## Contents

1. Creating Content .............................................................. 9

   Generating Sample Content .................................................. 9
   Generating Sample Content Overview ....................................... 9
   Analyzing Sample Content .................................................... 13

   Creating Reports .................................................................. 19
   Choosing a Report Output ...................................................... 20

   Creating Charts ................................................................... 21
   Narrating Charts .................................................................. 24
   Chart Outputs ...................................................................... 25

   Creating Your Own Chart Types ............................................. 26
   Introducing Chart Extensions ................................................. 26
   Creating a Chart Extension ..................................................... 27

   Using the Chart Extension API .............................................. 28
   Rendering Charts .................................................................. 28
   Configuring Your Chart Extension .......................................... 32
   Creating a config Object for Chart Engine Configuration ............ 32
   Configuring the Chart Interface ............................................. 34

   Accessing Data for Your Extension ....................................... 36
   Defining and Using Buckets in an Extension ............................ 37
   Handling Partial and Null Data in an Extension ....................... 40

   Installing a Chart Extension .................................................. 40
   Using Your Extension in a WebFOCUS Request ....................... 42

   Building a Document ............................................................. 44
   Inserting Reports From Multiple Data Sources ......................... 44
   Inserting a New Report .......................................................... 45
   Inserting a New Chart ............................................................ 46
   Inserting an Existing Report .................................................... 47
   Creating a Document From a Single Report ............................... 47
   Inserting Text and Images ...................................................... 47

   Editing Components in a Document ........................................ 48

   Creating Multi-Page Documents ............................................. 55
   Creating Multi-page Documents ............................................. 56

Creating Content 3
<table>
<thead>
<tr>
<th>Topics</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Tab</td>
<td>230</td>
</tr>
<tr>
<td>Series Tab</td>
<td>232</td>
</tr>
<tr>
<td>Ribbon Commands for Documents</td>
<td>234</td>
</tr>
<tr>
<td>Home Tab</td>
<td>234</td>
</tr>
<tr>
<td>Insert Tab</td>
<td>237</td>
</tr>
<tr>
<td>Format Tab</td>
<td>238</td>
</tr>
<tr>
<td>Data Tab</td>
<td>240</td>
</tr>
<tr>
<td>Slicers Tab</td>
<td>241</td>
</tr>
<tr>
<td>Layout Tab</td>
<td>242</td>
</tr>
<tr>
<td>View Tab</td>
<td>243</td>
</tr>
<tr>
<td>Field Tab</td>
<td>245</td>
</tr>
<tr>
<td>Series Tab</td>
<td>250</td>
</tr>
<tr>
<td>Ribbon Commands for Visualizations</td>
<td>251</td>
</tr>
<tr>
<td>Home Tab</td>
<td>251</td>
</tr>
<tr>
<td>Format Tab</td>
<td>253</td>
</tr>
<tr>
<td>View Tab</td>
<td>255</td>
</tr>
<tr>
<td>Field Tab</td>
<td>256</td>
</tr>
<tr>
<td>Series Tab</td>
<td>257</td>
</tr>
</tbody>
</table>
Creating Content

Create reports, documents, charts, and interactive visualizations using the available features and functionality.

In this chapter:

- Generating Sample Content
- Creating Reports
- Creating Charts
- Creating Your Own Chart Types
- Building a Document
- Creating Multi-Page Documents
- Building Visualizations
- Creating Matrix Charts
- Using Active Technologies
- Using Navigation Options for Reports
- Creating Maps to Illustrate Trends
- Building InfoMini Applications
- Viewing Data Behind Visuals
- Creating HOLD Files
- Creating Shortcuts and URLs
- Creating Blogs
- Working With Pages
- Working With the WebFOCUS BUE Portal
- Creating Report Queries With InfoAssist+
- Ribbon Command Reference

Generating Sample Content

This topic describes how to generate sample content from uploaded or existing data using the Samples Generator. It also provides information about how to interpret and analyze the sample content.

Generating Sample Content Overview

The Samples Generator automatically generates a suite of analytic content based on uploaded Excel workbooks, CSV files, or existing single-segment Master Files in your repository. The Samples Generator populates your directory with sample charts, reports, and dashboards. Additionally, the suite contains charts and reports that provide quick and easy navigation through the levels of each available hierarchy. You can view, edit, or delete this content, or use it as a starting point to create new dashboards.
The Samples Generator feature is useful to the novice user, because it introduces all major analytic content types in the InfoAssist+ toolset. Depending on the structure of your source worksheet or synonym, the Samples Generator automatically creates the following items:

- Active dashboards:
  - Initial Dashboard
  - Initial Dashboard by Year
  
  **Note:** This item is only generated if your source dataset includes an eligible date, which contains data for minimum three unique months.

- Reports:
  - Auto-drill report starting at the top of each identified hierarchy
  - Overview accordion report
  - Overview active report

- Charts:
  - Pie chart
  - Bar chart
  - Line chart
  
  **Note:** Line charts are only created if your source dataset includes an eligible date, which contains data for minimum three unique months.

The dashboards, auto-drill reports, overview accordion report, and overview active report are stored in the Analytics folder. All other items are placed in the folders that are named after the measures for which they are created. The content may vary depending on the structure and size of your synonym.

To see the most complete suite of analytical content, it is recommended that you use a data source that contains at least four measures, six dimensions, and data for a minimum of three unique months. Additionally, a record count called Trans appears in the sample content, if there are not sufficient measures available for analysis.

**Note:** Virtual fields, such as COMPUTE and DEFINE, are not eligible for selection as dimensions or measures in the generated content.
The following image shows an example of a synonym and the suite of sample content generated from this synonym and displayed in the Resources tree.

**Note:** If you generate sample content more than once from the same source worksheet or synonym in the same location, the Samples Generator creates a new folder with an underscore and number appended to the title. For example, if a retail_sample folder already exists in a domain or folder, a new folder with the new set of content is created and titled retail_sample_1. The number is incremented each time you repeat this action.

You can generate sample content from one of the following ways:

- By navigating to the Sample Content option from the New option in the Resources tree for access to existing data.
- By uploading an Excel spreadsheet or CSV file and selecting the Gain Insight option at the end of the upload procedure.

**Procedure:** **How to Generate Sample Content From the Resources Tree**

1. In the Resources tree, right-click a domain or folder, point to New, and then click Sample Content.

The Open dialog box opens.

**Note:** Only single-segment Master Files are displayed for selection.
2. Locate a single-segment Master File that you want to use for generating sample content and click Open.

The new folder with the same name as your Master File appears in your chosen directory. It contains sample charts, reports, and dashboards.

**Procedure:** How to Generate Sample Content From the Upload Wizard

1. Upload a spreadsheet, as described in *Uploading and Appending Spreadsheets*.

After the Upload procedure is complete, a selection screen opens, as shown in the following image.

![Selection Screen](image)

**Note:** Generating sample content on Master Files uploaded to a temporary folder, such as FOCCACHE, may produce unexpected results.

2. Click *Automatically generate content from your data*.

The sample content is generated in the same folder that you selected for your upload.
Analyzing Sample Content

The following section provides a closer look at each content type, and explains how this content is generated. These examples have been generated using the retail_data_extract.xlsx spreadsheet that is provided with your WebFOCUS installation.

Initial Dashboard by Year

The Initial Dashboard gives you a quick overview of your data. It is comprised of three charts and one report, as shown in the following image. Additionally, it displays a drop-down menu, which allows you to narrow down your results to a specific year. The Initial Dashboard by Year is only generated if your source worksheet or synonym includes an eligible date, which contains data for a minimum of three unique months.

The bar chart is generated from the first measure and first dimension in the source spreadsheet or synonym. It shows the Top 10 values.

The first pie chart is generated from the second measure and second dimension. It shows the Top 5 values.
The second pie chart is generated from the third measure and third dimension. It shows the Top 5 values.

The active report shows an overview of all measures and dimensions in the source worksheet or synonym.

**Initial Dashboard**

The Initial Dashboard is identical to the Initial Dashboard by Year, with the exception that the year drop-down menu is not displayed.

**Auto-drill reports**

The auto-drill reports are generated for each of the identified hierarchies in the synonym. For example, if your data set contains three hierarchies, the Samples Generator automatically creates three auto-drill reports and one overview auto-drill report. In each auto-drill report, the first four measures in the data set will be summed up by the dimension values in the hierarchy. The report also features data bars and grand totals for each dimension in the hierarchy. The name of the hierarchy is reflected in the title of the report. For example: Dimension_Auto_Drill_Report.fex where Dimension is the top level of the hierarchy. The following image shows an example of an Overview Auto-Drill Report.

<table>
<thead>
<tr>
<th>Country</th>
<th>Sale Date Year</th>
<th>Product Category</th>
<th>Revenue</th>
<th>Cost of Goods</th>
<th>Gross Profit</th>
<th>Quantity Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Australia</strong></td>
<td>2012</td>
<td>Accessories</td>
<td>3,957</td>
<td>2,653</td>
<td>1,314</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
<td>4,057</td>
<td>2,503</td>
<td>1,554</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
<td>4,315</td>
<td>2,917</td>
<td>1,398</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
<td>11,656</td>
<td>9,053</td>
<td>2,603</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
<td>13,152</td>
<td>9,431</td>
<td>3,721</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
<td>1,698</td>
<td>1,205</td>
<td>493</td>
<td>7</td>
</tr>
<tr>
<td><strong>2013</strong></td>
<td></td>
<td>Accessories</td>
<td>149,408</td>
<td>102,379</td>
<td>47,029</td>
<td>577</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
<td>151,166</td>
<td>96,371</td>
<td>54,795</td>
<td>538</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
<td>154,166</td>
<td>114,529</td>
<td>40,637</td>
<td>509</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
<td>293,022</td>
<td>225,838</td>
<td>67,185</td>
<td>949</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
<td>323,902</td>
<td>229,324</td>
<td>94,578</td>
<td>1,214</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Televisions</td>
<td>81,027</td>
<td>61,989</td>
<td>19,038</td>
<td>94</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
<td>58,771</td>
<td>40,569</td>
<td>18,212</td>
<td>220</td>
</tr>
</tbody>
</table>
Click one of the links to drill-down to the lower level, as shown in the following image. You can use the breadcrumbs to navigate back to the original report.

### Overview Accordion Report

The Overview Accordion Report provides a way to control the amount of sorted data that appears on a page with the expandable views of data for each vertical sort field. It contains up to three dimensions and the first four measures that are found in your source synonym. The report displays total values for each measure. The following image shows an example of an Overview Accordion Report.

<table>
<thead>
<tr>
<th>State</th>
<th>Year</th>
<th>Product Category</th>
<th>Revenue</th>
<th>Cost of Goods</th>
<th>Gross Profit</th>
<th>Quantity Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>New South Wales</td>
<td>2012</td>
<td>Accessories</td>
<td>3,967</td>
<td>2,053</td>
<td>1,314</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
<td>4,057</td>
<td>2,503</td>
<td>1,554</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
<td>4,315</td>
<td>2,917</td>
<td>1,356</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
<td>11,656</td>
<td>9,053</td>
<td>2,603</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
<td>13,152</td>
<td>9,431</td>
<td>3,721</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
<td>1,688</td>
<td>1,205</td>
<td>403</td>
<td>7</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td>1,260,307</td>
<td>898,749</td>
<td>381,568</td>
<td>4,242</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>State</th>
<th>Year</th>
<th>Sales Region</th>
<th>Revenue</th>
<th>Cost of Goods</th>
<th>Gross Profit</th>
<th>Quantity Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td></td>
<td>Australia</td>
<td>1,260,307</td>
<td>898,749</td>
<td>381,568</td>
<td>4,242</td>
</tr>
<tr>
<td></td>
<td>2012</td>
<td></td>
<td>38,845</td>
<td>27,762</td>
<td>11,083</td>
<td>141</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Accessories</td>
<td>3,967</td>
<td>2,053</td>
<td>1,314</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
<td>4,057</td>
<td>2,503</td>
<td>1,554</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
<td>4,315</td>
<td>2,917</td>
<td>1,356</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
<td>11,656</td>
<td>9,053</td>
<td>2,603</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
<td>13,152</td>
<td>9,431</td>
<td>3,721</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
<td>1,688</td>
<td>1,205</td>
<td>403</td>
<td>7</td>
</tr>
<tr>
<td>Total</td>
<td>2013</td>
<td></td>
<td>1,221,462</td>
<td>870,987</td>
<td>350,475</td>
<td>4,101</td>
</tr>
<tr>
<td>Belgium</td>
<td></td>
<td></td>
<td>20,148,423</td>
<td>14,449,034</td>
<td>5,699,389</td>
<td>66,721</td>
</tr>
<tr>
<td>Brazil</td>
<td></td>
<td></td>
<td>25,974,012</td>
<td>18,815,007</td>
<td>7,359,005</td>
<td>86,606</td>
</tr>
<tr>
<td>Canada</td>
<td></td>
<td></td>
<td>51,147,788</td>
<td>36,606,113</td>
<td>14,541,675</td>
<td>171,492</td>
</tr>
</tbody>
</table>
Overview Active Report

The Overview Active Report contains one BY field for each dimension. The report displays maximum of six dimensions and four measures. The total values are displayed for each measure. Each field features a drop-down menu, where you can access active report options. The Overview Active Report is always generated and resides in the Analytics folder. The following image shows an example of an Overview Active Report.
**Pie Charts**

The Samples Generator uses the first four measures to create Pie charts, by pairing these measures with up to three different dimensions found in the source synonym. Each pie chart shows the Top 10 values. The number of pie charts may vary depending on your synonym structure. The following image shows an example of a pie chart created by the Samples Generator.

![Pie Chart Example](image-url)
Bar Charts

The Sample Generator creates bar charts for each measure paired with up to three different dimensions. Each bar chart shows all values in the dataset for that dimension. If there are more values than can be displayed on the screen, a scrollbar appears. The number of bar charts may vary depending on the structure of your synonym. The following image shows an example of an automatically generated bar chart.
**Line Charts**

Line charts are only generated, if your source dataset includes an eligible date, which contains data for minimum three unique months. If this data is present in the dataset, a line chart is created for each measure. The following image shows an example of a line chart.

![Line Chart Example](image)

**Creating Reports**

You can use the following procedures to create a basic report.

**Procedure:  How to Create a Report From the BUE Portal**

After you have signed in to the WebFOCUS Business User Edition, you can work with an existing folder, or create a new folder in the Resources tree to store your reports.

1. Right-click the folder that you want to use, point to New, and then click Report.

   Or

   Select a folder and on the Home page, on the Quick Links tab, under Create, click Report.

   InfoAssist+ opens.

2. From the Open dialog box, select the data source that you want to use, and click OK.

   The data source that you selected appears in the Data pane.

3. Drag fields onto the canvas or into the Query pane to begin building your report.
Procedure: How to Create a Report From the Application Main Menu

1. In the upper-left corner of the InfoAssist+ interface, click the IA button to open the Application Main Menu.
2. From the Application Main Menu, click New.
   The InfoAssist+ splash screen opens.
   The Open dialog box opens.
4. From the Open dialog box, select the data source that you want to use, and click Open.
   The data source that you selected appears in the Data pane of the Resources panel.
5. Drag fields onto the canvas or into the Query pane to begin building your report.

Procedure: How to Create a Report From the Quick Access Toolbar

1. On the Quick Access Toolbar, click the New icon.
   The InfoAssist+ splash screen opens.
   The Open dialog box opens.
3. From the Open dialog box, select the data source that you want to use, and click Open.
   The data source that you selected appears in the Data pane of the Resources panel.
4. Drag fields onto the canvas or into the Query pane to begin building your report.

Procedure: How to Create a Report From an Existing Chart

1. Open the chart that contains the data that you want to present in a report.
   The data is presented as a report.

Choosing a Report Output

The following output types are available for reports:

- HTML
- active report
- PDF
Note: When you create a report in Document view, you have access to Excel only.

When you create a report in Live Preview or Query Design view, you have access to the following Excel output types:

- **Excel (xlsx)**. Outputs the report in Excel 2007 (and higher) format.
- **Excel**. Outputs the report in Excel format.
- **Excel Formula (xlsx)**. Outputs the report, using Excel formulas that calculate and display the results of any type of summed information, such as column totals, row totals, and subtotals. This format is for Excel 2007 (and higher).
- **Excel Formula**. Outputs the report, using native Excel formulas for totals and computed values.

**Creating Charts**

On the *Format* tab, the *Chart Types* group provides buttons for each of the five most commonly-used chart types. These include Bar (default), Pie, Line, Area, and Scatter. You also have access to Esri Choropleth and Proportional Symbol maps. A button labeled Other gives you access to the complete chart library of advanced charts.

The Chart Types group is shown in the following image.

![Chart Types](image)
When switching between chart formats that use a different syntax, you are prompted with a message that allows you to proceed with the change, or cancel your request. This message is shown in the following image.

![Chart Attributes Modified dialog box](image)

On the Chart Attributes Modified dialog box, you can click Yes to accept the changes or click No to save the changes to a different file and preserve the originating procedure (.fex).

**Procedure: How to Create a Basic Chart**

You can run this procedure in Query Design view or Live Preview.

1. On the **Format** tab, in the **Chart Types** group, click the button of the chart that you want to create. Bar chart is the default.

   The chart appears on the canvas.

2. Populate the chart with your data in one of the following ways:

   - Drag the dimension fields and measure fields onto the chart.
   
   - Drag the dimension fields and measure fields into the appropriate Query field containers in the Query pane.

**Procedure: How to Create an Advanced Chart**

You can run this procedure in Query Design view or Live Preview.

1. On the **Format** tab, in the **Chart Types** group, click **Other**.

   The Select a chart dialog box opens. The chart types, depicted by icons, display on the left side of the dialog box.

2. To display the name of a chart type, hover over the chart type with the mouse.

   From top to bottom, the chart type categories are Bar, Line, Area, Pie, XY Plots, 3D, Stock, Special, HTML5, and Map.
**Note:** For streamgraphs, which are in the HTML5 category, the tooltip has been enhanced to display specific information, by data point, depending on the underlying data source.

3. Click a chart type.

   All supported variations of the chart type appear as thumbnail images in the dialog box.

4. Click an image to display a detailed description of that chart type.

   If you are not familiar with a chart type, be sure to read the description carefully before finalizing your selection. Some chart types require a certain number of data values, or a certain type of data values. If your data does not satisfy the requirements, the chart will not accurately represent the data.

   You can also hover over an image with your mouse to display the chart type name.

5. In the Select a chart dialog box, click **OK** to finalize your selection and close the dialog box.

6. Populate the chart with your data in one of the following ways:

   - Drag the dimension fields and measure fields onto the chart.
   - Drag the dimension fields and measure fields into the appropriate Query field containers in the Query pane.

**Procedure:** **How to Create a Combination Chart**

You can run this procedure in Query Design view or Live Preview.

1. On the **Format** tab, in the **Chart Types** group, click the button of the chart that you want to create. Bar chart is the default.

   The chart appears on the canvas.

2. Populate the chart with your data in one of the following ways:

   - Drag the dimension fields and measure fields onto the chart.
   - Drag the dimension fields and measure fields into the appropriate Query field containers in the Query pane.

3. Change a series type in one of the following ways:

   - **Ribbon:** On the **Series** tab, in the **Select** group, select the series that you want to display in a different chart type. Then, in the Properties group, from the Type drop-down menu, select the chart type.

   - **Shortcut Menu:** Right-click the series that you want to display in a different chart type, point to **Series Type**, and click the chart type.
The series appears in the new chart type.

**Procedure: How to Create a Dual-Axis Chart**

When you create a dual-axis chart, you assign one data series to the Y1 axis and another data series to the Y2 axis.

1. Create a chart.
2. On the *Format* tab, in the *Chart Types* group, click *Other*.
   
   The Select a chart dialog box opens.
3. Select a dual-axis chart, such as dual-axis bar, and then click *OK*.
4. Drag one field onto the Y1 field, and then drag another field onto the Y2 field.

** Procedure: How to Create a Multi-Axis Chart**

When you create a multi-axis chart, you assign one data series to the Y1 axis and another data series to the Y2, Y3, Y4, and Y5 axes (as needed).

1. Create a chart.
2. On the *Format* tab, in the *Chart Types* group, click *Other*.
   
   The Select a chart dialog box opens.
3. Select a multi-axis chart, and then click *OK*.
4. Drag fields onto the Y1, Y2, Y3, Y4, and Y5 fields, as needed.

**Narrating Charts**

Narrative charts tell the story of your data. When creating a bar, line, area, or pie chart, you can bring your chart to life with words that describe your data, as shown in the following image.
If your administrator has activated this feature for you, you can enable Narrative Charts from the ribbon. On the Format tab, in the Features group, click Narrative. This will add descriptive text for the current chart or visual.

Narrative charts let you communicate about your data, summarizing data values and providing an interpretation of the results.

Chart Outputs

You can create charts using one of the following output formats:

- HTML
- HTML5 (default)
- active report
- PDF
- Excel
- PowerPoint
The HTML5 output format allows you to render a chart in the browser using a built-in JavaScript engine. Charts with this output format utilize the very latest capabilities of the HTML5 Web standard, including animation, high-quality vector output, and attractive alpha-channel and gradient effects.

**Note:** Not every chart type can be output in every format listed here. To make sure that the chart that you are creating can be output in the format that you want, please see the topic for that particular chart type.

### Creating Your Own Chart Types

WebFOCUS BUE supports the ability to add new, custom chart types to its list of built-in charts. These custom chart types are called *extensions* or *plug-ins*. An extension is a block of code that accesses resources external to WebFOCUS BUE. This topic describes the structure of an extension and the steps necessary to create your own and add it to the chart library.

### Introducing Chart Extensions

Chart extensions are written in JavaScript. The visual part of a visualization can be drawn with HTML, Canvas, or SVG. Extensions can include external CSS and JS libraries (such as d3), which can be used to build almost any visualization. The WebFOCUS Extension API is limited to new, complete chart types only. It is not possible to add features to existing chart types, and it is not possible to modify or extend parts of WebFOCUS BUE outside of the chart area allocated to your extension.

This topic summarizes the process of writing, configuring, and installing a chart extension. Detailed instructions can be found on the Information Builders GitHub site:

https://github.com/ibi/wf-extensions-chart

WebFOCUS BUE extensions must be placed in the extensions folder under the web_resource folder of your WebFOCUS BUE installation. By default, this is the following location:

```c:\ibi\install_dir\config\web_resource\extensions```

where:

*install_dir*

Is your WebFOCUS BUE installation directory.
Several sample chart extensions have already been installed in the extensions folder so that you can see their code, their structure, and how they are accessed in the WebFOCUS BUE tools.

**Note:** The user installing the extension must know how to write JavaScript code for what the chart extension needs to generate. The GitHub site documents how to make the extension conform to the WebFOCUS API and how to install the extension in the WebFOCUS BUE chart library. It does not describe how to write JavaScript code.

### Creating a Chart Extension

This section summarizes the build cycle for creating an extension and the structure and components of an extension.

**Reference:** **Build Cycle for Writing an Extension**

Creating an extension often involves cycles of writing, running, and then debugging code.

When you make changes to the properties.js file for your extension, you need to clear the WebFOCUS BUE cache in order for those changes to be recognized. Clear the cache using the *Clear cache* link in the Administration Console.

If you change the .js code for your extension (for example, com.ibi.simple_bar.js), you do not need to make any changes to WebFOCUS BUE. You only need to clear your own browser cache, to ensure that the new JavaScript file is downloaded. The same is true if you change any additional .js files included by your extension.

**Reference:** **Extension Structure**

The Simple Bar extension example demonstrates the required and optional files in an extension, and how those files are typically laid out.

You can open com.ibi.simple_bar and com.ibi.simple_bar.js in a text editor to see exactly how an extension is written.

The extension ID (ext_id) is a string in the form `com.your_company.extension_name`. The ext_id must be all lowercase, and can include only letters, numbers, underscores and dots. The entire extension lives in a folder named `ext_id`. The core of the extension lives in a file named `ext_id.js`. This file includes code to render the extension as a new chart type within WebFOCUS BUE.

The properties.json file configures your extension to run in WebFOCUS BUE. This file includes all the metadata needed to include your extension in the WebFOCUS BUE user interface, as well as a list of all properties you wish to expose to end users, so they can customize the behavior of your extension.
The extension folder can also include optional additional folders for external css and lib resources. If your extension uses any additional CSS or JavaScript library files, you can keep those resources organized in dedicated folders, such as css and lib, as you choose. External resources are configured and loaded inside the base ext_id.js file of your extension.

**Using the Chart Extension API**

To see examples of everything that the chart extension API provides, look at `com.ibi.simple_bar.js`. It is divided into two main parts, chart rendering and extension configuration.

**Rendering Charts**

The extension API provides three entry points that you can use as needed by defining your own JavaScript callback functions. They are passed a set of properties in a config object. Some properties are available during the entire rendering process, and some are only available during render callback.

**Reference:** Chart Rendering Callback Functions

You can define the following three JavaScript callback functions. Only the renderCallback function is always required.

- **initCallback(successCallback, config)** This optional function is invoked by the engine exactly once during library load time, providing a way to implement document.onload initialization code. This function is passed a successCallback, which you must invoke with `true` if your initialization code succeeded or `false` if was not successful. If you call successCallback(false), no further interaction with your extension will occur, and your extension will render as an empty page.

- **preRenderCallback(config)** This optional function is invoked each time your extension is to be rendered, as the very first step in the overall rendering process. This is a good place to examine and tweak or override any internal chart properties that will affect the subsequent rendering.

- **renderCallback(config)** This required function must contain all of the code that will actually draw your chart. The config object will contain the properties described in the following sections.

Each of the three entry point callbacks is passed a config object, which contains a set of useful properties.
**Example:** Sample renderCallBack Function

The following sample renderCallBack code renders the Simple Bar extension.

```javascript
function renderCallBack(renderConfig) {
    var chart = renderConfig.moonbeamInstance;
    var props = renderConfig.properties;
    var container = d3.select(renderConfig.container)
        .attr('class', 'com_ibi_chart');
    var data = renderConfig.data;
    if (renderConfig.dataBuckets.depth === 1) {
        data = [data];
    }

    var seriesCount = data[0].length;
    var seriesLabels = data[0].map(function(el){return el.labels;});
    data = d3.transpose(data).map(function(el, idx) {
        el = el[0];
        var v = Array.isArray(el.value) ? el.value : [el.value];
        var y0 = 0;
        return v.map(function(d, s) {
            return chart.mergeObjects(d, {y0: y0, y1: y0 += d, seriesID: s, value: d, labels: seriesLabels[idx]});
        });
    });

    var w = renderConfig.width;
    var h = renderConfig.height;
    var x = d3.scale.ordinal().domain(pv.range(seriesCount)).rangeRoundBands([0, w], 0.2);
    var ymax = d3.max([], function(d){return d.y1;});
    var y = d3.scale.linear().domain([0, ymax]).range([25, h]);
    var svg = container.selectAll("g")
        .data(data)
        .enter().append("g")
        .attr('transform', function(d, i){return 'translate(' + x(i) + ', 0)';});

    svg.selectAll("rect")
        .data(function(d){return d;})
        .enter().append("rect")
        .attr("width", x.rangeBand())
        .attr("y", function(d) {return h - y(d.y1);})
        .attr("height", function(d){return y(d.y1) - y(d.y0);})
        .attr('tdgtitle', function(d, s, g) {
```
// To support tooltips, each chart object that should draw a tooltip
// must set its 'tdgtitle' attribute to the tooltip's content string.

// Retrieve the chart engine's user-defined tooltip content with
getToolTipContent():
// 's' and 'g' are the series and group IDs for the riser in
question.
// 'd' is this riser's individual datum, and seriesData is the
array of data for this riser's series.
var seriesData = chart.data[s];
var tooltip = renderConfig.modules.tooltip.getToolTipContent(s, g, d, seriesData);
// getToolTipContent() return values:
//  - undefined: do not add any content to this riser's tooltip
//  - the string 'auto': you must define some 'nice' automatic
tooltip content for this riser
//  - anything else: use this directly as the tooltip content
if (tooltip === 'auto') {
  if (d.hasOwnProperty('color')) {
    return 'Bar Size: ' + d.value + '<br />Bar Color: ' + d.color;
  }
  return 'Bar Size: ' + d.value;
}
return tooltip;
})
.attr('class', function(d, s, g) {
  // To support data selection and tooltips, each riser must include
  a class name with the appropriate seriesID and groupID
  // Use chart.buildClassName to create an appropriate class name.
  // 1st argument must be 'riser', 2nd is seriesID, 3rd is groupID,
  // 4th is an optional extra string which can be used to identify the
  risers in your extension.
  return chart.buildClassName('riser', s, g, 'bar');
})
.attr('fill', function(d) {
  // getSeriesAndGroupProperty(seriesID, groupID, property) is a
  handy function
  // to easily look up any series dependent property. 'property' can
  be in
  // dot notation (eg: 'marker.border.width').
  return chart.getSeriesAndGroupProperty(d.seriesID, null, 'color');
});

svg.append('text')
  .attr('transform', function(d) {return 'translate(' +
  (x.rangeBand() / 2) + ',' + (h - 5) + ')';})
  .text(function(d, i){return seriesLabels[i];})
renderConfig.modules.tooltip.updateToolTips(); // Tell the chart
engine your chart is ready for tooltips to be added
renderConfig.modules.dataSelection.activateSelection(); // Tell the
chart engine your chart is ready for data selection to be enabled
}
### Properties That Are Always Available

The following properties are always available.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>moonbeamInstance</td>
<td>The chart instance currently being rendered.</td>
</tr>
<tr>
<td>data</td>
<td>The data set being rendered.</td>
</tr>
<tr>
<td>properties</td>
<td>The block of properties for your extension, as set by the user.</td>
</tr>
</tbody>
</table>

### Properties Available Only During Render Callback

The following properties are available only during render callback, and are used by your chart rendering code (renderCallback).

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>Width of the container your extension renders into, in pixels.</td>
</tr>
<tr>
<td>height</td>
<td>Height of the container your extension renders into, in pixels.</td>
</tr>
<tr>
<td>containerIDPrefix</td>
<td>The ID of the DOM container your extension renders into. Prepend this to all IDs your extension generates, to ensure multiple copies of your extension work on one page.</td>
</tr>
<tr>
<td>container</td>
<td>DOM node for your extension to render into, either an HTML DIV element or an SVG G element, depending on your chosen containerType extension configuration</td>
</tr>
<tr>
<td>rootContainer</td>
<td>DOM node containing the specific chart engine instance being rendered.</td>
</tr>
</tbody>
</table>
Configuring Your Chart Extension

Extension configuration consists of two parts.

- Chart Engine Configuration configures the extension to interact with the chart engine and chart canvas in WebFOCUS BUE. This part of the extension configuration is defined in the `config` object that is passed to the chart renderer functions.

- Chart Interface Configuration interacts with the chart type picker in the user interface and the chart attribute categories. This part of the extension configuration is defined in the `properties.json` file.

Creating a config Object for Chart Engine Configuration

To configure your extension, create a `config` object with all the information unique to your extension, then register your extension with the extension API.

**Reference:** Creating a config Object for Your Extension

Required and optional properties in your config object are described in the following table.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>Is the extension ID described in <em>Extension Structure</em> on page 27.</td>
</tr>
<tr>
<td>name</td>
<td>Is the name for the chart type to be displayed in the user interface.</td>
</tr>
<tr>
<td>description</td>
<td>Is a description for the chart type to be displayed in the user interface.</td>
</tr>
<tr>
<td>containerType</td>
<td>Is either 'html' or 'svg' (the default).</td>
</tr>
<tr>
<td>initCallback</td>
<td>Optional. References your initCallback function, described in <em>Rendering Charts</em> on page 28.</td>
</tr>
<tr>
<td>preRenderCallback</td>
<td>Optional. References your preRenderCallback function, described in <em>Rendering Charts</em> on page 28.</td>
</tr>
<tr>
<td>renderCallback</td>
<td>Required. References your renderCallback function, described in <em>Rendering Charts</em> on page 28.</td>
</tr>
</tbody>
</table>
### Property Name | Description
--- | ---
resources | Optional. Are additional external resources (CSS and JS) required by this extension.

**Example:** **Sample config Object**

The following code is a sample of the config object used with the Simple Bar extension.

```javascript
var config = {
  id: 'com.ibi.simple_bar', // string that uniquely identifies this extension
  containerType: 'svg', // either 'html' or 'svg' (default)
  initCallback: initCallback, // Refers to your init callback fn (optional)
  preRenderCallback: preRenderCallback, // Refers to your preRender callback fn (optional)
  renderCallback: renderCallback, // Refers to your render fn (required)
  resources: { // Additional external resources (CSS & JS) required by this extension (optional)
    script: ['lib/d3.min.js'],
    css: ['css/extension.css']
  }
};
```

**Reference:** **Registering Your Extension**

To register your extension with the WebFOCUS extension API, call:

```javascript
tdgchart.extensionManager.register(config);
```

**Reference:** **Tips for Building Your Extension**

The easiest way to build your own extension is to clone the Simple Bar example, then tweak it. Assume the ID of the new extension is com.foo.bar:

2. In com.foo.bar.js, delete the inner content of the three callback functions.
3. In com.foo.bar.js, change the entries for each property in config to match the requirements of your extension.
4. Add any external resources you need to *lib* and *css*, and load them by setting `config.resources` in com.foo.bar.js.
5. Implement `renderCallback` in com.foo.bar.js to draw your extension.
Configuring the Chart Interface

Each extension must include a properties.json file, which defines the information needed by WebFOCUS BUE when drawing its user interface.

The properties.json file consists of the following blocks.

- **info.** This block defines several general purpose configuration options.

- **properties.** This block defines any properties of your extension that the end user may want to change. The user can change these properties in the GRAPH_JS blocks in a WebFOCUS BUE chart procedure.

- **propertyAnnotations.** This block validates the content of the properties block. Everything in properties must appear in propertyAnnotations. The possible types of any non-object (leaf) property in properties must be notated as one of "str", "bool", or "number".

- **dataBuckets.** This block defines the set of chart attribute categories that appear in the Query pane in the WebFOCUS BUE user interface when creating a chart. Each member in the dataBuckets collection is a bucket.

There are two types of buckets, built-in and custom. Built-in buckets provide an easy way to reuse the existing WebFOCUS BUE data bucket logic. There are currently two built-in buckets, tooltip, and series_break. Use any of these buckets by setting the associated dataBuckets property to `true`.

- **bucket.** Each bucket block defines one custom chart attribute category. Each custom bucket requires the following properties:

  - **id.** This property corresponds exactly to the dataArrayMap and data properties that will be received by the render function for your chart.

  - **type.** This property defines the type of data field this bucket accepts, "measure", "dimension", or "both".

  - **count.** Consists of count.min and count.max, which define the minimum and maximum number of fields this bucket can accept. A minimum of 0 means this bucket is optional.

  - **translations.** Defines translations in different languages for every label to be drawn in the WebFOCUS BUE interface. The translation object has one property for each language the extension supports, keyed by ISO-639 two letter locale strings.
**Example: Sample properties.json File**

The following properties.json file is from the Simple Bar extension.

```json
{
    // Define some general extension configuration options
    "info": {
        "version": "1.0",  // version number of your extension.
        "implements_api_version": "1.0",  // version number of the
                                            // WebFocus API used by your extension.
        "author": "Information Builders",
        "copyright": "Information Builders Inc.",
        "url": "https://github.com/ibi/wf-extensions-chart/tree/master/
                simple_bar%20example",
        "icons": {
            "medium": "icons/medium.png"  // Reference to an image in
                                             // the extension, used in the WF chart picker
        }
    },
    // Define any properties of your extension that end user may want
    // to change.
    "properties": {
        "exampleProperty": 50
    },
    // Define the possible values for each property in 'properties'.
    "propertyAnnotations": {
        "exampleProperty": "number"
    },
    // Define the available data buckets drawn in WF's 'Query' data
    // bucket tree.
    "dataBuckets": {
        // Choose whether or not to reuse existing WF data buckets.
        // All optional.
        "tooltip": false,
        "series_break": true,
        // Other properties here...
    }
}
```

1. Creating Content
// Define your own custom data buckets. Optional
"buckets": [
    {
        "id": "value",
        "type": "measure",
        "count": {"min": 1, "max": 5}
    },
    {
        "id": "labels",
        "type": "dimension",
        "count": {"min": 1, "max": 5}
    }
],
// Define the set of labels used in the WF interface for buckets
and chart type picker.
"translations": {
    "en": {
        "name": "My Simple Bar Chart",
        "description": "This chart is just a simple bar chart,
nothing to see here.",
        "icon_tooltip": "This extension does ...",
        "value_name": "Value Bucket",
        "value_tooltip": "Drop a measure here",
        "labels_name": "Label Bucket",
        "labels_tooltip": "Drop a dimension here"
    },
    "fr": {
        "name": "Un Bar Chart tres simple",
        "description": "C'est un Bar Chart vraiment simple",
        "icon_tooltip": "This extension does ...",
        "value_name": "Value Bucket",
        "value_tooltip": "Drop a measure here",
        "labels_name": "Label Bucket",
        "labels_tooltip": "Drop a dimension here"
    }
}

**Accessing Data for Your Extension**

Each time an extension is rendered, the render callback for the extension is passed the
current data set using the renderConfig.data argument. The overall structure of the data set is
defined by the set of buckets listed in the properties.json file, while the specific content of the
data is defined by the data fields the user has added to each bucket.
Defining and Using Buckets in an Extension

The data set is passed into an extension using the data property of the first argument of the render callback, typically named renderConfig. Additional information about the current set of fields in each bucket is in renderConfig.dataBuckets.

A data set is represented in JavaScript as arrays of objects. If an extension defines only custom buckets, the data set will be a flat array of objects. If an extension uses some built-in buckets, the data set may contain deeply nested arrays of arrays. The renderConfig.dataBuckets.depth property will be set to the number of array dimensions in the current data set.

Custom Buckets

Each innermost object within the arrays of data (called a datum) will have one property for each data bucket that contains a field. Each property will be the id of a custom bucket, as defined in the dataBuckets.buckets section of properties.json. The type of values of these properties depend on the bucket type. Dimension buckets have string values, while measure buckets have numeric values. If a bucket contains more than one field, the associated property for each innermost object will be an array of string or number values.

Built-in Buckets

An extension can use buckets that are built-in and predefined by WebFOCUS BUE. These buckets will affect more than just the data set. Each bucket will also set specific chart engine properties, to pass in additional information related to that bucket.

Each built in WebFOCUS BUE bucket is either a standard bucket or a break bucket.

- Standard buckets behave exactly like custom buckets. The data set remains a single array, and each datum object will include an additional property named after the bucket.

- Break buckets divide the data set into additional arrays of data. For each break bucket used, each datum object will be transformed into a full array of datum objects. The number of datum objects in each array will remain unchanged, but the number of arrays or datum arrays will correspond to the number of entries in the break field.
Types of Break Buckets

Break buckets can be of two types:

- A series-break bucket breaks the data set into one array for each entry in the series break field chosen by the user. A series-break bucket uses series-dependent properties defined in the chart engine, and the data names are now listed in those series-dependent properties. Each entry in the series-break field will generate a corresponding series property object in the chart engine, retrievable with `renderConfig.moonbeamInstance.getSeries(x)`, where `x` is an integer for the series to be retrieved. `getSeries` returns an object with properties such as color and label, which are unique to the chosen series.

- A matrix-break bucket is used for the sort fields that define the columns and rows in a matrix chart. A matrix-break bucket also adds more array dimensions to the data set. A matrix-break bucket is broken into `column` and `row` sub-buckets. If either the row or column bucket contains any fields, the data set will contain two additional dimensions of data, even if one of the matrix buckets is empty. That is, the data set will either contain neither row nor column data, or both row and column data, never just one or the other. `bucket.depth` will always be at least three.

The Tooltip Bucket

The tooltip bucket is not a break bucket, and does not add any additional array dimensions to the data set. Instead, tooltip behaves like a custom bucket. Each inner datum object will contain a property named `tooltip`, with a value of type string for dimensions, number for measures, and an array of values for multiple fields in the bucket.

The usefulness of this bucket is that in addition to including tooltip-specific data in the data set, WebFOCUS BUE also generates meaningful tooltip content for each series. This tooltip content is the same content used for all of the built in WebFOCUS BUE chart types. Using the tooltip bucket means the extension does not have to figure out what ought to go into each tooltip.

Example: Sample Series-Break Bucket Definition

This example uses the following sample data.

<table>
<thead>
<tr>
<th>Car</th>
<th>Country</th>
<th>Seats</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMW</td>
<td>Germany</td>
<td>5</td>
</tr>
<tr>
<td>Audi</td>
<td>Germany</td>
<td>4</td>
</tr>
<tr>
<td>Car</td>
<td>Country</td>
<td>Seats</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>Peugeot</td>
<td>France</td>
<td>5</td>
</tr>
<tr>
<td>Alfa Romeo</td>
<td>Italy</td>
<td>4</td>
</tr>
<tr>
<td>Maserati</td>
<td>Italy</td>
<td>2</td>
</tr>
<tr>
<td>Toyota</td>
<td>Japan</td>
<td>4</td>
</tr>
</tbody>
</table>

The following code defines a series-break bucket.

dataBuckets:
  series_break: true,
  buckets: [
    {id: "label", type: "dimension"},
    {id: "value", type: "measure"}
  ]

Consider the following fields assigned to each of the buckets:

- "Country" assigned to the "series_break" bucket.
- "Car" assigned to the "label" bucket.
- "Seats" assigned to the "value" bucket.

In the renderConfig function, the renderConfig.data object will be similar to the following, in which the Country values are no longer part of the data array. However, a new array starts for each change in the Country value:

```javascript
[{labels: "PEUGEOT", value: 5}],
{labels: "ALFA ROMEO", value: 4}, {labels: "MASERATI", value: 2},
{labels: "TOYOTA", value: 4}],
{labels: "AUDI", value: 4}]
```

The renderConfig.dataBuckets object will be defined as follows:

```javascript
renderConfig.dataBuckets = {
  depth: 2,
  series_break: {title: "Country"},
  buckets: {
    label: {title: "Car"},
    value: {title: "Seats"}
  }
}
```
Handling Partial and Null Data in an Extension

In many cases, the end user working with an extension cannot populate all of the extension buckets immediately. An extension must correctly handle these partial data cases, and cannot crash if one or more buckets are empty. It is important to check renderConfig.dataBuckets to see which buckets have been populated, and act accordingly.

In addition, data sets are often incomplete, missing some values for a given combination of dimensions and measures. These missing values may show up in the data set as null entries within an array (instead of datum objects), or they may show up as entirely empty arrays. It is important to detect and handle these missing data cases, and render a visualization appropriate for such missing data.

Most extensions require some minimum number of populated buckets before anything can be rendered. Use the count.min properties of each dataBuckets.bucket entry in properties.json to define these minimum requirements. If the fields in all buckets do not meet the minimum counts, then the renderCallback for the extension will not be called. Instead, the noDataPreRenderCallback for the extension is called. This allows the extension to render in a special \textit{no data} mode. In this mode, the extension should render in grey scale, using renderCallback.baseColor as the main color. This should be a very simplified, sample rendering of the extension.

\textbf{Example:} \textit{Sample noDataPreRenderCallback Function}

The following noDataPreRenderCallback function is from the Simple Bar sample extension.

\begin{verbatim}
function noDataRenderCallback(renderConfig) {
    var grey = renderConfig.baseColor;
    renderConfig.data = [{value: [3, 3]}, {value: [4, 4]}, {value: [5, 5]}, {value: [6, 6]}, {value: [7, 7]}];
    renderConfig.moonbeamInstance.getSeries(0).color = grey;
    renderConfig.moonbeamInstance.getSeries(1).color = pv.color(grey).lighter(0.18).color;
    renderCallback(renderConfig);
}
\end{verbatim}

Installing a Chart Extension

1. Find the extensions folder for your local WebFOCUS BUE installation. This is typically the following folder.

\texttt{C:\ibi\install\dir\config\web\resource\extensions}

where:

\texttt{install_dir}

Is your WebFOCUS BUE installation directory.
**Note:** The WebFOCUS Extension section of the Information Builders GitHub page maintains a list of publicly available and supported extensions. To install one of those, click the extension you want to install, then right click the zip file for that extension, for example `com.ibi.xyz.zip`, and choose **Save link as...**

2. Unzip the downloaded zip file into the WebFOCUS BUE extensions folder. For example, for the `com.ibi.xyz.zip` zip file, this should create the following folder.

   ```
   C:\ibi\install_dir\config\web_resource\extensions\com.ibi.xyz
   ```

   If you are installing your own extension from your own environment, copy or download it to the WebFOCUS BUE extensions folder, using the same naming conventions for the folder and the extension ID as described for the sample extensions.

3. Edit `C:\ibi\install_dir\config\web_resource\extensions\html5chart_extensions.json`. Create a new line for the new extension in the form:

   ```
   "com.ibi.abc": {"enabled": true},
   ```

   where:

   ```
   abc
   ```

   Is the name of the extension.

4. In the Administration Console, click **Clear cache**. This will force WebFOCUS to reload all extensions.

Following is a sample `html5chart_extensions.json`.

```json
{
   "com.ibi.simple_bar": {"enabled": true},
   "com.ibi.liquid_gauge": {"enabled": false},
   "com.ibi.sankey": {"enabled": true}
}
```

**Reference:** *Preserving Custom Chart Types When Reinstalling the WebFOCUS Client*

If you reinstall the WebFOCUS Client, your extensions folder will be overwritten. Therefore, if you have installed any custom chart extensions, you should preserve them by copying them to another location prior to reinstalling the WebFOCUS Client and copying them back to the extensions folder after reinstalling the WebFOCUS Client.

You will also have to copy the entries for your custom extensions into the new `html5chart_extensions.json` file installed with the new version of the WebFOCUS Client.
**Note:** The extensions that are delivered as part of WebFOCUS BUE will be reinstalled automatically, so you should not preserve those extensions. In that way, if any enhancements have been made to those extensions, you will automatically have access to the enhanced versions when you reinstall the WebFOCUS Client.

**Using Your Extension in a WebFOCUS Request**

If you have installed and configured your extension as described, your extension will be available for use in the WebFOCUS BUE tools as a chart type in the *Other* format category under *HTML5 Extension*, as shown in the following image.

![Image of WebFOCUS BUE tools with HTML5 Extension](image)

The attribute categories you defined in the dataBuckets object of your extension are available in the query pane.

In the FOCEXEC:

- The LOOKGRAPH value is EXTENSION.

- The actual extension to use is identified in the chartType property of the *GRAPH_JS* block in the StyleSheet. For example:
*GRAPH_JS
chartType: "com.ibi.simple_bar",
}

- Each custom attribute category name is prepended with a greater-than character (>). For example:

```
TYPE=DATA, COLUMN=N1, BUCKET= >labels, $
TYPE=DATA, COLUMN=N2, BUCKET= >value, $
TYPE=DATA, COLUMN=N3, BUCKET= >value, $
TYPE=DATA, COLUMN=N4, BUCKET= >value, $
TYPE=DATA, COLUMN=N5, BUCKET= >value, $
```

The following is a sample request using the Simple Bar extension.

```
GRAPH FILE WF_RETAIL_LITE
SUM COGS_US
GROSS_PROFIT_US
REVENUE_US
DISCOUNT_US
BY PRODUCT_CATEGORY
ON GRAPH PCHOLD FORMAT JSCHART
ON GRAPH SET LOOKGRAPH EXTENSION
ON GRAPH SET AUTOFIT ON
ON GRAPH SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/combine_templates/ENWarm.sty,$
TYPE=DATA, COLUMN=PRODUCT_CATEGORY, BUCKET= >labels, $
TYPE=DATA, COLUMN=COGS_US, BUCKET= >value, $
TYPE=DATA, COLUMN=GROSS_PROFIT_US, BUCKET= >value, $
TYPE=DATA, COLUMN=REVENUE_US, BUCKET= >value, $
TYPE=DATA, COLUMN=DISCOUNT_US, BUCKET= >value, $
*GRAPH_JS
chartType: "com.ibi.simple_bar",
*END
ENDSTYLE
END
```
Run the chart. The output is shown in the following image.

Building a Document

Document view allows you to build multiple reports and charts on the same canvas. The styling, design, and report building functionality of Live Preview and Query Design view is available in Document view.

In addition, there are many other features that simplify building documents. You can build and insert multiple reports in the form of reports and charts into documents. You can also insert images and text for presentation and organizational purposes.

Inserting Reports From Multiple Data Sources

With InfoAssist+ opened in Document view, you can insert multiple charts and reports onto the canvas. These reports can be from different data sources. With documents, you have the option to add additional data sources to the document.

In order to insert reports from different data sources, the document must have multiple data sources loaded. For more information on adding and switching between data sources, see Data Tab.

Procedure:  **How to Insert Two Reports From Two Different Data Sources**

A document can display multiple reports from multiple data sources in the same document.

1. With InfoAssist+ open in Document view, click the Insert tab and select chart or report.
2. If your document has only one data source, insert additional data sources.  
   For more detailed instructions on inserting multiple data sources, see Data Tab.

3. Switch to a data source different than the one used in step 1.  
   For more detailed instructions on switching to a different data source, see Data Tab.

4. Insert a chart or report using this new data source, following the instructions given in Inserting a New Report on page 45.
   Your document is now populated with reports that have data from different data sources. You can add as many data sources as you need.

Inserting a New Report

With InfoAssist+ opened in Document view, you can insert multiple charts and reports onto the canvas. The procedures in the following sections detail how to insert reports into documents.

In Document view, you can insert a report in the following ways.

- Use the Insert tab.
- Double-click a data source field.
- Right-click a data source field.
- Drag a data source field onto the canvas.

**Note:**

- When you use the Insert tab, double-click a data source field, or right-click a data source field, a report placeholder is added to the canvas.
- When you insert an existing report, which has already been created and is referenced via INCLUDE syntax, and then select it on the Document canvas, the data fields do not display in the Query pane.

Dragging a data source field onto the canvas inserts the placeholder at the location you dropped it.

The following procedures describe how to insert new reports. For more information on how to edit existing reports, see How to Style and Customize a Report on page 53.

**Procedure:** How to Insert a Report

Do one of the following, while in Document mode:

- On the Insert tab, in the Reports group, click Report. Add fields to the placeholder report.
On the Home tab, in the Format group, click Report. Double-click a data source to automatically create a report with that data.

On the Home tab, in the Format group, click Report. Drag a field to the canvas to create a report.

**Inserting a New Chart**

With InfoAssist+ opened in Document view, you can bring multiple charts and reports onto the canvas. The procedures in the following sections describe how to insert charts into documents.

In Document view, you can insert a chart in the following ways:

- Use the Insert tab.
- Double-click a data source field.
- Right-click a data source field.
- Drag a data source field from the Resources panel onto the canvas.

**Note:** When you use the Insert tab, double-click a data source field, or right-click a data source field, a chart placeholder is added to the canvas.

Dragging a data source field onto the canvas inserts the placeholder at the location you dropped it.

The following procedures describe how to insert new charts. For more information on how to edit existing charts, see How to Style and Customize a Chart on page 53.

**Procedure: How to Insert a Chart**

1. Do one of the following, while in Document mode:
   - On the Insert tab, in the Reports group, click Chart. Add fields to the placeholder chart.
   - On the Home tab, in the Format group, click Chart. Double-click a data source to automatically create a chart with that data.
   - On the Home tab, in the Format group, click Chart. Drag a field to the canvas to create a chart.

2. Optionally, change the chart format using the options on the Format tab, in the Chart Types group.
Inserting an Existing Report

With InfoAssist+ opened in Document view, you can insert existing charts and reports onto the canvas from the Insert tab. The following procedure describes how you can insert reports into new documents and documents that are already populated with reports, text, and images.

**Note:** When working in Document view, you cannot insert an existing report that has a HOLD.

**Procedure:** How to Insert an Existing Report With the Insert Tab

You can create a document in the Custom Reports section of the domain and use Standard Reports items as Existing Report components. You cannot use other Custom Report items as components.

1. With InfoAssist+ open in Document view, click the **Insert** tab.
2. In the **Reports** group, click **Existing Report**.
   
   An Open dialog box appears.
3. Browse to the report that you want to insert and click **Open**.
   
   The report placeholder is added to the canvas.

   **Note:** You cannot edit an existing report that is inserted into a document.

Creating a Document From a Single Report

You can take a single report created in Live Preview or Query Design view and convert it into a document, displaying it in Document view.

When you convert a single report into a document, the original report is preserved and a copy of that report is opened as a document in Document view. You can then add additional reports, charts, images, and text.

Inserting Text and Images

With InfoAssist+ opened in Document view, you can bring text and images onto the canvas. The following procedures describe how you can insert text and images into new documents and documents that are already populated with reports, text, and images.

**Note:** You can only do this in Document view.

The following procedures detail how to insert text and images. For more information on how to edit existing text and images, see *Editing Components in a Document* on page 48.
Procedure: How to Insert Text

1. With InfoAssist+ open in Document view, click the Insert tab.
2. In the Objects group, click Text Box.
   A text component is added to the canvas, containing default text.
3. Double-click, or right-click, the text component to edit the text.
   For more information on editing and styling the text, see How to Edit Text on page 54.

Procedure: How to Insert an Image

1. With InfoAssist+ open in Document view, click the Insert tab.
2. In the Objects group, click Image.
   An Open dialog box appears.
   Note: By default, the Open dialog box displays image files in the current WebFOCUS Content folder.
3. Browse to the desired image and click OK.
   The selected image is added to the canvas.

Editing Components in a Document

The reports, controls, and text in a document can be edited, moved, resized, and deleted. Each of these components has a context menu which can be accessed by right-clicking the component.

Images can be moved, resized, and deleted, but they have no context menu and cannot be edited. Right-clicking a image brings up the option to delete it.

Procedure: How to Resize a Component

You can resize a component in the following ways:

- Using the component sizing handles.
- Changing the height and width on the Layout tab, in the Size & Arrange group.
- Accessing the options on the Size tab in the Size and Position dialog box.

The resize feature is available for all components that can be added to a document.

1. Open or create a document with at least one report, text component, control, or image.
2. Resize the component in one of the following ways:

- **Sizing Handles:** Select the component and drag the sizing handles that appear around it. As you manually increase the height and width of the component, the new values appear in the corresponding text boxes in the Size & Arrange group of the Layout tab.

- **Ribbon:** You can use the ribbon in one of the following ways:
  - Select the component in the document. On the Layout tab, in the Size & Arrange group, enter values in the Height and Width fields.
  - On the Layout tab, in the Size & Arrange group, click the dialog box launcher to open the Size and Position dialog box, as shown in the following image.

![Size and Position dialog box](image)

- **Shortcut Menu:** Right-click the component and select *Size and Position*. The Size and Position dialog box opens.

  **Note:** You must right-click the corner of the component. For charts, if you click on any other point in the chart, the Size and Position option will not display.

  From the Size and Position dialog box, open the Size tab.

  Use the Height and Width options to change the position of the selected component.

  You can adjust the pixel size of the object with the Size options or the scale percentage of the object with the Scale options.
You can lock the aspect ratio using the Aspect Ratio button, which is available when working with charts, images, and text boxes while working in Document view. With the aspect ratio locked, changing the width automatically changes the height to keep the component to scale, and changing the height automatically changes the width.

**Note:** The Auto Overflow option is only available while working with reports in Document view through the Size & Arrange group. With Auto Overflow set, you cannot manually set the height and width of a report. The area of the report expands automatically to show all data.

When two objects are selected, the *Relative Position* button sets the bottom-left corner of the component that is higher on the page to the upper-left corner of the one that is lower. Once a relationship is created, arrows appear to show that relationship while both items are still selected.

**Procedure:** How to Move a Component

You can move a component by clicking it, or by accessing the Position section of the Size and Position dialog box. This feature is available for all components that can be added to a document.

You can also align components with each other so that their horizontal or vertical position matches. For more information, see *How to Align Components* on page 50.

1. Open or create a document with at least one report, text component, control, or image.
2. Select the component and move it by using one of the following methods:

   - Drag the component anywhere on the canvas.
   - or
   - Right-click the component and click *Size and Position*.
     
     - On the Size and Position dialog box, click the *Position* tab.
     - Use the Horizontal and Vertical options to change the position of the selected component.

**Procedure:** How to Align Components

You can align components with each other so that their horizontal or vertical positions match. You must have multiple components selected to use the align options.
The alignment is anchored by the component that is in the farthest position of the selected alignment. For example, if you select two components and click **Align Left**, the components align horizontally with the component farthest to the left.

1. Open or create a document with at least two components.
2. Select a component.
3. Select a second component by holding the Ctrl key and clicking a component.

**Note:** You can select multiple components simultaneously by holding the Ctrl key and with the left mouse dragging a selection box around the components. When you release the mouse, sizing handles appear around each component that you selected. If the components display with light-grey coloring, this indicates that the components are selected.

Sizing handles appear around the components, as shown in the following image.
4. Align the components using one of the following methods:

- Right-click one of the selected components and select an alignment option from the Align drop-down menu, as shown in the following image.

![Align Menu Image]

- Access the alignment options from the Align drop-down menu. The menu is available on the Layout tab, in the Size & Arrange group.

The selected components align, as shown in the following image.

![Aligned Components Image]

5. Click anywhere in the canvas to deselect the components.
**Procedure:**  How to Style and Customize a Report

When you select a component, you can perform various functions on the component, such as moving and resizing it, as explained in *How to Move a Component* on page 50 and *How to Resize a Component* on page 48. After clicking a component, you can use the ribbon to affect all settings of the selected component, except for fields. You can right-click a component to select individual fields to edit through the context menu.

In addition to reports, you can style and customize charts and text. For more information on charts, see *How to Style and Customize a Chart* on page 53. For more information on text, see *How to Edit Text* on page 54.

**Note:** Images cannot be edited.

1. Open or create a document with at least one report.
2. Click the report.

   The Query pane becomes active and you can now select fields within the report. Select a field by clicking it in the canvas or in the Query pane.

**Procedure:**  How to Style and Customize a Chart

When you select a component, you can perform various functions on the component, such as moving and resizing it, as explained in *How to Move a Component* on page 50 and *How to Resize a Component* on page 48. After clicking a component, you can use the ribbon to affect all settings of the selected component, except for fields. You can double-click or right-click a component to select individual fields to edit through the context menu or Field tab.

In addition to charts, you can style and customize reports and text. For more information on reports, see *How to Style and Customize a Report* on page 53. For more information on text, see *How to Edit Text* on page 54.

**Note:** Images cannot be edited.

1. Open or create a document with at least one chart.
2. Click the chart.

   The Query pane becomes active and you can now select fields within the chart. Select a field by clicking it in the canvas or in the Query pane.

   You can now edit the selected chart using commands available through the context menu or the ribbon.
**Procedure: How to Edit Text**

When you select a component, you can perform various functions on the component, such as moving and resizing it, as explained in *How to Move a Component* on page 50 and *How to Resize a Component* on page 48. After clicking a component, you can use the ribbon to affect all settings of the selected component, except for fields. You can right-click a component to select individual fields to edit through the context menu.

In addition to editing text, you can style and customize reports and charts. For more information on reports, see *How to Style and Customize a Report* on page 53. For more information on charts, see *How to Style and Customize a Chart* on page 53.

**Note:** Images cannot be edited.

1. Open or create a document with at least one text component.
2. Click the text box.
   
   Sizing handles appear around the border and the text box toolbar becomes active.
3. Click anywhere in the text box and begin entering text.
4. Highlight the text you would like to edit, and right-click it. A menu of options appears, as shown in the following image.

5. Using the menu options, you can style the text and insert quick text.

   The text component menu options are as follows:

   - **Font.** Opens a list of available fonts for the selected text.
Procedure: How to Delete a Component

The following procedure applies to all components in Document view.

1. Open or create a document with at least one component.
2. Right-click the component and click Delete.

The component is deleted from the canvas.

**Note:** You can also delete a component by clicking it and pressing the Delete key.

Creating Multi-Page Documents

In Document mode, content can be created on multiple pages. The available output formats are: HTML, active report, PDF, Excel (xlsx), and PowerPoint (pptx). Additional Excel formats are available, as well.

**Note:** When working in Document mode using the active report format, you can create a rich, multi-object document that integrates various reports and charts, closely resembling a dashboard.
Microsoft Excel 2007 and Microsoft PowerPoint 2007 are enabled by default in the Administration Console. To enable or disable formats, you must do so in the Administration Console.

- The active report output format combines multiple reports and charts into one document, resulting in a tabbed active dashboard.
- Excel combines multiple reports as different sheets in a workbook.
- PowerPoint combines multiple reports and charts in a single slide.

Creating Multi-page Documents

You can create multi-page documents, allowing you to display an array of information across different pages.

Procedure: **How to Create a Multi-page Document**

1. Create a new document.
   
   Page 1 appears on the canvas title bar.
2. Add content, such as a new or existing report, chart, text, and images to Page 1.
3. To add another page, do one of the following:
   - On the Insert tab, in the Pages group, click **Page**.
   - On the canvas title bar, click the page icon. From the Page menu that opens, select **New Page**.

   A new page, for example, Page 2, is inserted after the current page, and appears on the canvas.

   Each new page that you add is named Page \( n \), where \( n \) is a unique number increasing by an increment of 1.
4. Add content to Page 2.
5. Repeat steps 3 - 4 until your document is complete.

   To navigate between pages, open the Page menu by clicking the Page icon at the top of the canvas.

Creating a Multi-page Active Technologies Dashboard

You can create a multi-page active technologies dashboard using InfoAssist+.
**Procedure: How to Create a Multi-page Active Technologies Dashboard**

1. Create a new active dashboard by setting the output format to active report.
   - Page 1 appears on the canvas title bar.

2. Add content, such as a new or existing report, chart, text, images, and active dashboard prompts to Page 1.

3. To add another page, do one of the following:
   - On the Insert tab, in the Pages group, click Page.
   - On the canvas title bar, click the page icon. From the Page menu that opens, select New Page.

   A new page, for example, Page 2, is inserted after the current page, and appears on the canvas.

   Each new page that you add is named Page n, where n is a unique number increasing by an increment of 1.

4. Add content to Page 2.

5. Repeat steps 3 - 4 until your dashboard is complete.

   To navigate between pages, open the Page menu by clicking the Page icon at the top of the canvas.

6. Run the active dashboard.
   - The tabs appear at the top of the canvas.

**Navigating the Page Menu**

You can access the Page menu by clicking the Page icon in Design mode.

The Page menu lists the pages in the order in which you created them. You can rearrange the pages using drag-and-drop functionality. You can also select multiple pages and delete them.

In addition, the Page menu contains the New Page option to add a new page to the document. The Duplicate option creates a duplicate page.

The Page menu also contains Page Options which you can click to launch a dialog box of the following options:

- Rename Page
- Move Page Up

Creating Content
When you select a page, the Rename, Move Up, Move Down, and Delete options become active in the menu bar at the top of the dialog box. Also, when you right-click a page, a context menu of these same options opens.

The position of the page that you have selected determines which directional options are available. For example, Move Up would not be an option for Page 1. Move Down would not be an option for the last page.

To close the dialog box, click OK.

**Using the Active Cache Option**

Because all post-retrieval processing is performed in the memory of the web browser, an active report has a processing limit of approximately 5,000 records or 100 pages of output. The active cache option enables you to send only the first page of active report output to the browser and retrieve subsequent pages from a temporary cache on the Reporting Server.

**Tip:** It is recommended that you set the number of rows retrieved five times greater than the number of lines retrieved per page (as indicated in SET LINES). The minimum number of rows retrieved is 100.

**Enabling Active Cache Through InfoAssist+**

Active cache is enabled when you select active report as the output type and the Pages on Demand button (Format tab, Navigation group) is enabled.

The Advanced tab on the active report options dialog box contains the Rows Retrieved drop-down list. Use this setting to establish the increments in which the cached data stored in a binary file is returned to the output window. The default is 100.

**Note:** In a multi-page document, active cache must be enabled per component. It is not globally set. Therefore, when creating a document in AHTML format, you must select each component separately to enable active cache. When you do so, the Pages on Demand button is activated.

**Building Visualizations**

Visualizations centralize information by providing different views of data that are pertinent to a particular objective. For example, reviewing trends or fluctuations in data over a period of time or within a region. A visualization provides you with a quick glance of information on a single screen.
Visualizations support the use of different types of charts, maps, and grids. For example, you may want to use a bar, pie, and line chart to show different views of the same data. Alternatively, you may want to offset a particular visual by showing other types of related data that employ a different type of visual. You can also add a text cell to your visualization to provide explanatory text or information that other users can reference.

Visualizations allow you to monitor changes in data. They also serve to provide information in real-time, based on changes in underlying data or other components. A visualization can be updated, changed, or revised at any time to account for shifts in data needs.

Creating a Visual

You can create charts, maps, and grids to visually represent your data. You can add multiple visuals to the canvas to create a complete visualization.

The default visual is a bar stacked chart. You can use the Change option in the Visual group on the Home tab to change the visual type.

The following visual is a matrix marker chart that shows sales data for a range of electronic products.
Procedure: How to Create a Visualization From InfoAssist+

You can have multiple file types opened at once. To create a visualization:

1. On the Quick Access toolbar, click New.
   
   or
   
   Click the Application Main Menu button, and click New.

   The InfoAssist+ splash screen displays.

2. Click Build a Visualization.

3. In the Open dialog box, select a data source and click Open.

   InfoAssist+ switches to visualization mode.

Changing the Visual Type

You can create a visual using the default chart type, which is a stacked bar chart. You can add your data to this chart and then change the chart type, or you can change the chart type prior to making your data selections.

Once you have started exploring your data, you can switch between the different types to obtain the graphical image that you wish to display.

You change the visual type from the Home tab.

Procedure: How to Change the Visual Type

1. On the Home tab, in the Visual group, click Change, as shown in the following image.

   ![Change Icon](image)

   Note: The Change icon updates depending on the chart, map, or grid that you select from the Select a Visual menu. By default, the Change icon displays a stacked bar chart.

   The Select a Visual menu displays.

2. On the Select a Visual menu, click the type of visual that you want to use.

   Your canvas refreshes and displays the visual that you selected.
Narrating Charts

Narrative charts tell the story of your data. When creating a bar, line, area, or pie chart, you can bring your chart to life with words that describe your data, as shown in the following image.

The data represents the Gross Profit for the following Product Categories: Stereo Systems, Media Player, Camcorder, Accessories, Video Production, Computers and Televisions.

If your administrator has activated this feature for you, you can enable Narrative Charts from the ribbon. On the Format tab, in the Features group, click Narrative. This will add descriptive text for the current chart or visual.

Narrative charts let you communicate about your data, summarizing data values and providing an interpretation of the results.

Selecting a Visual

It is important that you select a chart, grid, or map that appropriately displays a meaningful view of your data. InfoAssist+ provides a library of visuals.

You can select a visual type from the Select a Visual menu, on the Home tab, in the Visual group. The following table describes the types of charts available.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Visual Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Grid Icon" /></td>
<td>Grid</td>
<td>Grids provide a tabular view of data. They allow you to review data in a row and column format, similar to a printed report.</td>
</tr>
<tr>
<td><img src="image" alt="Bar Chart Icon" /></td>
<td>Bar chart</td>
<td>Bar charts plot numerical data by displaying rectangular blocks against a scale (numbers or variable measure fields that appear along the axis).</td>
</tr>
<tr>
<td><img src="image" alt="Stacked Bar Chart Icon" /></td>
<td>Stacked bar chart</td>
<td>A stacked bar chart is the default visual.</td>
</tr>
<tr>
<td><img src="image" alt="Absolute Line Chart Icon" /></td>
<td>Absolute line chart</td>
<td>Line charts allow you to trace the evolution of a data point by working backwards or interpolating. Highs and lows, rapid or slow movement, or a tendency towards stability are all types of trends well suited for a line chart.</td>
</tr>
<tr>
<td><img src="image" alt="Area Chart Icon" /></td>
<td>Area chart</td>
<td>Area charts analyze trends over time and look for differences in values.</td>
</tr>
<tr>
<td><img src="image" alt="Stacked Area Chart Icon" /></td>
<td>Stacked area chart</td>
<td>Stacked area charts allow you to stack data on top of each other.</td>
</tr>
<tr>
<td><img src="image" alt="Pie Chart Icon" /></td>
<td>Pie chart</td>
<td>Pie charts are circular charts that represent parts of a whole. A pie chart emphasizes where your data fits, in relation to the other components in the pie.</td>
</tr>
<tr>
<td><img src="image" alt="Ring Pie Chart Icon" /></td>
<td>Ring pie chart</td>
<td>Ring pie charts are useful when you want to review the value of each segment, which represents the measure value for the selected dimension, as it relates to the total for the selected measure.</td>
</tr>
<tr>
<td>Icon</td>
<td>Visual Type</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Scatter Plot</td>
<td>Scatter charts enable you to plot data using variable scales on both axes. When you use a scatter chart, the data is plotted with a hollow marker, so that you can visualize the density of individual data values around particular points, or discern patterns in the data.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Bubble chart</td>
<td>Bubble charts can have two column fields representing X and Y data values, or have three column fields representing X, Y, and Z data values. The third variable (Z) represents size. The size of each bubble is used to show the relative importance of the data.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Matrix Marker chart</td>
<td>Matrix marker charts are useful for analyzing one or two measures against a crosstab of two categorical dimensions. The result is a color-scaled matrix chart that shows categorized trends.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>Treemap</td>
<td>Treemaps are used to display large amounts of hierarchically structured data. Using a set of nested rectangles to illustrate data relationships, sections of a treemap represent branches of a tree.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>Gauge</td>
<td>Gauges are used to display the value of a measure. In particular, circular gauges are used to represent a single data value within a given spectrum. You can create a single circular gauge for a measure or a matrix circular gauge, which shows the value of the selected measure across different dimensions, such as product category or yearly sales.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>Choropleth map</td>
<td>A geographically-based heat map. It is useful for visualizing location-based data, trends, and distributions across a geographic area.</td>
</tr>
<tr>
<td><strong>Icon</strong></td>
<td><strong>Visual Type</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
<td>-----------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Proportional symbol map</td>
<td>A technique that uses symbols of different sizes to represent data associated with different areas or locations within the map.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Heatmap</td>
<td>A heatmap is a graphical representation of data where the individual values that comprise a matrix are represented as colors. Using radiant hues, you can track the intensity of a data relationship using the colors defined in the legend.</td>
</tr>
</tbody>
</table>

**Note:** When new data is added to a bar, line, area, pie, scatter, bubble, gauge, or treemap chart, the chart will morph and rebuild, revealing the new values in a smooth transition.

Use the topics in this section to select and create your visuals.

**Grids**

Grids provide a tabular view of data. They allow you to review data in a row and column format, similar to a printed report.

In the following example, we review the Sale Year and Product Category data for the following measure fields:

- Revenue
Gross Profit

<table>
<thead>
<tr>
<th>Sale Year</th>
<th>Product Category</th>
<th>Revenue</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014</td>
<td>Accessories</td>
<td>$16,060,415.69</td>
<td>$4,945,779.69</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>$7,857,928.55</td>
<td>$3,376,360.55</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>$30,105,200.05</td>
<td>$6,730,870.05</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>$9,295,726.31</td>
<td>$1,964,927.31</td>
</tr>
<tr>
<td></td>
<td>Video Production</td>
<td>$7,313,170.38</td>
<td>$2,286,521.38</td>
</tr>
<tr>
<td>2015</td>
<td>Accessories</td>
<td>$35,619,872.81</td>
<td>$10,953,840.81</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>$24,176,475.33</td>
<td>$8,277,897.33</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>$65,002,426.97</td>
<td>$14,480,370.97</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>$20,042,855.67</td>
<td>$4,262,155.67</td>
</tr>
<tr>
<td></td>
<td>Video Production</td>
<td>$15,959,696.26</td>
<td>$4,938,902.26</td>
</tr>
<tr>
<td>2016</td>
<td>Accessories</td>
<td>$53,208,007.57</td>
<td>$16,362,313.57</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>$63,190,001.88</td>
<td>$18,677,664.88</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>$99,448,235.40</td>
<td>$22,237,625.40</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>$30,964,700.29</td>
<td>$6,560,087.29</td>
</tr>
<tr>
<td></td>
<td>Video Production</td>
<td>$23,810,094.17</td>
<td>$7,330,486.17</td>
</tr>
</tbody>
</table>

**Procedure:** How to Create a Grid

1. Change the visual to a grid, or insert a new grid.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - **Rows or Columns** - one or more data fields
   - **Measure** - one or more data fields

As you add, edit, or rearrange the fields in your Query field containers, your canvas refreshes.
Bar Charts

Bar charts plot numerical data by displaying rectangular blocks against a scale (numbers or variable measure fields that appear along the axis). The length of a bar corresponds to a value or amount. You can clearly compare data series (fields) by the relative heights of the bars. Use a bar chart to display the distribution of numerical data. You can create horizontal and vertical bar charts.

**Note:** If you are working with a large dataset, a scroll bar displays under your chart, enabling you to easily scroll through your data from left to right. In visualization mode, scroll bars are automatically enabled, but if you want to disable or re-enable scroll bars, click the Format tab and then click *Interactive Options*. In the Interactive Options dialog box, select the *Auto Enable X-Axis Scrolling* check box. If you are working in any other mode, you must enable this functionality.

Use a bar chart when individual values are important. For example, the following image is a basic vertical bar chart that compares the individual products sold to the total amount in sales for each product. A retailer would find it important to know which pieces of inventory are selling and how much revenue each item is generating for the company.

![Bar Chart Example](image_url)
A horizontal bar chart becomes useful when you want to emphasize a ranking relationship in descending order, or the X-axis labels are too long to fit legibly side-by-side. For example, the following image is a basic horizontal bar chart that ranks which products are generating the most revenue for the retailer.

![Horizontal Bar Chart Example](image)

**Note:** You can swap the orientation of your data in a bar chart. To do so, on the *Home* tab, in the *Visual* group, click *Swap*.

**Procedure:**  **How to Insert a New Bar Chart**

1. Change the visual to a bar chart or insert a new bar chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field

**Note:** You can also double-click a data field to add it to your Query field containers.

The bar chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the bar chart.
Procedure: How to Create a Stacked Bar Chart

The bar stacked visual is the default visual.

1. Change the visual to a stacked bar chart or insert a new stacked bar chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one or more data fields
   - Color - one data field

Note: You can also double-click a data field to add it to your Query field containers.

The stacked bar chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the stacked bar chart.

Line Charts

Line charts allow you to trace the evolution of a data point by working backwards or interpolating. Highs and lows, rapid or slow movement, or a tendency towards stability are all types of trends well suited for a line chart.

You can also plot line charts with two or more scales to present a comparison of the same value, or set of values, in different time periods.

Note: If you are working with a large dataset, a scroll bar displays under your chart, enabling you to easily scroll through your data from left to right. In visualization mode, scroll bars are automatically enabled, but if you want to disable or re-enable scroll bars, click the Format tab and then click Interactive Options. In the Interactive Options dialog box, select the Auto Enable X-Axis Scrolling check box. If you are working in any other mode, you must enable this functionality.
Use a line chart when you want to trend data over time, for example, monthly changes in employment figures, or yearly sales of an item in your inventory. The following image is a line visual that shows the gross profit in monthly sales for products.

![Line chart showing gross profit in monthly sales for products](image)

**Procedure: How to Create a Line Chart**

1. Change the visual type to a line chart or insert a new line chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Color - one data field (optional)

**Note:** You can also double-click a data field to add it to your Query field containers.

To add insight, you can drag a data field to the color Query field container. This displays the values for this field using color.
The line chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the line chart.

**Area Charts**

Area charts analyze trends over time and look for differences in values by using the see-thru nature of the area fills. Stacked area charts allow you to stack data on top of each other. Stacking allows you to highlight the relationship between data series, showing how some data series approach a second series.

**Note:** If you are working with a large dataset, a scroll bar displays under your chart, enabling you to easily scroll through your data from left to right. In visualization mode, scroll bars are automatically enabled, but if you want to disable or re-enable scroll bars, click the Format tab and then click *Interactive Options*. In the Interactive Options dialog box, select the *Auto Enable X-Axis Scrolling* check box. If you are working in any other mode, you must enable this functionality.

Use an area chart when you want to distinguish the data more dramatically by highlighting volume with color. For example, the following image is a basic area chart that depicts the yearly gross profit for various electronic products.
**Procedure:** How to Create an Area Chart

1. Change the visual type to an area chart or insert a new area chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Color - one data field (optional)

**Note:** You can also double-click a data field to add it to your Query field containers.

The area chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the area chart.

**Procedure:** How to Create a Stacked Area Chart

1. Change the visual type to a stacked area chart or insert a new stacked area chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Color - one data field (optional)

**Note:** You can also double-click a data field to add it to your Query field containers.

The stacked area chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the stacked area chart.

**Pie Charts**

Pie charts are circular charts that represent parts of a whole. A pie chart emphasizes where your data fits, in relation to the other components in the pie. Pie charts work best when there are a limited number of slices (for example, less than 10) and the slices are all of a sufficient value as to reveal their fill color inside their wedge.
Use a pie chart when you have segments of data that you want to display as a whole. For example, the following image is a pie chart that shows the proportions of various electronic products based on the quarterly revenue.

You can add one or more measures to the Measure field container. Each measure will be used to create a separate, unique pie chart, to which you can add a measure or dimension to the Color field container to add color to your chart.

**Note:** When working with pie charts, you can add one measure field to the Color field container. This adds the measure as a By field, and determines how the pie chart is colored. Depending on your measure data, this may result in a large number of pie segments.

**Procedure: How to Create a Pie Chart**

1. Change the visual type to a pie chart or insert a new pie chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - **Measure** - one data field. Data in this category is used to indicate the size of the pie slice for the relevant category.
   - **Color** - one data field. Data in this category indicates the colors in your pie chart.
Note: You can also double-click a data field to add it to your Query field containers.

The pie chart displays on the canvas. You can add additional data fields for comparative purposes, or to create another pie chart on the same canvas. You can also view underlying data by hovering over any particular point on the pie chart.

Ring Pie Charts

Ring pie charts are circular charts that display the total for the selected measure, as well as the individual segments that comprise the ring pie chart. You can hover over each segment to review the underlying data values. This is useful when comparing the measure value for an individual segment against the total for the measure, which displays in the center of the ring pie.

You can add one or more measures to the Measure field container. Each measure will be used to create a separate, unique ring pie chart, to which you can add a measure or dimension to the Color field container to add color to your chart.

Note: The font size of the value label in the middle of the ring is automatically set by the chart engine.
Use a ring pie chart when you want to review the value of each segment, which represents the measure value for the selected dimension, as it relates to the total for the selected measure. The following image is an example of a ring pie chart.

**Procedure:** How to Create a Ring Pie Chart

1. Change the visual type to a ring pie chart or insert a new ring pie chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Measure - one data field. Data in this category is used to indicate the size of the ring pie segment for the relevant category.
   - Color - one data field. Data in this category indicates the colors in your ring pie chart.

**Note:** You can also double-click a data field to add it to your Query field containers.

The ring pie chart displays on the canvas. The total for the selected measure displays in the center of the ring pie chart. You can view underlying data by hovering over any of the ring pie chart segments.
**Scatter Charts**

Scatter charts enable you to plot data using variable scales on both axes. When you use a scatter chart, the data is plotted with a hollow marker, so that you can visualize the density of individual data values around particular points, or discern patterns in the data. A numeric X axis, or sort field, always yields a scatter chart, by default.

**Note:** You can specify a non-measure (dimension) data field on the horizontal or vertical axis, or both.

If your chart reveals clouds of points, there is a strong relationship between X and Y values. If data points are scattered, there is a weak relationship, or no relationship.

Adding data fields to the Detail Query field container creates additional BY fields on the scatter chart. For example, the following image shows the results when adding the Product, SubCategory and Model dimension fields to Detail Query field container in a scatter chart which showed gross profit and MSRP data.

![Scatter Chart Example](image)

**Procedure:** How to Create a Scatter Chart

1. Change the visual type to a scatter chart or insert a new scatter chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:

- Vertical Axis - one data field
- Horizontal Axis - one data field
- Detail - one or more data fields
- Color - one data field

**Note:** You can also double-click a data field to add it to your Query field containers.

The scatter chart displays on the canvas. You can also view underlying data by hovering over any particular point on the scatter chart.

**Bubble Charts**

A bubble chart is a chart in which the data points are represented by bubbles. Bubble charts can have two column fields representing X and Y data values, or have three column fields representing X, Y, and Z data values, in that order. The Z variable represents size. The size of each bubble is used to show the relative importance of the data.

When you add a data field to the Size field container, this value is represented as the Z Axis Title in the legend. It displays as an empty Z Axis Title when a size data field is not specified. If you choose to indicate a Z, or size, data value, the data label displays in the legend. A Size Legend also displays, showing the estimated data value for a range of circle sizes. This allows you to estimate the value of the data based on the size of the circle.

**Note:**

- You can hover over the circles in the visual to obtain exact data values for any given point.
- You can specify a non-measure (dimension) data field on the horizontal or vertical axis, or both.
- In Visualization mode and for HTML5 charts, if you select the No fill option for your Series style when creating a bubble chart, the series displays in shades of black. For active charts, you must enable the Show Border Color option in order to view the bubbles in your chart at run time, otherwise the bubbles are invisible.
In the following image, a bubble chart is used to show the Manufacturers Suggested Retail Price (MSRP) plotted against Revenue for a variety of electronics products. It also shows the values for Gross Profit, which was specified in the Size field container in the Query pane.

**Procedure:** How to Create a Bubble Chart

1. Change the visual to a bubble chart or insert a new bubble chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one data field
   - Horizontal Axis - one data field
   - Detail - one or more data fields
   - Size - one data field
   - Color - one data field (optional). Labels for the values in this data field will comprise the legend.

**Note:** You can also double-click a data field to add it to your Query field containers.

The bubble chart displays on the canvas. You can also view underlying data by hovering over any particular point on the bar chart.
Matrix Marker

Matrix marker charts are useful for analyzing one or two measures against a crosstab of two categorical dimensions. You can use the Size Query field container for one measure and the Color Query field container for a second measure. The result is a color-scaled matrix chart that shows categorized trends, as shown in the following image.

### Procedure: How to Create a Matrix Marker Chart

1. Change the visual to a matrix marker chart or insert a new matrix marker chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Matrix Rows - one data field
   - Matrix Column - one data field
   - Size - one data field. The data for this field determines the size of the marker.
   - Color - one data field. The data in this field determines the color of the marker.

The matrix marker chart displays.
Treemaps

Treemaps are used to display large amounts of hierarchically structured data. Using a set of nested rectangles to illustrate data relationships, sections of a treemap represent branches of a tree. Each branch is given a rectangle, to which any number of smaller sub-branches can be assigned. The size of each branch is proportional to the summed values of the elements inside the branch.

The following treemap shows the categories of the selected dimension fields, using two data fields to determine the size and color of the treemap segments.

---

**Procedure:** How to Create a Treemap

1. Change the visual to a treemap or insert a new treemap.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - **Grouping** - one or more data fields, which establishes the hierarchy of the Treemap grouping.
   - **Size** - one data field. This data controls the size of the branches that display.
   - **Color** - one data field. This data controls the colors that display based on the accompanying gradient.
Gauges

Gauges are used to display the value of a measure. In particular, circular gauges are used to represent a single data value within a given spectrum. These gauges have a circular shape. You can create a single circular gauge for a measure or a matrix circular gauge, which shows the value of the selected measure across different dimensions, such as product category or yearly sales. The value of the measure that displays in a circular gauge is determined by the underlying data stored for that measure in the database.

The circular gauge functionality uses only one measure in its presentation. The legend reflects the color of the measure within the circular gauge.

In the following example, we review revenue data for each product category by quarterly sales in a matrix circular gauge chart.

<table>
<thead>
<tr>
<th>Sale Quarter</th>
<th>Accessories</th>
<th>Computers</th>
<th>Media Player</th>
<th>Televisions</th>
<th>Video Production</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>25.7M</td>
<td>19.7M</td>
<td>47.8M</td>
<td>14.9M</td>
<td>11.4M</td>
</tr>
<tr>
<td>2</td>
<td>24.1M</td>
<td>22.0M</td>
<td>44.5M</td>
<td>13.6M</td>
<td>10.9M</td>
</tr>
<tr>
<td>3</td>
<td>24.5M</td>
<td>24.6M</td>
<td>45.4M</td>
<td>14.4M</td>
<td>11.0M</td>
</tr>
<tr>
<td>4</td>
<td>30.7M</td>
<td>29.0M</td>
<td>56.8M</td>
<td>17.4M</td>
<td>13.8M</td>
</tr>
</tbody>
</table>

Procedure: How to Create a Circular Gauge

1. Change the visual type to a gauge or insert a new gauge.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following query field containers must be populated for this visual:

- **Measure** - one data field. Data in this category is used to indicate the value of the selected measure, which displays within the gauge.

- **Tooltip** - one or more data fields. The fields that you add provide you with the ability to review additional related, underlying data for different measures. Tooltips are optional.

**Note:** You can also double-click a data field to add it to your Query field containers.

The circular gauge displays on the canvas. You can select additional measure fields for which to include in the tooltip.

### Heatmaps

A heatmap is a graphical representation of data where the individual values that comprise a matrix are represented as colors. Using radiant hues, you can track the intensity of a data relationship using the colors defined in the legend.

Heatmaps are useful when you are looking for hot spots in your data, or areas of focus or interest, as shown in the following image.
Procedure: How to Create a Heatmap

1. Change the visual to a heatmap or insert a new heatmap.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Color - one data field. This data controls the colors that display based on the accompanying gradient.
   - Horizontal field container - one data field.
   - Vertical field container - one data field

Note: You can optionally populate the Matrix Row and Column fields to increase the segmentation of your heatmap.

The heatmap displays.

Interacting With Visualizations

A visualization is comprised of one or more visuals, such as charts, maps, or grids and text. You can create different views of your data in a single visualization, and share that visualization with others in your enterprise.

The following image shows a sample visualization. This visualization includes a map, a matrix grid, and a stacked area chart.
This section summarizes the tasks that are available to you when working with visuals. It provides centralized instructional information on performing each task and offers links to the most common topics when working with visuals.

<table>
<thead>
<tr>
<th>Task</th>
<th>How To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change visual</td>
<td>On the Home tab, in the Visual group, click Change. Note: The Change icon updates depending on the chart, map, or grid that you select from the Select a Visual menu. By default, the Change icon displays a stacked bar chart. Select a chart, map, or grid from the Select a Visual menu.</td>
</tr>
<tr>
<td>Insert new visual</td>
<td>On the Home tab, in the Visual group, click Insert. Use the default stacked bar chart or click Change to select a different chart, map, or grid from the Select a Visual menu. Note: You can also add additional charts, maps, or grids to a visualization by dragging a data field onto the canvas and placing it using the handles that are available.</td>
</tr>
<tr>
<td>Rearrange visuals</td>
<td>Drag a visual on top of another visual to activate a shaded area that contains handles, which can be used to indicate placement.</td>
</tr>
<tr>
<td>Copying a visual</td>
<td>On the canvas, select a visual. On the Home tab, in the Clipboard group, click Copy. Note: You can also press CTRL+C to copy a selected visual.</td>
</tr>
<tr>
<td>Pasting a visual</td>
<td>Copy a visual. On the Home tab, in the Clipboard group, click Paste. Note: You can also press CTRL+V to paste a copied visual on the canvas.</td>
</tr>
<tr>
<td>Task</td>
<td>How To</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Duplicating a visual</td>
<td>On the canvas, select a visual. On the Home tab in the Clipboard group, click Duplicate. A duplicate visual is created and a sequential number is assigned based on the type of visual.</td>
</tr>
<tr>
<td>Delete visual</td>
<td>Select a visual. On the Home tab, in the Clipboard group, click Cut. You can click the Close button in the upper-right corner of the current visual. From the Query pane, right-click a visual and click Delete. You can also press the Delete key when a visual is selected.</td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Drag a dimension field or measure field into the Filter pane to access the filter options that are available. To add filter options for a field that is already in the Query pane, select the field and on the Field tab, in the Filter group, click Filter.</td>
</tr>
<tr>
<td>Add visuals to the storyboard</td>
<td>Create a visual. On the Home tab, in the Storyboard group, click Add.</td>
</tr>
</tbody>
</table>

**Procedure: How to Insert a New Visual**

1. On the Home tab, in the Visual group, click the down arrow next to Insert.
2. On the menu, click one of the following options:
   - **Chart.** Inserts a stacked bar chart visual.
   - **Grid.** Inserts a grid visual.
   - **Text.** Inserts a blank text cell.
3. Populate your visual with data or add text to the text cell.

**Note:**

- By default, when you click Insert, a stacked bar chart visual is inserted.
You can also drag a data field from the Data pane to the canvas to insert a new visual. This inserts the default visual, a stacked bar chart. You can use the placement handles to position your new visual on the canvas, for example, above an existing visual or to the side of an existing visual.

**Procedure: How to Add Text to Your Visualization**

1. On the Home Tab, in the Visual group, click the down arrow on next to Insert.
2. On the menu, click Text.
   A text cell opens on the canvas.
3. Add text to your visualization.

   **Note:** You can resize the text cell and use the text formatting options to customize the display of any text that you add, as shown in the following image.

You can also position the text cell in your visualization by dragging the text cell on top of a visual. Use the placement handles to indicate placement of the text cell.

**Procedure: How to Create a Visualization**

1. Begin with the default canvas, which consists of a stacked bar chart template.
2. Insert a new visual in one of the following ways:
   a. Drag a data field from the Data pane onto the canvas. Handles display, which allow you to select the location for the new visual, for example, top (above) or left of the current visual.
   
   ![Image of visual insertion]
   

   **Note:** You can optionally click the down arrow on the Insert button to specify the addition of a chart, grid, or text.

3. Add another visual.
   
   Now, three visual cells display side-by-side.

4. Click a visual to select it.

   **Note:** You can click a visual to activate it, or double-click on the visual number or name in the Query pane.

5. Reorganize your visuals using the handles.
6. Once you have organized the placement of your visuals, select one and specify the visual type.
   

   **Note:** The Change icon updates depending on the chart, map, or grid that you select from the Select a Visual menu. By default, the Change icon displays a stacked bar chart.

   b. In the Select a Visual menu, click the type of visual you want to use. For example, Line, Area, or Map.

   c. Repeat these steps for all three visuals on your canvas.

7. Populate each visual with your data.

   You can change the type of visual that you previously selected at any time. You can also resize or reorganize the position of each visual as you add data.

   For example, move the lower-left visual to the top of the visualization.
The bubble chart now runs across the top of the visualization.

8. Click Save to save your visualization.

**Minimizing or Maximizing a Visual**

When working on a visualization with more than one chart, map, or grid, you can maximize and minimize individual visuals. This allows you to focus on one visual at a time, and then minimize it to view it alongside the other visuals.

The maximize and minimize icons are located in the top-right corner of each visual, next to the Close button. When you click the Maximize icon, the current visual moves to the foreground and is the only visual that displays on the canvas. You can work on this visual, and then minimize it to view the other visuals.

**Note:** You can view other visuals in the maximized mode by selecting a different visual in the Query pane.

**Procedure:** How to Minimize or Maximize a Visual

1. Create a visualization with two or more visuals.
2. Perform the following actions to minimize or maximize your visual:
   - Click the maximize icon or double-click on the Title bar to maximize your visual.
   - Click the minimize icon or double-click on the Title bar to minimize your visual.
   You can maximize one visual at a time, and you can switch between visuals in this mode by double-clicking a different visual in the Query pane.

**Procedure: How to Delete a Visual**
1. In your visualization, select the chart, map, or grid that you want to delete.
2. Perform one of the following tasks to delete the visual:
   - Press the Delete key.
   - On the *Home* tab, in the *Clipboard* group, click *Cut*.
   - Click the *Close* button in the upper-right corner of the current visual.
   - From the Query pane, right-click on a visual, and click *Delete*.
   **Note:** You can use the Undo and Redo options on the Quick Access Toolbar to reverse or redo any prior actions.

**Renaming a Visual**
You can rename a visual on the canvas or within your visualization. You may want to do this for presentation and organizational purposes, as each visual has a default label (for example, Bar 1, Bar 2, and Bar 3). You can change these labels by renaming the visual in the Query pane.

Once new labels are in place, it is easier to recognize which visual you want to select at any given time.

Using the shortcut menu for a visual in the Query pane, you can also rename your visual.

**Procedure: How to Rename a Visual**
1. Create a visualization with one or more chart, map, or grid.
2. In the Query pane, right-click the visual number for which you want to modify the title.
3. Click *Rename*.
4. In the Edit Title dialog box, enter a new name for the visual.
5. Click *OK*.
   The visual is renamed in the Query pane and the new title is reflected at the top of the selected visual.
Creating Matrix Charts

Matrix charts are powerful, comparative tools. They provide enough detail to show a trend and they organize information in a categorical fashion.

Matrix charts display data in a grid, showing the comparative values on either axis. They provide you with a quick glance at trends over time, giving you a succinct synopsis of a situation (for example, sales or investment trends).

You can use various formats in your matrix chart (for example, pie or line chart).

In the following example, we review quarterly revenue data, by product category, for a range of years (2014 - 2016, specifically). Using a bar chart for the matrix, we are able to review how gross profit for each product category shifts over time.

You can plot one value on the X axis and one value on the Y axis. For example, sales against region. You can also plot just one value for the rows or columns in the matrix chart.
Procedure: How to Create a Matrix Bar Chart

1. Launch InfoAssist+ in Chart or Visualization mode.
   - In Visualization mode, on the Format tab, in the Chart Types group, click Bar chart.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Bar chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart. The following Query field containers must be populated for this chart:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Matrix Rows - one data field
   - Matrix Columns - one data field

Note: You can also double-click a data field to add it to your Query field containers.

The matrix bar chart displays on the canvas. You can add additional fields for comparative purposes. In Visualization mode, you can also view underlying data by hovering over any particular point on the matrix bar chart.

Procedure: How to Create a Matrix Line Chart

1. Launch InfoAssist+ in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Line chart.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Line chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart. The following Query field containers must be populated for this chart:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Matrix Rows - one data field
   - Matrix Columns - one data field

Note: You can also double-click a data field to add it to your Query field containers.
The matrix line chart displays on the canvas. You can add additional fields for comparative purposes. In visualizations mode, you can also view underlying data by hovering over any particular point on the matrix line chart.

**Related Information:**
- Working with Visualizations

**Procedure: How to Create a Matrix Area Chart**

1. Launch InfoAssist+ in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Area chart.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Area chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Matrix Rows - one data field
   - Matrix Columns - one data field

   **Note:** You can also double-click a data field to add it to your Query field containers.

A matrix area chart displays on the canvas. You can add additional data fields for comparative purposes. In Visualization mode, you can also view underlying data by hovering over any particular point on the matrix area chart.

**Procedure: How to Create a Matrix Pie Chart**

1. Launch InfoAssist+ in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Pie chart.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Pie chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart. The following Query field containers must be populated for this chart:
   - Measure - one data field

   **Note:** Each unique measure field is represented by a separate pie chart.
Procedure: How to Create a Matrix Ring Pie Chart

1. Launch InfoAssist+ in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Other. In the Select a chart dialog box, click Pie, then click Ring Pie.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Line chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart.

The following Query field containers must be populated for this chart:

- Measure - one data field
  
  **Note:** Each unique measure field is represented by a separate ring pie chart.

- Color - one data field

- Matrix Rows - one data field

- Matrix Columns - one data field

**Note:** You can also double-click a data field to add it to your Query field containers.

The matrix ring pie chart displays on the canvas. You can add additional fields for comparative purposes, or to create another pie chart unique to the additional measure fields you select. In Visualization mode, you can also view underlying data by hovering over any particular point on the matrix ring pie chart.
Procedure: How to Create a Matrix Circular Gauge

1. Launch InfoAssist+ in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Other. In the Select a chart dialog box, click Special, then click Gauge.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Gauge.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart. The following query field containers must be populated for this chart:
   - Measure - one data field. Data in this category is used to indicate the value of the selected measure, which displays within the gauge.
     Note: Since the gauge relies on a constant (measure field), each intersection of the matrix chart is calculated using that measure along with the various matrix rows and columns in the matrix chart.
   - Matrix Rows - one data field.
   - Matrix Columns - one data field.
   - Tooltip - one or more data fields. The fields that you add provide you with the ability to review additional related, underlying data for different measures. Tooltips are optional.
     Note: You can also double-click a data field to add it to your Query field containers.

     The matrix circular gauge displays on the canvas. You can select additional measure fields for which to include in the tooltip.

Using Active Technologies

This topic provides an overview of Active Technologies and discusses security and active cache processing. It includes additional information about the features of the product that will help you use it. It is intended for administrators and developers who are responsible for creating active reports, charts, and dashboards.

This topic also describes the features of an Active Technologies report, which is a report that is enabled to use the full capabilities of Active Technologies. An Active Technologies report is also called an active report.
Active Technologies Report Overview

An active report is a report that is designed for offline analysis. When using an active report, you can:

- Interact with the data, using analysis options similar to those found in an Excel® workbook, without any connection to a server. Analysis options include filtering, sorting, charting, and much more.

- Work offline without any additional plug-ins or programs. An active report is a self-contained report, meaning that it contains all the data and JavaScript® within the HTML output file. Packaging the data and the interactive functions in the HTML file also makes the output highly compressible for email and transparent to security systems.

- Save the report on a local machine with active report functionality. Since no connection to a server is required to view the data or use the analysis options, you can save and use the report anywhere.

Performance may vary across browsers due to browser-specific memory limitations. For very large reports, Internet Explorer® may produce an error. For more information, refer to the Microsoft® website.

When working with an active report, you can:

- Filter or highlight data.

- Sort data within any column in ascending or descending order.

- Apply calculations to columns and choose the location at which to display results.

- Control the display of data by hiding columns, freezing columns, limiting the number of rows per page, and using graphic visualization to compare column values.

- Create a variety of simple or advanced charts (pie, line, bar, or scatter) and Rollup Tables.

- Apply a global filter to multiple reports within the same HTML page.

- Export report data and chart data.

- Restore original report settings.

- Run active reports on your mobile device with the Opera browser (Version 8.60 U2 or higher) installed. See the Opera website for a list of supported devices.

- Run active reports on your iPhone® mobile device. For the best performance results, it is recommended that you set a maximum of 500 records for a mobile report.
Some active report functionality is drag and drop based, and thus not supported with iPhone.

The following image shows an HTML active report. The pop-up menu is open for the Sale Unit(s) column, with the Calculate Avg operator selected.

<table>
<thead>
<tr>
<th>Store Region</th>
<th>Business Region</th>
<th>Revenue</th>
<th>Sale Unit(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMEA</td>
<td>Africa</td>
<td>$26,4</td>
<td>▼</td>
</tr>
<tr>
<td></td>
<td>Asia</td>
<td>$30,9</td>
<td>▼</td>
</tr>
<tr>
<td></td>
<td>Europe</td>
<td>$396,2</td>
<td>▼</td>
</tr>
<tr>
<td>North America</td>
<td>Canada</td>
<td>$51,1</td>
<td>▼</td>
</tr>
<tr>
<td></td>
<td>East</td>
<td>$39,0</td>
<td>▼</td>
</tr>
<tr>
<td></td>
<td>Mexico</td>
<td>$12,9</td>
<td>▼</td>
</tr>
<tr>
<td></td>
<td>Midwest</td>
<td>$80,9</td>
<td>▼</td>
</tr>
<tr>
<td></td>
<td>Northeast</td>
<td>$1,5</td>
<td>▼</td>
</tr>
<tr>
<td></td>
<td>South</td>
<td>$77,4</td>
<td>▼</td>
</tr>
<tr>
<td></td>
<td>Southeast</td>
<td>$4,4</td>
<td>▼</td>
</tr>
<tr>
<td></td>
<td>West</td>
<td>$382,3</td>
<td>▼</td>
</tr>
<tr>
<td>Oceania</td>
<td>Australia-New Zealand</td>
<td>$1,2</td>
<td>▼</td>
</tr>
<tr>
<td>South America</td>
<td>SA-Port</td>
<td>$25,9</td>
<td>▼</td>
</tr>
<tr>
<td></td>
<td>SA-Span</td>
<td>$1,2</td>
<td>▼</td>
</tr>
</tbody>
</table>

14 of 14 records, Page 1 of 1
The following image shows the options that are available at the cell level for a report in active report format. Included are the options that reflect Auto Drill, Multi Drill, and Auto Linking functionality. For more information, see *Customizing Content*.

![Options for Cell Level in Active Report Format](image)

**Security Features**

You can password protect an active report. This feature restricts users from viewing the report by requiring them to enter a password before opening the report. The data is encrypted using the 256-bit Advanced Encryption Standard (AES) specification. The password is used as the key for decrypting and encrypting the data. Therefore, the password is not stored in the report, and you do not need a connection to go back to the server for password verification.

The HTML page that you receive contains both the JavaScript and the data for the report so that you can interact with the data in a disconnected mode. Internet Explorer detects the JavaScript and issues a warning. If you look at the Internet Explorer warning, it mentions explicitly the detection of active content, which is the JavaScript. The same warning appears when pop-ups are blocked in the browser.
Handling a Large Amount of Data

Because all post-retrieval processing is performed in the memory of the web browser, an active report has a processing limit of approximately 5,000 records or 100 pages of output. The active cache option enables you to send only the first page of active report output to the browser and retrieve subsequent pages from a temporary cache on the WebFOCUS Reporting Server. The server also becomes the resource for performing all calculations, sorting, and filtering when active cache is enabled. Since active cache uses on-demand paging functionality, WebFOCUS Viewer is not supported.

The active report with active cache option in the clustered server environment, using Cluster Manager (CLM), will maintain the connection with the WebFOCUS Reporting Server on which the temporary cache is created. This enables the retrieval of subsequent pages from the browser, while the report is in the same browser session.

The active cache feature uses a POST instead of a GET in an HTTP request.

Distribution and Viewing Considerations

Active Technologies stores an active report as an HTML file. The HTML file created by Active Technologies contains both the report data and the JavaScript code that enables you to interact with the data in disconnected mode.

An active report is designed for distribution to users who need to perform offline analysis and interactive functions without connection to a server.

You can save an active report from your web browser to another location. You can also send an active report to another person by email, as an HTML attachment. However, when you distribute an active report, you must keep in mind how it will be viewed.

For example, when you send an active report as an HTML attachment to email, many client email programs on a mobile device can block the JavaScript in the attachment. A third-party tool, such as the Mobile Faves App for a mobile device, may be used to correctly view the attachment.

If you try to view an active report in a web browser, and JavaScript is blocked or disabled on your web browser, you will receive a message reminding you that JavaScript must be enabled on the browser. If you are using a mobile device, the message directs you to use the Mobile Faves App. If the Mobile Faves App is not installed, you can download it from the App Store® for iOS devices or from the Google Play™ store for Android™ devices. In the message, App Store and Google Play store are hyperlinks to the Mobile Faves App.
The message is displayed on the Desktop or on a supported mobile device when JavaScript is disabled in a web browser used to open an online or offline active report. It is also displayed on the Preview pane or window of an application used to preview the content of an offline active report.

The following image shows JavaScript disabled in Google Chrome™.
Usage Notes for Active Technologies

The following apply to browser support.

- ActiveX, a technology from Microsoft, is not supported in Microsoft Edge. Any Active Technologies feature that requires the use of ActiveX controls is therefore not available in Microsoft Edge. These features include the following, which are accessible in other browsers at run time, using the column drop-down menu on an active report:
  - Send as E-mail (supported only in Internet Explorer)
  - Save Changes (supported only in Internet Explorer)
  - Export to XML (Excel) when active cache is disabled

- If you are using a Firefox browser and you export an AHTML report to Excel, the file extension that displays is incorrect (for example, .xls.xls). You can override this default value using the browser settings. Specifically, if you click the Always ask me where to save files radio button, located under Options, you will be prompted, upon download, to either open or save the file. You can then provide a name and extension for the file.

The following apply to Active Technologies reports.

- Active reports employ left and right cell padding, by default. This enables you to view the active report consistently, without the concatenation of any values or spacing issues related to the cell padding. In cases where these settings are not defined in the StyleSheet, the default settings for the left and right cell padding are used.

- By default, Active Technologies displays the name specified in the Master File to identify a column in an ACROSS group on a tabular active report. With the following WebFOCUS SET command, you can display the title specified in the Master File, instead of the name, to identify the column:

  SET ACRSVRBTITL = ON

  Active Technologies derives the title from the TITLE attribute in the Master File (for example, TITLE = 'Product ID'). It derives the name from the FIELDNAME or FIELD attribute (for example, FIELD = PCD).

  InfoAssist+ in the Business User Edition does not allow you to create or modify your active report procedures with a text editor. In the Business User Edition, you must issue the SET ACRSVRBTITL = ON command in a server profile (for example, edasprof.prf). When issued in edasprof.prf, the setting is applied globally. It affects all users and all procedures run in the Business User Edition.
For more information on customizing the server profile in the Business User Edition, see *Managing the Server or Global Profile*, in *Setting Up Your Environment*.

The following applies to filtering Active Technologies content.

- When using active content in Cache Mode, filtering may not work properly if the content contains a text field (for example, TX50). As a workaround, consider using an alphanumeric field (for example, A50).

The following apply when using the Export to Excel functionality.

- When using the Export to Excel option while creating and generating an active report with active cache enabled, the request will be generated in XLSX format rather than EXL2K. This applies to the following browsers: Microsoft Edge, Internet Explorer, Firefox, and Chrome.

  The export behavior is controlled by the WebFOCUS Reporting Server, and an ActiveX plugin is not required for Internet Explorer. When the export is performed, an Office Open XML document is produced, which you can download and save in the required format (default is .xlsx).

- When using the Export to XML (Excel) option with active cache disabled, the export behavior is controlled by the active JavaScript layer.

  An ActiveX plugin is required for Internet Explorer. This is used to export the output directly into Microsoft Excel, enabling you to save the document in the required format (.xlsx or .xls depending on the Microsoft Excel version installed).

  In Firefox and Chrome, when the export is performed, an MS Office XML document is produced, which you can download and save in the required format (the default is .xls).

  In Microsoft Edge, the Export to XML (Excel) option is not supported. The option is available with active cache disabled, but when the export is performed, the output is displayed as text inside the browser window.

### Creating an Active Technologies Report

An active report is a self-contained report that is designed for offline analysis.

**Procedure:** How to Create an Active Technologies Report

With InfoAssist+ in Report mode, you can perform this procedure in Query Design view or Live Preview.

1. On the status bar, in the Output Types menu, click *active report*.
2. Populate the report with your data in one of the following ways:
   - Drag the dimension fields and measure fields onto canvas.
   - Drag the dimension fields and measure fields into the appropriate field containers in the Query pane.

**Active Technologies Report Menu Options**

Menu options for an active report are described in the following table.

*Note:* The following options described in the table require the use of ActiveX controls. Since Microsoft Edge does not support ActiveX technology, these options are not available in that browser:

- Send as E-mail
- Save Changes
- Export to XML (Excel) when active cache is disabled

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort Ascending</td>
<td>Sorts the column in ascending order.</td>
</tr>
<tr>
<td>Sort Descending</td>
<td>Sorts the column in descending order.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>Filter</td>
<td>Filters the data. Options are:</td>
</tr>
<tr>
<td></td>
<td>- Equals</td>
</tr>
<tr>
<td></td>
<td>- Not equal</td>
</tr>
<tr>
<td></td>
<td>- Greater than</td>
</tr>
<tr>
<td></td>
<td>- Greater than or equal to</td>
</tr>
<tr>
<td></td>
<td>- Less than</td>
</tr>
<tr>
<td></td>
<td>- Less than or equal to</td>
</tr>
<tr>
<td></td>
<td>- Between</td>
</tr>
<tr>
<td></td>
<td>- Not Between</td>
</tr>
<tr>
<td></td>
<td>- Contains</td>
</tr>
<tr>
<td></td>
<td>- Contains (match case)</td>
</tr>
<tr>
<td></td>
<td>- Omits</td>
</tr>
<tr>
<td></td>
<td>- Omits (match case)</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calculate</td>
<td>Calculation types that you can apply to the column:</td>
</tr>
<tr>
<td></td>
<td>- Clear</td>
</tr>
<tr>
<td></td>
<td>- Clear All</td>
</tr>
<tr>
<td></td>
<td>- Count</td>
</tr>
<tr>
<td></td>
<td>- Distinct, which counts the number of distinct values within a field.</td>
</tr>
<tr>
<td></td>
<td>For numeric fields, you can also apply:</td>
</tr>
<tr>
<td></td>
<td>- Sum</td>
</tr>
<tr>
<td></td>
<td>- Avg</td>
</tr>
<tr>
<td></td>
<td>- Min</td>
</tr>
<tr>
<td></td>
<td>- Max</td>
</tr>
<tr>
<td></td>
<td>- % of Total</td>
</tr>
<tr>
<td>Chart</td>
<td>Creates an active chart from the report. Options are Pie, Line, Column, and Scatter.</td>
</tr>
<tr>
<td>Rollup</td>
<td>Lists the fields available to create a table.</td>
</tr>
<tr>
<td>Pivot (Cross Tab)</td>
<td>Lists the fields available to create a Pivot table.</td>
</tr>
<tr>
<td>Visualize</td>
<td>Adds visualization bars to, or removes them from, the selected column. The Visualize option is available for numeric data columns.</td>
</tr>
<tr>
<td>Hide Column</td>
<td>Suppresses the display of the selected column in the report.</td>
</tr>
<tr>
<td>Show Columns</td>
<td>Lists the names of the columns that are hidden in the report, allowing you to individually restore a column.</td>
</tr>
<tr>
<td></td>
<td>Select the name of a specific column in the hidden columns list to restore that column to the report.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Freeze Column</td>
<td>Freezes the report at a particular point so that columns to the left of the freeze point remain in view while the user scrolls through the other report columns. Note: If the report can be fully viewed in the browser window, freeze is not applied. The Freeze column option is not available for expandable report (Accordion) views.</td>
</tr>
<tr>
<td>Unfreeze All</td>
<td>Unfreezes the columns.</td>
</tr>
<tr>
<td>Grid Tool</td>
<td>Opens the Grid Tool, which you can use to change the column order, select multiple columns to sort ascending or descending, hide and show columns, add a calculation result to a column, and add subtotals to the active report.</td>
</tr>
<tr>
<td>Chart/Rollup Tool</td>
<td>Opens the Chart/Rollup Tool, which you can use to select multiple group fields to generate the chart or rollup table. The Chart/Rollup Tool contains a list of columns available in the active report to add to Group By and Measure fields. Drag the columns into the field that you want.</td>
</tr>
<tr>
<td>Pivot Tool</td>
<td>Opens the Pivot Tool, which you can use to select multiple group fields to generate the chart or pivot table. The Pivot Tool contains a list of columns available in the active report to add to Group By, Across, and Measure fields. Drag the columns into the field that you want.</td>
</tr>
<tr>
<td>Show Records</td>
<td>Opens the Show Records menu option to list the number of records available for display per page in the report. Select a number (for example, 10) to display, per page. Default displays the number of records (lines) per page that is specified in the WebFOCUS report procedure.</td>
</tr>
<tr>
<td>Comments</td>
<td>Options to display comments under cells or hide indicators for comments in the active report output.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Send as E-mail| Enables you to save the current state of the active report and send the report as email.  
**Note:** To use this feature, you must have ActiveX enabled in your browser security settings. This feature is only supported in Internet Explorer. |
| Save Changes  | Saves the current state of the active report.  
When you save an active report using the browser Save as option, the report is saved in its original default state. In the browser Save as dialog box, it is recommended that you select the Webpage, HTML Only save option to ensure that the page is saved properly.  
**Note:** To use this feature, you must have ActiveX enabled in your browser security settings. This feature is only supported in Internet Explorer. |
| Export        | When active cache is enabled, exports all records or filtered only records to HTML, CSV, Excel, or PDF.  
**Note:** active cache is enabled on an active report when you click Pages On Demand on the Format tab, in the Navigation group.  
When active cache is disabled, exports all records or filtered only records to HTML, CSV, or XML (Excel). To use this feature, you must enable ActiveX in your browser security settings. |
| Print         | Prints all records or filtered only records.                                                                                                                                                   |
| Window        | Displays reports in a cascade or separate tabs.                                                                                                                                                 |
| Restore Original | Restores the active report to the default state specified in the report procedure.                                                                                                  |

**Active Technologies Cell Menu Options**

When you are working in active report format, the following data cell options display.
<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Definition</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill down</td>
<td>Enables you to drill down one level in the hierarchy of your data source. This option displays for reports that have Auto Drill enabled.</td>
</tr>
<tr>
<td>Drill up</td>
<td>Enables you to drill up one level in the hierarchy of your data source. This option displays for reports that have Auto Drill enabled.</td>
</tr>
<tr>
<td>Restore Original</td>
<td>Restores the active report to the default state specified in the report procedure.</td>
</tr>
<tr>
<td>Auto Links</td>
<td>Displays a list of target reports that are linked to the Auto Link enabled report. This option displays for reports that have Auto Linking enabled.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enables you to add comments about data in your report. The result is an annotation that displays when you hover over it run time.</td>
</tr>
<tr>
<td>Highlight Value</td>
<td>Enables you to highlight a particular value in your report.</td>
</tr>
<tr>
<td>Highlight Row</td>
<td>Applies highlighting to the selected row in your report.</td>
</tr>
<tr>
<td>Unhighlight All</td>
<td>Removes any applied highlighting from values or rows in your report.</td>
</tr>
<tr>
<td>Filter Cell</td>
<td>Enables you to filter the output, showing only a selected row of data.</td>
</tr>
<tr>
<td>Remove Cell Filter</td>
<td>Removes any applied cell filters.</td>
</tr>
</tbody>
</table>

**Configuring Active Technologies Report Options**

You can configure active report options, including menu options, based on user role, through the active report options dialog box.

You can access the dialog box on the Format tab, in the Features group, by clicking the **active report options** button. The button is available when active report is selected as the output type.
The active report options dialog box contains the following tabs:

- General
- Menu Options
- Colors
- Advanced

**General Tab**

Use the General tab to set common properties specific to active reports.

The General tab contains the following options:

- **Display.** This area contains options to set the window to cascade or tabs, and options to freeze columns.
- **Window.** Select the window setting. The options are Cascade and Tabs.
- **Freeze Columns.** Select the columns you would like to freeze. You can also select None.

**Page Options.** This area contains options to set the number of records per page, enable the display of page information, edit the alignment, and set the location of the page information.

- **Records Per Page.** Select or type the number of records that you would like to display per page. The default value is 57.
- **Display Page Information.** Select this option to display page navigation information. Clear this option to disable the display of page navigation information.
- **Alignment.** Click the appropriate button to set the alignment of the page navigation information. Options are Left, Center, and Right.
- **Location.** Select the location for the page navigation information. The options are Top Row and Bottom Row.

**Menu Options Tab**

Use the Menu Options tab to select a user type and which options to display in the menu.

The Menu Options tab contains the following options:

- **User Type.** The options are Power, Analyst, Basic, and Custom.
  - **Power.** This is the default user type. It enables all functionality.
- **Analyst.** This user type has the following functionality: Show Records, Freeze, Hide/Unhide, Export, Sorting, Pivot, Filter, Calculations, Chart, Visualize, Restore Original, Save Changes, and Accordion.

- **Basic.** This user type has the following functionality: Show Records, Freeze, Hide/Unhide, Sorting, Filter, Calculations, Visualize, and Restore Original.

- **Custom.** If you select a combination of options that does not match one of the existing user types (Power, Analyst, Basic), the User level name that appears in the User Type field is Custom. This is not a default user type or a selectable user type. It indicates that options for this user do not match any of the existing user types.

The options available according to user type include the following:

- **Show Records.** Shows all records or specific numbers of records.

- **Freeze.** Freezes and unfreezes columns.

- **Hide/Unhide.** Hides and shows columns.

- **Export.** Exports data to HTML, CSV, Excel, or PDF if active cache is enabled, or to HTML, CSV, or XML (Excel) if active cache is disabled.

- **Sorting.** Sorts data in ascending or descending order.

- **Pivot.** Lists the fields available to create a Pivot table.

- **Window Type.** Shows windows as cascade or tabs.

- **Send as Email.** Enables you to save the current changes and send a report as email.

- **Print.** Prints all records or filtered-only records.

- **Advanced Tools.** Accesses the Chart/Rollup, Pivot, and Grid Tools.

- **Filter.** Opens the Filter Selection dialog box.

- **Calculations.** Performs the following calculations: Sum, Avg, Min, Max, Count, Distinct, % of Total.

- **Chart.** Converts a report to a pie, line, bar, or scatter chart.

- **Visualize.** Adds data visualization bars to a report.

- **Rollup.** Performs rollup on data.

- **Comments.** Adds comments.
- **Restore Original.** Restores the active report to the default state specified in the report procedure.

- **Save Changes.** Saves the current changes.

- **Accordion.** Produces accordion reports.

- **Grid Tool.** Opens the Grid Tool dialog box.

**Colors Tab**

Use the Colors tab to select colors for various objects on the report.

The Colors tab contains the following options:

**Page.** This area contains options to set the colors for the font and background of the page text.

- **Font.** Opens the Color dialog box, where you can select the font color.

- **Background.** Opens the Color dialog box, where you can select the background color for the page text.

**Row Selection.** This area contains options to set the colors that appear when you point to or select a row on the report.

- **Hover.** Opens the Color dialog box, where you can select the color that the row becomes when you hold the mouse over the row.

- **Selected.** Opens the Color dialog box, where you can select the highlight color that the row becomes when you use the highlight option.

**Visual.** This area contains options to set the colors for the data visualization bars.

- **Positive.** Opens the Color dialog box, where you can select the color for a data visualization bar that represents a positive number.

- **Negative.** Opens the Color dialog box, where you can select the color for a data visualization bar that represents a negative number.

**Calculations.** This area contains options to set the colors for values in a calculation.

- **Font.** Opens the Color dialog box, where you can select the font color for the calculation.

- **Background.** Opens the Color dialog box, where you can select the background color for the calculation.
**Menu.** This area contains options to change the color of the menu.

- **Normal**
  - **Font.** Opens the Color dialog box, where you can select the color for the text of the options on the column menus.
  - **Background.** Opens the Color dialog box, where you can select the background color for the column menus.
  - **Border.** Opens the Color dialog box, where you can select the color for the border of the column menus.

- **Hover**
  - **Font.** Opens the Color dialog box, where you can select the color for the text of the options on the column menus when you point to them.
  - **Background.** Opens the Color dialog box, where you can select the background color that appears behind options on the column menus when you point to them.

**Advanced Tab**

Use the Advanced tab to control the number of rows retrieved from active cache and to add security settings.

**Note:** active cache is enabled when you select *active report* as the output type, and click *Pages On Demand* on the Format tab, in the Navigation group.

The Advanced tab contains the following options:

- **active cache.** Enables a report to cache the data in a binary file and return the data to the output window in pre-set increments.

- **Rows Retrieved.** Select the number of rows retrieved in the output. The default value is 100.

- **Security.** This area allows you to set a password to access the report and enable expiration by date or by days.

**Note:** When setting security options for active reports, be aware that security options can be set for each individual component on the canvas, but only one password can be set for the entire document.
Creating an Active Technologies Chart

An active chart is a chart that is designed for offline analysis. For more information, see Active Technologies Report Overview on page 95.

Procedure: How to Create an Active Technologies Chart

With InfoAssist+ in Chart mode, you can perform this procedure in Query Design view or Live Preview.

1. On the status bar, in the Output Types menu, click active report.

2. On the Format tab, in the Chart Types group, click the button of the chart that you want to create. Bar chart is the default.

   The chart appears on the canvas.

3. Populate the chart with your data in one of the following ways:

   - Drag the dimension fields and measure fields onto the chart.
   - Drag the dimension fields and measure fields into the appropriate field containers in the Query pane.

Active Technologies Options for Charts

Active chart toolbar options are shown in the following image.

Menu options for an active chart are described in the following table.
<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>More Options</td>
<td><strong>New.</strong> Creates a new instance of the chart. This option is available only when the chart is created from a column menu on a tabular report.</td>
</tr>
<tr>
<td></td>
<td><strong>Group By (X).</strong> Changes groups by the horizontal sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>Add (Y).</strong> Adds a vertical sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>X-Axis.</strong> Specifies a measure or dimension sort field. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Y-Axis.</strong> Specifies a measure. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Arrange By.</strong> Specifies the marker color. The marker color depends on the field assigned to the color attribute. If no field is assigned to this category, then all of the markers will be the same color. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Export to.</strong> Exports to Excel, Word, or PowerPoint.</td>
</tr>
<tr>
<td></td>
<td><strong>Stacked.</strong> Stacks the risers on top of each other, with the length of each riser representing the data value. Applies to column charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Top.</strong> Displays the top values. Options are Top 3, Top 5, Top 10, and Clear Top. Applies to pie charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Trend.</strong> Draws a trendline and equation label for an individual series. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Chart/Rollup Tool.</strong> Opens the Chart/Rollup Tool, which you can use to select multiple group fields in the chart or rollup table generated. The Chart/Rollup Tool contains a list of columns available in the active report and Group By and Measure sort fields. Drag the columns into the desired sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When working with the Chart/Rollup Tool for active charts (specifically those with the new chart attribute syntax), the Series tab is not supported. It is available with charts that are created with tabular reports or stand-alone charts that do not use the new chart attribute syntax.</td>
</tr>
<tr>
<td></td>
<td><strong>Restore Original.</strong> Restores the active report to the default state specified in the report procedure.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Column</td>
<td>Displays data as a column chart.</td>
</tr>
<tr>
<td>Pie</td>
<td>Displays data as a pie chart.</td>
</tr>
<tr>
<td>Line</td>
<td>Displays data as a line chart.</td>
</tr>
<tr>
<td>Scatter</td>
<td>Displays data as a scatter chart.</td>
</tr>
<tr>
<td>Rollup</td>
<td>Displays the chart as a rollup table.</td>
</tr>
<tr>
<td>Advanced Chart</td>
<td>Opens the Chart/Rollup Tool.</td>
</tr>
<tr>
<td>Original Chart</td>
<td>Restores the active chart to the chart type specified in the report procedure.</td>
</tr>
<tr>
<td>Lock/Unlock</td>
<td>Freezes the chart or rollup table. You can link or unlink a chart or rollup table to the filters that you have applied in your report using the Freeze Chart or Freeze Rollup icon. The icon indicates whether the report is linked to the filter (Freeze Chart or Freeze Rollup) or not (Unfreeze Chart or Unfreeze Rollup). This option is available only when the chart is created from a column menu on a tabular report.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Applies the following options to a Measure field: Sum, Avg, Min, Max, Count, and Distinct. The default value is Sum.</td>
</tr>
<tr>
<td>Remove Filter</td>
<td>Removes a filter from a chart. You can apply a filter by pointing to or lassoing an area of the chart and then clicking the Filter Chart or Exclude from Chart option from the chart tooltip.</td>
</tr>
</tbody>
</table>

**Creating an Active Technologies Dashboard**

You can create an active dashboard by inserting multiple content types, such as reports, charts, images, and text, into a document. An active dashboard will run any report or chart using the active output format, even if the report or chart itself is not in active output format.

You can also insert active dashboard prompts into a document to act as filters for the reports and charts on the dashboard. You can cascade (chain) prompts to populate them based on the selections from the previous prompts.
The output format of the active dashboard must be active report in order to add active dashboard prompts.

**Active Technologies Dashboard Prompts**

The Active Dashboard Prompts group contains buttons that insert active dashboard prompts into your dashboard. This group is only visible when the output format of the dashboard is set to active report. You can access the active dashboard prompts on the Insert tab, in the active dashboard prompts group.

The following are the types of active dashboard prompts that you can use to apply filters to an active dashboard:

- **Drop Down.** Inserts a drop down prompt placeholder in the upper-left corner of the canvas.
- **List.** Inserts a list prompt placeholder in the upper-left corner of the canvas.
- **Checkbox.** Inserts a check box prompt placeholder in the upper-left corner of the canvas.
- **Radio Button.** Inserts a radio button prompt placeholder in the upper-left corner of the canvas.
- **Text.** Inserts a text area prompt placeholder in the upper-left corner of the canvas.

**Note:** The display of values populated in active dashboard prompts is dependent on the data setting. For example, if sample data is turned on, then active dashboard prompts will show sample data, such as:

WF_RETAIL1
WF_RETAIL2
WF_RETAIL3

**Target Reports**

When you bind a field to an active dashboard prompt, the default target report is the report from which you dragged the field. You can add or remove target reports from an active dashboard prompt through the active dashboard properties dialog box. For more information on using the active dashboard properties dialog box, see *Using Multiple Reports as Targets and Sources* on page 116.

A report must meet one of the following requirements to be a target report:

- The report must contain a field with the same name as the source field (actual field name or AS name).
- The Master File of the report must contain a field with the same name as the source field.
If a report is eligible to be a target report because the field has the same user-supplied title and the title is changed, the report is automatically removed as a target.

**Procedure:** How to Add an Active Technologies Dashboard Prompt to a Dashboard

This procedure describes how to begin to create a dashboard by creating one report and binding a single prompt to one of the fields of the report.

With InfoAssist+ in Document mode:

1. On the status bar, in the Output Types menu, accept the default output type (active report).
   
   A placeholder appears on the canvas.
3. Drag fields onto the canvas, or into the Query pane, to create the report and start building the dashboard.
4. On the Insert tab, in the active dashboard prompts group, select a dashboard prompt to insert into the document.

   An active dashboard prompt appears in the upper-left corner of the canvas. If the report is located in the upper-left corner of the canvas, you will have to drag the prompt off the report.
5. Select the report and bind one of its data source fields to the prompt in one of the following ways:

   - **Query pane:** Select the report. From the Query pane, drag the field that you want to bind onto the prompt.
   - **Report on the canvas:** Click the report on the canvas. You can now edit it. Highlight the column that contains the data that you want and drag it onto the prompt.

   Once you have bound the field to the prompt, the values of the field appear in the prompt.

   **Note:** Once an active dashboard prompt is added to the canvas, the document is locked in an active output format. You cannot change the active report format if there are prompts present on the canvas. To switch to a non-active output format, you must remove all prompts.

**Using Multiple Reports as Targets and Sources**

You can add multiple reports and charts to an active dashboard. Each report can have multiple prompts associated with it.
**Procedure:** How to Build a Dashboard With Multiple Reports as Targets and Sources

The following procedure describes how to set up active dashboard prompts for two reports on a dashboard. In the example that is used, the first report contains information about the categories of electronics products sold in various regions. The Product,Category field will be bound to a group of radio buttons. Each radio button will represent a particular product category of electronics. When you select a radio button for a product category, for example, Accessories, the report will be filtered by your selection.

The second report contains information about the gender and geographic location of electronics consumers. The Gender field will be bound to a drop-down list. The list will display the values, F (female) and M (male). When you select a gender from the drop-down list, the report will be filtered by your selection.

1. Open InfoAssist+ in Document mode using the wf_retail_lite Master File.
2. Create an active dashboard by adding two reports with the following components, respectively:

   **Report 1:**
   - Product,Category
   - Store,Business,Region
   - Discount
   - Gross Profit

   **Report 2:**
   - Gender
   - Customer, Continent
   - Product, Category

3. On the Insert tab, in the Active Dashboard Prompts group, add the following active dashboard prompts to the dashboard, positioning them relative to each respective report.

   - **Radio Button:** This prompt will be used for Report1.
   - **Drop Down:** This prompt will be used for Report2.

   For more information on working with active dashboard prompts, see *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 116.

4. Right-click the radio button active dashboard prompt for which you want to bind a field to and click *Properties.*

   The active dashboard properties dialog box opens.
The Prompts list displays the two prompts (for example, radiobutton_1 and radiobutton_2) that were added to the dashboard in step 3.

5. From the Report drop-down menu, select the report that contains the field to which you want to bind an active dashboard prompt.

In this example, the radio button list (radiobutton_1) has been selected as the prompt for the region report (Report1), as shown in the following image.

The next step describes how to bind the Product,Category field from the region report to the radio button list to filter that report.

6. From the Field drop-down menu, select the field to which you want to bind the active dashboard prompt.
In this example, the Product,Category field has been selected for the radio buttons list (radiobutton_1), as shown in the following image.

**Note:** You can optionally specify an ascending or descending sort order for the current scenario.

7. Click **OK**.

The prompt is now bound to the field on the dashboard.
In the following image, the radio buttons list is bound to the Product, Category field. It displays all product categories by which a user can filter the report.

The following steps describe how to bind the Gender field in the gender report (Report2) to the drop-down list prompt.

8. Right-click the Drop Down active dashboard prompt for which you want to bind a field and click Properties.

The active dashboard properties dialog box opens again.
Notice that combobox_2, the prompt selected on the dashboard, is selected in the Prompts list.

9. From the Report drop-down menu, select the report (Report2) that contains the field to which you want to bind an active dashboard prompt.

   The next step describes how to bind the Gender field from the gender report to the drop-down list to filter that report.

10. From the Field drop-down menu, select the field (Gender) to which you want to bind the active dashboard prompt.

   Once the Gender field has been selected, Report2 (gender report) appears in the Targets list and Report1 (region report) appears in the Candidate Reports list.

   **Note:** To move a report from the Candidate Reports list box to the Targets list box, select it and click the *Add to List* arrow. To remove a report from the Targets list box, select it and click the *Remove from List* arrow. You can select multiple reports by holding down the Ctrl key and clicking each one.

11. Click OK.
The prompt is now bound to the field on the dashboard. You can now filter the gender report by female or male, as shown in the following image.
The final active dashboard displays, as shown in the following image.

### Procedure: How to Change the Field

You can change the field to which the active prompt is bound.

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind an active prompt to a field.
2. Right-click the active dashboard prompt that you want to configure, and click Properties. The active dashboard properties dialog box opens.
3. From the Field menu, select a different field.
   A warning message alerts you that changing the source field for the prompt will remove the existing prompt and any dependent (child) prompts from the cascades.
4. Click OK to close the warning.
5. Click OK to close the active dashboard properties dialog box.
Procedure: How to Change the Filter Condition

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind an active dashboard prompt to a field, as described in How to Add an Active Technologies Dashboard Prompt to a Dashboard on page 116.

2. Right-click the active dashboard prompt that you want to work with, and from the shortcut menu, select Properties.

   The active dashboard properties dialog box opens.

3. From the Condition drop-down menu, select the filter condition for the active dashboard prompt. The options are Equal to, Not equal to, Less than, Less than or equal to, Greater than, and Greater than or equal to.

4. Click OK.

   The filter condition is applied to the active dashboard prompt.

Procedure: How to Add Multiple Prompts to a Dashboard

1. Create an active dashboard in Document mode, or open an existing dashboard containing at least one report, and add at least two active dashboard prompts, as described in How to Add an Active Technologies Dashboard Prompt to a Dashboard on page 116.

2. Bind the fields to prompts that you have added, as described in How to Add an Active Technologies Dashboard Prompt to a Dashboard on page 116.

Procedure: How to Cascade Prompts

When you have more than one prompt on the canvas, you can cascade prompts to populate them based on the selections of the previous prompts. Cascading prompts have a parent-child relationship, in which the parent filters the available options of the child.

An active prompt can be the parent of more than one other prompt, but cannot be a child of more than one prompt.

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind at least two active prompts to fields.

2. Right-click the active dashboard prompt that you want to configure, and click Properties.

   The active dashboard properties dialog box opens.

3. Click Cascades.
By default, a cascade named Cascade1 appears in the Cascades section of the active dashboard properties dialog box.

- You can click the Create a new cascade button to create a new cascade.
- You can click the Delete selected cascade button to delete the selected cascade.

4. Select the cascade to which you want to add prompts.

5. From the Available Prompts list box, select the prompt that you want to add.

6. Click the Add to List arrow to move the selected prompt to the Selected Prompts list box.

   **Note:** You can remove prompts from the Selected Prompts list box by selecting them and clicking the Remove from List arrow.

7. Add any additional prompts you want to be part of the cascade by repeating steps 5 and 6.

   By default, the hierarchy of the prompts is determined by the order in which they are added to the Selected Prompts list. The cascade of the prompts is from top to bottom. The prompts that come first in the Selected Prompts list are the parents of the lower prompts.

8. You can change the hierarchy of the prompts by selecting a prompt in the Selected Prompt list box and clicking the Move Up and Move Down arrows.

9. Click OK.

   The cascade is created.

10. Run the report.

    **Note:** If you set up more than one cascade, the cascade that you interact with last is the one that filters the report.

### Using Navigation Options for Reports

When working with reports, you can use the following options to customize output display and navigation.

- **Table.** Generates standard browser output. This is the default.

- **Table of Contents.** Generates output by displaying a table of contents icon in the upper-left corner where report output typically appears. Clicking *Table of Contents* opens a menu that enables you to select (view) individual values of the first Sort By (By) field, one value at a time.

  You can also select options to view the entire report or remove the table of contents.
Creating Maps to Illustrate Trends

Note:

- The Table of Contents option is activated only when HTML, active report, Excel, or PowerPoint output format is selected.
- You cannot use the Table of Contents option with the Accordion feature.
- Freeze. Generates output with column titles that freeze (remain in view) when you scroll through pages of the report output.
- Pages On Demand. Provides access to two distinct features depending upon the output type that you have selected.
  - HTML. If you select this output type, and click Pages on Demand, then the report opens in the WebFOCUS Viewer.
  - active report. If you select this output type, and click Pages on Demand, then active cache is enabled. For more information on active cache, see Using the Active Cache Option on page 58.
- Auto Drill. Provides access to Auto Drill functionality, which enables you to navigate the hierarchy of your data at run-time. For more information, see Using Auto Drill.

Note: Auto Drill functionality is only available for the HTML and active report output formats.

Creating Maps to Illustrate Trends

Using InfoAssist+, you can create maps to identify patterns or trends in your data. By converting data into values that can be displayed on a map, you are able to visualize scenarios, illustrate hot spots, and identify potential problem areas. For example, a law enforcement agency may use mapping functionality to identify areas of higher crime within the locations they cover. You can also use maps to determine how places are related, understand where things are located, and identify the best actions to take. By illustrating trends on a map, a decision maker can identify patterns easily, and reach conclusions sooner.
An early example of how maps can be used to illustrate trends is the case of Dr. John Snow, an epidemiologist who was one of the first to use data to map occurrences of cholera to find the cause of infection. By plotting the cholera data on a map of a town, Dr. Snow was able to visualize a trend that showed higher incidences of cholera closest to water pumps. This example is shown in the following image.

Maps also allow you to measure size, shape, and distribution to detect and quantify patterns, and even perform predictive analytics. An example of how maps can help detect and quantify patterns is the scenario in which a state agency used a WebFOCUS mapping application to solve a problem with their food stamp system. Using this application, odd food stamp redemptions, such as rounded numbers transactions, were discovered. By plotting those transactions on a map, the agency discovered that the redemptions appeared in the same geographic location. Upon further investigation, the agency identified that individuals were selling their food stamps at reduced prices, $50 worth of food stamps for $40 in cash, to others instead using them as intended. This map example is shown in the following image.
When working with maps, the concepts of location intelligence and business intelligence are important to understand. A Geographic Information System (GIS) captures, stores, analyzes, manages, and presents data linked to a location, while Business Intelligence (BI) relies on the conversion of raw data into meaningful information. Location intelligence is the process of analyzing data to make better business decisions. It combines GIS and BI/Analytics to allow the recognition of patterns in your data, including the visualization and discovery of geospatial outliers, which would not be easily discovered if you use the technology independently and separately.

More specifically, maps use non-intrusive GIS workflows with existing data. You can view symbol layers for data bound to a geo-location, such as state, country, and ZIP code, in an integrated map viewer. Using metrics from your data, you can also visualize geographic roles or dimensions. Geographic roles, or dimensions, can be built directly into your Metadata or assigned to a data field when you create a map.

**InfoAssist+ and Esri Integration**

Using WebFOCUS InfoAssist+ with the Esri integration, you can create maps that help you illustrate or identify trends, so that you can take action quickly. WebFOCUS architecture provides the framework in which this system operates. Using a Javascript map viewer, you can navigate the interface easily, as shown in the following image.
In addition, this integration utilizes the capabilities of Esri by leveraging the ArcGIS Javascript API and content. Specifically, you can integrate data into maps with published content in ArcGIS Online platform. For more information, see http://www.esri.com/software/arcgis/arcgisonline. Additionally, by using this integration, you can include information about demographics, spending habits, crime, and lifestyle to maps that contain your data. These maps include layers with extensive demographic or reference detail and topography and allow you to view information about people, businesses, climate, and much more.

You can create the following maps in InfoAssist+:

- **Choropleth.** A common thematic map that uses geographical measures (for example, states and countries), representing the values aerially while employing a varying intensity of colors. It is useful for visualizing location-based data, trends, and distributions across a geographic area. The color hues for Choropleth maps are dictated by the legend, based on the selected measure, enabling you to determine data concentration across your map.

- **Proportional Symbol (Bubble).** A map that represents coordinates, such as an address or intersection, using symbols of different sizes to represent any measure. These maps focus on specific areas, for which data concentrations may vary. When the data concentration is larger, the bubble will be bigger.

Both maps can be created in Chart or Visualization mode. Built-in zooming capabilities allow you to drill down to a specific geographic area of focus easily. This allows you to get a closer look at regional or local data, draw inferences, and make recommendations, without changing the initial view of your data.

In Chart mode, you can also use the Auto Drill and Auto Linking features that are available when you create charts or reports in InfoAssist+. In Visualization mode, you can also drill up and down within different levels in a data hierarchy in a map. Auto Drill allows you to navigate through the geographical hierarchy of your map data at run time. You can use this information to visualize the same measure at different geographical hierarchies, such as Countries to States and States to Cities. Auto Linking allows you to connect to related charts or reports in your environment that share similar data parameters.

Using the Esri integration in InfoAssist+, you can also add the following layers to your map:

- **Backgrounds.** Display a layer that positions data as it is located, in context to other geographical features, such as streets, terrain, and imagery. Some standard Background options may combine road, aerial, and topographic data using a variety of symbols. Hosted on ArcGIS, you can change your background at any time, to review your data in a different context.
When you apply a Background to your map, its appearance changes. You can then adjust the view of your data, showing different terrain or geographical views. Backgrounds provide at least 17 levels of zoom. For more information, see https://developers.arcgis.com/javascript/jsapi/esri.basemaps-amd.html.

- **Reference Layers.** Display a layer of boundaries and locations that range from a continental scale to country, state, and even local neighborhood. For example, if you are viewing World data on electricity usage, you may want to add a Reference Layer that displays the borders and concentration of your data within each country.

- **Demographic Layers.** Display a layer of information about people and businesses in a specific demographic area. This includes the United States and 120 other countries. Demographic Layers are thematic maps that provide additional information about the location, such as spending habits, population, and lifestyles. You can add Demographic Layers to a map about sales data, to identify new locations for stores, based on the spending habits for a specific area.

Both mapextent and the Layers menu functionality are applied to your map when you select a Background, Reference Layer, or Demographic Layer. Mapextent is an automatic view of the map. Layers is a menu that appears on the map and provides access to options that allow you to adjust the information that is being displayed.

The map example in the following image shows the use of layers.

![Map Example](image)

**Note:** Backgrounds, Demographic Layers, and Reference Layers can be accessed from the Format tab for maps in both Chart and Visualization mode. These layers are static, standard options that Esri provides for use with InfoAssist+, and do not change based on the data source that you select.
Configuring an Esri On Premise Environment

The Esri On Premise functionality enables you to download and access mapping files through the use of a local Application Programming Interface (API). Once you download and configure the API, you do not need an internet connection to utilize the robust mapping features that Esri provides. For information on downloading and configuring the API that controls this feature, see *How to Download and Configure the ArcGIS JavaScript API* on page 131.

The Esri On Premise functionality provides you with local access to Esri mapping files. This is particularly useful if you are away from your office or without an Internet connection. You may also be using a mobile device, such as an iPad or smartphone with a large screen, without an Internet connection. The following mapping components are supported when using the Esri On Premise functionality:

- **Offline Basemaps.** Basemaps are an offering from ArcGIS. Standard basemaps are provided for your use offline. For example, there is an Oceans basemap and a Terrain with Labels basemap. In InfoAssist+, these basemaps are also known as backgrounds. In an online setting, there are 10 basemaps available. In order to use offline basemaps, you need to use a tiled mapservice published in the ArcGIS Server.

- **Offline Geographic Roles.** Geographic Roles are used to visualize measures with commonly known dimensions (for example, Country, State, Cities, and so on). These provide the location information often in the form of (x/y) needed to plot on a map. Geographic roles are pre-defined for online users through ArcGIS Online. In InfoAssist+, a geographic role defines the geographic component that you can select when creating a map (for example, State or Continent). For an offline user, the options that display can be customized in the geoservices.xml file. For more information, see *Adding a Custom Geographic Role* on page 152.

**Note:** Demographic Layers are not supported in an Esri On Premise environment.

**Procedure:** How to Download and Configure the ArcGIS JavaScript API

You can use this procedure to download and configure the API that controls the Esri On Premise environment.

1. In your browser, navigate to the following URL to download the API: https://developers.arcgis.com/downloads

2. Sign in to access the download options that are available to you.
3. Select Version 3.15 of the ArcGIS API for JavaScript, as shown in the following image.

![ArcGIS API for JavaScript](image)

4. Click API to download the API.
5. In drive:\ibi\config\web_resource, create a folder named arcgis_api.
6. Open the arcgis_js_v315_api.zip file downloaded in step 4 and navigate to arcgis_js_v315_api\arcgis_js_api\library\3.15\3.15.
7. Extract the files in that folder to the drive:\ibi\config\web_resource\arcgis_api folder.
8. Next, verify the path to the API in the WebFOCUS Administration Console, as shown in the following image.

**Note:** This is the path to which you extracted the API files.

This field identifies the path to the internal ArcGIS Javascript API Source that develops ESRI-based maps. This setting is blank, by default, indicating that the use of the internal API source to develop ESRI maps is not activated. The API that is referenced is https://js.arcgis.com/3.15/, by default. To direct WebFOCUS to use the internal ArcGIS Javascript API to develop ESRI maps, enter the path to the local API files that you extracted into this setting. For more information, see the WebFOCUS Security and Administration manual.

**Note:** This path should be a relative path that is accessible within the local WebFOCUS install.
9. Click **Save**.

10. Next, open the following two local API files:

- `drive:\ibi\config\web_resource\arcgis_api\init.js`
- `drive:\ibi\config\web_resource\arcgis_api\dojo\dojo.js`

In both files, search for `HOSTNAME_AND_PATH_TO_JSAPI`. Replace `'' + 
"[HOSTNAME_AND_PATH_TO_JSAPI]dojo"` with `'' + HOSTNAME_AND_PATH_TO_JSAPI + 
"dojo"

11. In the WebFOCUS Administration Console, click **Clear Cache** to clear the browser cache. Your configuration is complete.

## Creating and Customizing Maps in InfoAssist+

The following procedures provide step-by-step instructions on how to create and customize maps.

As you create your maps, you can use the following built-in map viewer features:

- You can use the plus (+) and minus (-) symbols, within the map to zoom in and out of different areas of the map. You can also click your left mouse button to zoom in to a specific location.

- Like all HTML5 visualizations, the highlighted markers and regions on a map support drill, multi-drill, auto-linking, and informational tooltip features.

- When working with maps in Chart mode, you can use the Pan / Selection button to alternate between the Pan and Selection controls. This option is in the upper-right corner of the map.

- When working with maps in Visualization mode, you can toggle the Pan or Selection button to make a selection. The Pan control allows you to click, hold, and move the map with your mouse. The Selection control allows you to lasso a specific area of the map and select data in the map.

### Procedure: How to Create an Esri Choropleth Map

**Note:** The default option of creating a map utilizes the ArcGIS Javascript API that Esri provides.

1. Launch InfoAssist+ in Chart or Visualization mode.

   - In Chart mode, on the **Format** tab, in the **Chart Types** group, click **Choropleth**.
In Visualization mode, on the Home tab, in the Visual group, click Change and click Choropleth.

A blank map displays and the Layer field container is enabled, as shown in the following image.

2. Add a Geolocation field to the Layer field container.
This field, which already has a geographic role assigned, is denoted with a Layer icon, in the Data panel, as shown in the following image. You can also hover over a data field to view the geographic role assignment.

For more information, see Geographic Roles on page 148.

The canvas refreshes, and your map displays.

3. Before saving your map, to add insight, you can also do following:

- Click Run, to preview your map.
- Add a measure or dimension to the Color field container, to color your chart by that underlying data value. When you add a measure or dimension field to the Color field container, a legend displays for that data value. If you specify a dimension in the Color field container, the label changes to Color BY.
- Add a dimension or measure to the Tooltip field container, which will display tooltip information when you place your mouse over an area of the map.
- Add a Background, Demographic Layer, or Reference Layer.

4. Click Save to save your map.
**Procedure:** How to Create an Esri Proportional Symbol (Bubble) Map

1. Launch InfoAssist+ in Chart or Visualization mode.
   - In Chart mode, on the **Format** tab, in the **Chart Types** group, click **Proportional Symbol**.
   - In Visualization mode, on the **Home** tab, in the **Visual** group, click **Change** and select **Proportional Symbol**.

   A blank map displays and the Layer field container is enabled.

2. Place a data field with a defined geographic role in the Layer field container.

   This field, which already has a geographic role assigned, is denoted with a Layer icon, in the Data panel, as shown in the following image. You can also hover over a data field to view the geographic role assignment.

   ![Data panel with Layer icon](image)

For more information, see *Geographic Roles* on page 148.
A basic bubble map displays, as shown in the following image.

3. Before saving your map, to add insight, you can also do following:

- Click Run, to preview your map.
- Add a measure or dimension to the Color field container, to color your chart by that underlying data value.
- Add a measure to the Size field container, to control the size of the bubbles on your map.
- Add a measure to the Tooltip field container, to display tooltip information when you place your mouse over an area of the map at run time.
- Add a Background, Demographic Layer, or Reference Layer.

4. Click Save to save your map.

**Procedure:**  **How to Assign a Geographic Role to a Data Field**

1. Launch InfoAssist+ in Chart or Visualization mode.

   - In Chart mode, on the Format tab, in the Chart Types group, click Choropleth.
In Visualization mode, on the Home tab, in the Visual group, click Change and click Choropleth.

2. In the Data pane, select a data field without a geolocation assignment.

3. Perform one of the following tasks to open the Map dialog box and assign a geographic role:
   
   - Right-click the desired data field, click Map As and select a geographic role, as shown in the following image.

   ![Map As menu](image)

   - Drag the desired data field into the Layer field container.
The Map dialog box displays, as shown in the following image.

![Map dialog box](image)

4. In the Map dialog box, select a geographic role. For example, State.

   **Note:** When specifying a geographic role, you can use Name or an ISO-2 value for countries. The ISO-2 codes are recognized worldwide, as published in [http://www.iso.org/iso/country_codes](http://www.iso.org/iso/country_codes)

   The Map dialog box refreshes and shows the Depends on section, as shown in the following image.

![Depends on section](image)
5. In the Depends on section, choose from the following options:

- **Field.** Identifies a specific field on which the geographic role depends. For example, you can select Country or Continent.

- **User Defined.** Enables the definition of a specific value from the data source. Selections can be as simple as a specific country. For example, you can select US.

The Geographic Role field automatically populates based on the hierarchy of your data source. For example, if your primary geographic role was State, and in your metadata hierarchy, State depends on Country, this option displays.

6. Click **OK**.

If you used the Map As option, you must place the data field with the defined geographic role in the Layer field container. If you placed a data field in the Layer field container and defined a geographic role, the field is automatically added to the Layer field container.

A basic map displays, as shown in the following image.
7. Before saving your map, to add insight, you can also do following:

- Click Run, to preview your map.
- Add a measure or dimension to the Color field container, to color your chart by that underlying data value.
- Add a measure to the Size field container, to control the size of the bubbles on your map.
- Add a measure to the Tooltip field container, to display tooltip information when you place your mouse over an area of the map at run time.
- Add a Background, Demographic Layer, or Reference Layer.

8. Click Save to save your map.

**Procedure:** How to Change the Geographic Role of a Geolocation Field

You can change the geographic role assignment of any geolocation field using the following steps.

1. Launch InfoAssist+ in Chart or Visualization mode.

   - In Chart mode, on the Format tab, in the Chart Types group, click Choropleth.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Choropleth.

2. From the Data pane, right-click a geolocation field and click Map As.

3. Select a geographic role.

   The Map dialog box displays using the selected Geographic Role.

4. In the Map dialog box, optionally select a geographic role from the drop-down list. For example, Country.

   **Note:** This changes the selection that you made on the Map As list.

5. Accept the default value for Stored As, or choose a new value from the drop-down list, for example, ISO code. Stored As indicates how the data values are represented in the table.

6. Click OK.

   The geographic role changes for the selected Geolocation field in the Data pane, and the map refreshes using the new geolocation that you specified.
Procedure: How to Change the Default Background of a Map

1. Create a new map or open an existing map in InfoAssist+.
2. On the Format tab, expand the Map group and click Background, as shown in the following image.
3. Select one of the following options:
   - World Street Map
   - Terrain with Labels
Procedure: How to Add Demographic Layers to a Map

1. Create a new map or open an existing map in InfoAssist+.
2. On the Format tab, expand the Map group and click Demographic Layers.
3. Select from various population and lifestyle groups, as shown in the following image.

![Demographic Layers](image)

**Note:** These are pre-defined demographic profiles, provided by ArcGIS. You can select multiple options in either category to gain additional insight into your data. Specifically, each Demographic Layer has its own profile and provides a layering option, when comparing values across different layers or profiles.

4. Click **OK**.
The Demographic Layers that you select are applied to your map. The map engine displays the different groups with unique hues and coloring. You can use the Table of Contents or Layers option, to toggle between the different layers that you have specified. The Layers option is shown in the following image.

![Layers Image]

**Note:** You can select and clear the check boxes to enable the display of one or more Demographic Layers to compare and contrast the different demographic scenarios.

**Procedure:** How to Add Reference Layers

1. Create a new map or open an existing map in InfoAssist+.
2. On the **Format** tab, expand the Map group and click **Reference Layers**.
The Reference Layers dialog box displays, as shown in the following image.

3. Select one or more Reference Layers, such as World Countries, to add to your map, and then click OK.
Your map refreshes, and the definitions and borders of the References Layers display on the canvas. You can use the Table of Contents or Layers option, to toggle different Reference Layers in your map. These options are shown in the following image.

**Reference:**  Query Field Containers by Map Type

This section presents the Query field containers that display for both charts and visualizations, by map type.

<table>
<thead>
<tr>
<th>Query field container</th>
<th>Chart mode</th>
<th>Visualization mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layer.</strong> One data field, specifically a field containing location data (for example, State).</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Color.</strong> One data field.</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating Content
### Reference: Geographic Roles

This section contains information on the geographic roles that are supported for Esri maps in InfoAssist+.

<table>
<thead>
<tr>
<th>Geographic Role</th>
<th>Description</th>
<th>Maps Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>POINT OF INTEREST</td>
<td>Points of Interest</td>
<td>Proportional Symbol</td>
</tr>
<tr>
<td>CITY</td>
<td>World Cities</td>
<td>Proportional Symbol</td>
</tr>
<tr>
<td>CONTINENT</td>
<td>World Continents</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>COUNTRY</td>
<td>World Countries</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>COUNTRY_ISO2</td>
<td>World Countries (ISO2 Code)</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>COUNTRY_ISO3</td>
<td>World Countries (ISO3 Code)</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>STATE</td>
<td>World Admin Divisions</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>STATE_ISO_SUB</td>
<td>World Admin Divisions (by ISO_SUB)</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>USCITY</td>
<td>USA Major Cities</td>
<td>Proportional Symbol</td>
</tr>
<tr>
<td>USCITY_FIPS</td>
<td>USA Major Cities FIPS</td>
<td>Proportional Symbol</td>
</tr>
<tr>
<td>Geographic Role</td>
<td>Description</td>
<td>Maps Supported</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>USCOUNTY</td>
<td>USA_Counties</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>USCOUNTY_FIPS</td>
<td>USA_Counties_FIPS</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>USSTATE</td>
<td>USA_States</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>USSTATE_FIPS</td>
<td>USA_States_FIPS</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>USSTATE_ABBR</td>
<td>USA_States (by abbreviation)</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>ZIP3</td>
<td>USA ZIP3</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>ZIP5</td>
<td>USA ZIP5</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
</tbody>
</table>

The following table summarizes additional geographic role information.

**Note:** All of the following roles are geographic roles, with the exception of Latitude and Longitude, which are coordinates.
<table>
<thead>
<tr>
<th>Role Name</th>
<th>Role Format</th>
<th>Geographic Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>FIPS code</td>
<td>COUNTRY_FIPS</td>
</tr>
<tr>
<td></td>
<td>ISO-3166-2 code</td>
<td>COUNTRY_ISO2</td>
</tr>
<tr>
<td></td>
<td>ISO-3166-3 code</td>
<td>COUNTRY_ISO3</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>Country (NUTS level 0)</td>
<td>NUTS code</td>
<td>NUTS0_CC</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>NUTS0</td>
</tr>
<tr>
<td>District (NUTS level 3)</td>
<td>NUTS code</td>
<td>NUTS3_CC</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>NUTS3</td>
</tr>
<tr>
<td>Geometry area</td>
<td></td>
<td>GEOMETRY_AREA</td>
</tr>
<tr>
<td>Geometry line</td>
<td></td>
<td>GEOMETRY_LINE</td>
</tr>
<tr>
<td>Geometry point</td>
<td></td>
<td>GEOMETRY_POINT</td>
</tr>
<tr>
<td>Latitude</td>
<td></td>
<td>LATITUDE</td>
</tr>
<tr>
<td>Longitude</td>
<td></td>
<td>LONGITUDE</td>
</tr>
<tr>
<td>Postal code</td>
<td></td>
<td>POSTAL-CODE</td>
</tr>
<tr>
<td>Province (NUTS level 2)</td>
<td>NUTS code</td>
<td>NUTS2_CC</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>NUTS2</td>
</tr>
<tr>
<td>Region (NUTS level 1)</td>
<td>NUTS code</td>
<td>NUTS1_CC</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>NUTS1</td>
</tr>
<tr>
<td>State</td>
<td>FIPS code</td>
<td>STATE_FIPS</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>STATE</td>
</tr>
<tr>
<td>US County FIPS</td>
<td>FIPS code</td>
<td>USCOUNTY_FIPS</td>
</tr>
<tr>
<td>Role Name</td>
<td>Role Format</td>
<td>Geographic Role</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>US city</td>
<td>FIPS code</td>
<td>USCITY_FIPS</td>
</tr>
<tr>
<td>US county</td>
<td>Name</td>
<td>USCOUNTY</td>
</tr>
<tr>
<td>US Postal code</td>
<td>3 digits</td>
<td>ZIP3</td>
</tr>
<tr>
<td></td>
<td>5 digits</td>
<td>ZIP5</td>
</tr>
<tr>
<td>US state</td>
<td>Abbreviation</td>
<td>USSTATE_ABBR</td>
</tr>
<tr>
<td></td>
<td>FIPS code</td>
<td>USSTATE_FIPS</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USSTATE</td>
</tr>
<tr>
<td></td>
<td>US ISO subdivision code</td>
<td>STATE_ISO_SUB</td>
</tr>
</tbody>
</table>

The following table illustrates the geographic roles and their dependencies. Level 1 indicates the highest level of hierarchy and level 5 is the lowest level of hierarchy.

<table>
<thead>
<tr>
<th>Region</th>
<th>Hierarchy Level</th>
<th>Geographic Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>1</td>
<td>COUNTRY, COUNTRY_ISO_CC</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>USSTATE, USSTATE_ABBR, USSTATE_FIPS</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>USCOUNTY, USCOUNTY_FIPS</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>USCITY, USCITY_FIPS</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>ZIP3, ZIP5</td>
</tr>
</tbody>
</table>
Adding a Custom Geographic Role

Customers with Enterprise Data often have map layers that represent their territories, events, or logistical information. These are published as Map Services to either a subscription based in the Esri Cloud (ArcGIS.com) or on an internal portal. This portal is available with ArcGIS Server 10.3 installations. More information can be found at http://server.arcgis.com/en/portal/.

The WebFOCUS Reporting Server comes with a configuration file (geo_services.xml) that contains elements that describe all of the geographic roles, geographic hierarchies, URLs to the map services, and base maps available to the Esri map viewer. This file is located in the catalog directory under the server home directory:

c:\ibi\srvnn\home\catalog

where nn is the release of your WebFOCUS Reporting Server. For example, 82 for version 8.2.

The geographic role selections that you can make while using the InfoAssist+ Map As option are built dynamically using this configuration file. Each role definition in the configuration file, when selected in InfoAssist+, generates Metadata and a request that is sent to Esri in order to download the appropriate map and place the markers or polygons on the map.

**Note:** When you run a map that has too many polygons, it fails to draw. This applies to maps that use the US Zipcode 5 layer, in particular.

A geographic role can be part of a hierarchy. For example, the World geographic role is at the top of a hierarchy that contains continents, countries, states, and cities. These hierarchies are also described in the geo_services.xml file. The default location is:

C:\ibi\srvnn\home\catalog\geo_services.xml
where \( nn \) is the release of your WebFOCUS Reporting Server. For example, 82 for version 8.2.

To add a custom geographic role, you must add the necessary parameters for the geography to this file.

**Reference:** Geographic Role Definitions

A geographic role is stored as geo_role element in the geo_roles object of the geo_services.xml file. A geographic role must be defined with:

- An ID that will identify the role in the configuration file.
- A format and length for the data to be returned.
- A role name.
- A display title for the role name (to appear as a selection when using the InfoAssist+ Map As option).
- An optional role format (if the role can have multiple formats, such as a name and an abbreviation).
- A display title for the format.
- A role type (GEOGRAPHY for polygons or GEOMETRY for points).
- An optional vocabulary rule element containing vocabulary elements for associating the role with a field in the metadata.

The following attributes define a geographic role.

**id**

Is an alphanumeric uppercase value, up to 50 characters, used to identify the geographic role.

**type**

Is the data type for the ID. Can be one of the following.

- "alpha". For alphanumeric data, formats An or In.
- "integer". For integer numeric data, format In.
- "numeric". For fractional numeric data, formats Pn.m, Dn.m, or Fn.m.
- "text". For text data, format TXn.

**value_size**

Is the optional number of characters in USAGE format length (any, if not set).
**role_name**
Is the name of the geographic role.

**role_name_title**
Is the title of the geographic role, which displays when you hover over a data field with a geographic role assigned. You can also assign a geographic role, by title, using the Map As option.

**role_format**
Is an optional format for the geographic role. This is useful when the role can be referenced using multiple formats, such as a name, an ISO code, and an abbreviation.

**role_format_title**
Is an optional title for the format of the geographic role. It will be shown in parentheses along with the role title when you use the Map As option. For example, US State (abbreviation).

**geo_type**
Is one of the following predefined role types.

- "geography". For geographic objects, such as country or city.
- "geometry". For geometry objects, such as latitude, longitude, or geometry point and area.

**vocabulary_rules**
Is an element that consists of a group of vocabulary elements that explicitly describe column names for the geographic role. These rules will be used to select the best geographic data for the role.

Elements in a rule are connected by the Boolean logic operation OR (only one needs to be satisfied). Each vocabulary element contains words enclosed with special characters. Words in the rule element are connected by the Boolean logic operation AND (all need to be satisfied).

A word may be prefixed and/or suffixed with the percent character (%), which is a placeholder for any sequence of characters. If an element contains more than one word, each word has to be prefixed by the character plus (+) or minus (-). Plus indicates that the word must be found in the column name. Minus indicates that the word must not be found in the column name.
Sample Geographic Role Definitions

The following defines the State Abbreviation geographic role. The role ID is USSTATE_ABBR. The role name is USSTATE with a role format of ABBR. The titles that show when using the Map As option are US State (Abbreviation). The format is A2, and the vocabulary rules specify that the characters state must be present, but the characters iso, capital, and population must not be present. The geo type is geography, indicating that the returned data will be a geographic area.

```xml
<geo_role
    id="USSTATE_ABBR"
    value_size="2"
    type="alpha"
    role_name="USSTATE"
    role_name_title="US state"
    role_format="ABBR"
    role_format_title="Abbreviation"
    geo_type="geography">
    <vocabulary_rules>
        <vocabulary>+%state%-%iso%-%capital%-%population%</vocabulary>
    </vocabulary_rules>
</geo_role>
```

The following is a role definition for latitude values. The role ID is LATITUDE. The role name is also LATITUDE. Its format is numeric. The title that displays when you hover over a field with a geographic role assigned (or when using the Map As option) is Latitude. The geo type is geometry, indicating that the returned data will be points or areas described using points. The vocabulary rules specify that the characters latitude must be present.

```xml
<geo_role
    id="LATITUDE"
    type="numeric"
    role_name="LATITUDE"
    role_name_title="Latitude"
    geo_type="coordinate">
    <vocabulary_rules>
        <vocabulary>%latitude%</vocabulary>
    </vocabulary_rules>
</geo_role>
```

The following is the definition for the city role. The ID is CITY. The role name is also CITY. Its format is NAME. The title that displays when you hover over a field with a geographic role assigned (or when using the Map As option) is City (Name). The definition has a set of vocabulary elements. Only one of the elements in the list must be true. Therefore, the characters city, or town, or country plus capital, or state plus capital must be present.

```xml
<geo_role
    id="CITY"
    type="alpha"
    role_name="CITY"
    role_name_title="City"
    role_format="NAME"
    role_format_title="Name">
    <vocabulary_rules>
        <vocabulary>%city% %town% %country% %capital% %state% %capital%</vocabulary>
    </vocabulary_rules>
</geo_role>
```
Some geographic roles exist as part of a hierarchy, and the data for the hierarchical roles are stored at the same map services endpoint (URL). Hierarchical role relationships are stored as hier elements in the geo_services.xml file.

Hierarchy definitions provide WebFOCUS with the information needed to use Auto Drill from a geographic role at a higher level of the geographic hierarchy to a geographic role at a lower level of the geographic hierarchy.

Each hierarchy has the name of hierarchy (attribute ID) and a group of LEV elements with the attributes level, geo_role, and, optionally, value. Not all defined roles can be used in hierarchies. The same role can be included in more than one hierarchy and may be on different hierarchical levels in each. However, the same role cannot be used more than once in the same hierarchy. Multiple geographic roles can be assigned to the same hierarchical level in a hierarchy.

Geographic hierarchies are defined with the following attributes:

**id**
Is a name of up to 50 alphanumeric characters used to identify the hierarchy.

**level**
Is a natural number (integer starting with 1 for the top level) that specifies the level of the role within the hierarchy.

**geo_role**
Is the ID attribute of a geographic role (geo_role element).
value
Is an alphanumeric value, up to 50 characters, predefined for this geo role in this hierarchy.

Example: Sample Geographic Hierarchy Definition
The following element defines the world hierarchy. The top level is CONTINENT, both the Name role and the ISO code role. Level 2 has four COUNTRY geographic roles, corresponding to four different country formats. Level 3 contains three state formats, level 4 contains the city name, and level 5 contains two address formats and the postal code.

```xml
<hier id="World">
  <lev level="1" geo_role="CONTINENT"/>
  <lev level="1" geo_role="CONTINENT_ISO2"/>
  <lev level="2" geo_role="COUNTRY"/>
  <lev level="2" geo_role="COUNTRY_FIPS"/>
  <lev level="2" geo_role="COUNTRY_ISO2"/>
  <lev level="2" geo_role="COUNTRY_ISO3"/>
  <lev level="3" geo_role="STATE"/>
  <lev level="3" geo_role="STATE_ISO_SUB"/>
  <lev level="3" geo_role="STATE_FIPS"/>
  <lev level="4" geo_role="CITY"/>
  <lev level="5" geo_role="ADDRESS_FULL"/>
  <lev level="5" geo_role="ADDRESS_LINE"/>
  <lev level="5" geo_role="POSTAL_CODE"/>
</hier>
```

Reference: Adding the Federal Reserve Districts Geographic Role
These steps describe how to add the Federal Reserve Districts geographic role to the geo_services.xml file.

1. Open the geo_services.xml file. The default location is:

   C:\ibi\srvnn\home\catalog\geo_services.xml

   where nn is the release of your WebFOCUS Reporting Server. For example, 82 for version 8.2.

2. Add the role to the end of the GEO_ROLES object:

   ```xml
   <geo_role id="FED-DIST" value_size="50" type="alpha"
     role_name="FEDDIST"
     role_name_title="FED District" role_format="FR_Distric"
     role_format_title="FED District Name" geo_type="geography">
     <vocabulary_rules>
       <vocabulary>%FR_Distric%</vocabulary>
     </vocabulary_rules>
   </geo_role>
   ```
3. The ID is FED-DIST. The role name is also FED-DIST. Its format is FR_Distric. The title that displays when you hover over a field with a geographic role assigned (or when using the Map As option) is FED District. The definition has a vocabulary rule. The characters \textit{FR\_Distric} must be present.

4. Add this role to the US Hierarchy:

```xml
<hier id="US">
  <lev level="1" value="United States" geo_role="COUNTRY"/>
  <lev level="1" value="US" geo_role="COUNTRY_ISO2"/>
  <lev level="1" value="USA" geo_role="COUNTRY_ISO3"/>
  <lev level="2" geo_role="USSTATE"/>
  <lev level="2" geo_role="USSTATE_ABBR"/>
  <lev level="2" geo_role="USSTATE_FIPS"/>
  <lev level="3" geo_role="USCOUNTY"/>
  <lev level="3" geo_role="USCOUNTY_FIPS"/>
  <lev level="4" geo_role="USCITY"/>
  <lev level="4" geo_role="USCITY_FIPS"/>
  <lev level="5" geo_role="ADDRESS_FULL"/>
  <lev level="5" geo_role="ADDRESS_LINE"/>
  <lev level="5" geo_role="ZIP3"/>
  <lev level="5" geo_role="ZIP5"/>
  <lev level="6" geo_role="FED-DIST"/>
</hier>
```

5. Add the URI to the map server layer for this role at the end of the URIS object:

```xml
<uri description="FedReserve Districts">
  <returned_geometry>GEOMETRY_AREA</returned_geometry>
  <returned_georole>FED-DIST</returned_georole>
  <url type="esri" authorization="none" synonym="">
    http://services7.arcgis.com/L95Wwv90jRQ0tjAs/arcgis/rest/services/FRDISTRICTS/FeatureServer/0</url>
  <parameters>
    <parm order="1" parm_name="FR_Distric" parm_georole="FED-DIST"/>
  </parameters>
</uri>
```
You will now be able to select this role when using the Map As option the next time you start InfoAssist+, as shown in the following image.

Building InfoMini Applications

InfoMini applications are built from an InfoAssist+ report and contain a subset of InfoAssist+ functionality available at run time.

You can build an InfoMini application and provide the run-time user with the option to interact with and edit the report.

Understanding InfoMini Applications

When you create a report in InfoAssist+, you have the option to activate InfoMini. You can run a report with InfoMini activated, which creates an InfoMini application. An InfoMini application contains a subset of the functionality available in the full version of the report or chart. You can limit or expand the functionality that is available to the user at run time when you build the report in InfoAssist+.

An InfoMini application opens in its own browser window when it is run from within InfoAssist+ to test. An InfoMini application does not open in its own browser window in the BUE Portal or in any other application that you build yourself.
An InfoMini application has many of the components an InfoAssist+ report has, with the following exceptions:

- The main menu is not accessible.
- The New, Open, and View code buttons on the Quick Access Toolbar are not available.
- Certain tabs and groups are unavailable or limited.
- The status bar is not accessible.
- The navigation taskbar is not accessible.
- InfoMini does not support referencing existing procedures.

For more information on the available components and their functionality, see InfoAssist+ Application Window.

**Using the InfoMini Button**

The InfoMini button can be found on the Format tab, in the Destination group. You can click the InfoMini button to activate the InfoMini option. With the InfoMini button active, you can run a report to open the InfoMini application.

To deactivate the InfoMini option, click the InfoMini button again. There must be at least one option selected from the InfoMini button menu for InfoMini to be activated.

You can set the options available to the user at run time from the menu on the InfoMini button. If you select an option from the menu when the InfoMini button is inactive, the InfoMini option is activated. The options are:

- Format Tab
- Slicers Tab
- Run Immediately
- Run Deferred

When you select an option from the menu, a check mark appears next to the option. The check mark indicates the option is available for the user at run time within the InfoMini application. If you select a checked option to clear it, the check mark disappears, and the option is no longer available through the InfoMini application. If you clear all of the options from the menu, InfoMini is deactivated. All options are selected by default.
The Run Immediately option enables reports to run immediately when InfoMini first launches. You might want to clear this option so that the user can choose a format and pick slicers before running a report.

**Understanding the InfoMini Layout**

The Resources panel is not available in InfoMini. If no options are selected from the InfoMini button when the application runs, an error message displays, indicating that you must select at least one tab.

From the Format tab, you can access the Output Types group, with the following exceptions:

- The Destination and Features groups, which are on the Format tab in InfoAssist+, are not available in an InfoMini application.
- The Other button, which is on the Format tab, in the Chart Types group in InfoAssist+, is not available in an InfoMini application.
- The InfoMini button, which is on the Format tab, in the Destination group in InfoAssist+, is not available in an InfoMini application.

The Output Types group contains commands to create output in any of the supported formats. For reports and charts, you also have access to the Auto Linking group. This group contains options for enabling the functions of Auto Linking, a feature that allows you to create a suite of referenceable reports and charts in your enterprise.

For more information on the functionality of the available groups on the Format tab, see *Format Tab*.

From the Slicers tab, you can access the Options, Record Limit, and Slicer Group groups, with the following exceptions:

- The New Group option, which is on the Slicers tab, in the Options group in InfoAssist+, is not available in an InfoMini application.
- The Update Preview option, which is on Slicers tab, in the Options group in InfoAssist+, is not available in an InfoMini application.
- The Preview list, which is on the Slicers tab, in the Record Limit group in InfoAssist+, is not available in an InfoMini application.

For more information on the functionality of the available groups on the Slicers tab, see *Creating Slicers*. 
Creating an InfoMini Application

To create an InfoMini application in InfoAssist+, build a report as you normally would, then activate InfoMini and add the functionality you want the user to have available to them at run time. For more information on what functionality is available to InfoMini applications, see Understanding InfoMini Applications on page 159.

Procedure: How to Activate InfoMini

1. With a report or chart open, click the Format tab.
2. In the Destination group, click InfoMini.

   Note: At least one option from the InfoMini menu must be selected in order to activate InfoMini. By default, the Format tab and Slicers tab are selected on the menu when you activate InfoMini in a new report. For more information on enabling InfoMini options, see How to Enable and Disable InfoMini Application Options on page 162.

   The InfoMini button is highlighted and the InfoMini mode is activated. For more information about running an InfoMini application, see How to Test an InfoMini Application on page 162.

Procedure: How to Enable and Disable InfoMini Application Options

You can choose which options will be available at run time in an InfoMini application. By default, the Format tab and Slicers tab are selected on the menu when you activate InfoMini in a new report. For more information about the functionality of each option, see Understanding InfoMini Applications on page 159.

1. With a report or chart open, click the Format tab.
2. Click the arrow next to the InfoMini button. A menu of available tabs and options displays.

   InfoMini does not have to be active for you to access the menu. When you select an option from the menu, InfoMini is activated.
3. From the menu, select any options you want to display in your InfoMini application.

Procedure: How to Test an InfoMini Application

1. With an InfoAssist+ report open, activate InfoMini as described in How to Activate InfoMini on page 162.
2. Enable the options that you want, as described in How to Enable and Disable InfoMini Application Options on page 162.
3. Run the report.
An InfoMini application opens in a new window.

**Procedure: How to Interact With an InfoMini Application**

With an InfoMini application open, you can edit the application using the functionality that was enabled in InfoAssist+. You have access to certain options, depending on which options were enabled.

You have the ability to alter the InfoMini application at run time. Changes to the application are not reflected on the canvas dynamically and you must run the report to see the updates.

1. Run a report with InfoMini activated, as described in *How to Test an InfoMini Application* on page 162.

An InfoMini application opens in a new window.

2. By default, the ribbon is hidden in an InfoMini application. To display the ribbon, do one of the following:
   - Click one of the tabs (Format or Slicers).
   - Click the down arrow next to the Help icon.

   The available options on these tabs provide the same functionality as they do in InfoAssist+. You can use this embedded functionality to change the report at run time.

3. After making your changes, click Run to see an updated version of the report.

**Viewing Data Behind Visuals**

You use InfoAssist+ to analyze your data by creating or building interactive visualizations. As you develop these visualizations, you can create different views of the data, and find patterns or trends.

As you gain insight and spot patterns, you may want to share only the underlying data that comprises a specific visual with others in your enterprise. You can do this using the data options, as shown in the following image.

![Data Options](image)

The Show data option provides options for you to view and share this data. The Export data option enables you to export the data specific to your visualization in a summary or detailed format. You can also review related data by using the Show Data with Related Columns option.
The Show Data with Related Columns functionality allows you to review more specific underlying data based on the fields that you have selected. Specifically, it displays data related to other fields that are part of the dimension hierarchy that you select. For example, if you selected the Product,Category dimension field, the related column data would include data from the Product,Subcategory and Model dimension fields, because these data fields are part of that dimension hierarchy.

Similar to the Show data option, the Show Data with Related Columns option provides more detailed data based on the data fields that you select. You can sort and review the data columns, which display in a separate browser window. Depending on the size and breadth of your dimension hierarchy, a multiple page report may be produced.

**Note:** You can export data in .xls or .csv format.

When you select the option to show data or show data with related columns, a report is generated in a separate browser window. This report is an active report, which you can review, sort, and modify using the drop-down menus that are available.

When you point to the Export Data option, you can:

- Export data in summary format, which includes totals for categories based on the data fields that you selected for your visual.

- Export more granular data based on the data values that you selected in your visual.

**Note:**

- When exporting data using the Summary or Data Detail options, you can save the resulting data file, which is in Microsoft Excel format, to your local machine for further analysis and sharing.

- The maximum number of records that can be exported is 100,000.

**Procedure:** How to Show the Data Behind Your Visual

1. Create a visual, such as a chart, map, or grid.
2. In the upper-right corner of the visual cell, click the down arrow.
3. In the menu that appears, click Show Data.

A new browser window opens. This window displays the data for your visual as a WebFOCUS active report. You can use this active report to create and share lightweight, browser-based data discovery analytics that are portable, and only require access to a browser.
**Procedure:** How to Show Data With Related Columns

1. Create a visual, such as a chart, map, or grid.
2. In the upper-right corner of the visual cell, click the down arrow.
3. In the menu that appears, click *Show Data with Related Columns*.

   A new browser window opens. This window displays the data for your visual as a WebFOCUS active report. You can use this active report to sort and work with the underlying hierarchical data in your visual.

**Procedure:** How to Export the Data Behind Your Visual

1. Create a visual, such as a chart, map, or grid.
2. In the upper-right corner of the visual cell, click the down arrow.
3. In the menu that appears, point to *Export Data*, and then click one of the following:

   - **Summary.** A prompt appears, asking you to open or save a Microsoft Excel file. This file is a summary of your data from a high level for a general analysis, as shown in the following image.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product Category</strong></td>
<td><strong>Product Name</strong></td>
<td><strong>Revenue</strong></td>
<td><strong>Gross Profit</strong></td>
</tr>
<tr>
<td>Accessories</td>
<td>Headphones</td>
<td>$9,341,397.65</td>
<td>$2,354,397.65</td>
</tr>
<tr>
<td>3</td>
<td>Cycle Energy Quick with Refresh Charger</td>
<td>$1,508,212.41</td>
<td>$666,612.41</td>
</tr>
<tr>
<td>4</td>
<td>Denon AH-D5000 Over-Ear Headphones</td>
<td>$9,272,133.77</td>
<td>$2,477,303.77</td>
</tr>
<tr>
<td>5</td>
<td>Grado RS1i Reference Series Headphones</td>
<td>$9,452,243.25</td>
<td>$2,208,713.25</td>
</tr>
<tr>
<td>6</td>
<td>Universal Remote</td>
<td>$14,419,020.31</td>
<td>$4,401,161.31</td>
</tr>
<tr>
<td>7</td>
<td>Control</td>
<td>$9,301,960.89</td>
<td>$1,518,520.89</td>
</tr>
<tr>
<td>8</td>
<td>Anywhere Kit with Tabletop Sensor</td>
<td>$11,401,805.70</td>
<td>$2,616,237.70</td>
</tr>
<tr>
<td>9</td>
<td>Anywhere Kit for Home Theater</td>
<td>$14,276,128.75</td>
<td>$4,825,372.75</td>
</tr>
<tr>
<td>10</td>
<td>Headphones</td>
<td>$8,028,218.25</td>
<td>$4,049,178.25</td>
</tr>
<tr>
<td>11</td>
<td>Samsung OEM 2.0 Amp Travel Charger</td>
<td>$2,514,022.50</td>
<td>$1,303,511.50</td>
</tr>
</tbody>
</table>

   - **Data detail.** Generates a detailed report that provides specific data regarding your data analysis.

**Creating Multi-Y Axis Comparative Visuals**

When creating a chart with more than one measure (numeric) field, you can split the Y axis to create multiple charts, based on each unique measure field.

**Note:** Measure fields are selected from the Data pane and display under the Vertical Axis (Y) in the Query pane.
This functionality is useful when analyzing trends for multiple measure fields, as you can view data for each measure field separately within the same chart, as shown in the following image.

This functionality is available for Bar, Bar Stacked, Line, Area, and Area Stacked charts.

**Procedure:** How to Create a Multi-Y Axis Comparative Visual

1. Launch InfoAssist+ in visualization mode.
3. Select one of the following visual types: Bar, Bar Stacked, Line, Area, or Area Stacked.
   **Note:** Bar Stacked is the default visual type.
4. Add multiple measure fields to the visual. For example, Gross Profit and Revenue.
5. Add at least one dimension field to the visual. For example, Product Category.
6. In the Query pane, right-click Vertical Axis.
7. Click Multi-Y split.
   The chart changes to display individual charts for each measure field.
   **Note:** You can revert your chart to an integrated display by right-clicking Vertical Axis and then clicking Multi-Y split.
Creating HOLD Files

A HOLD file is the output of a report request stored in a file that you can use as input to another WebFOCUS procedure.

You can then create new report requests that extract data from the HOLD file, resulting in multi-step report.

HOLD files can be created to use in a report, chart, document, or visualization.

Valuable Applications of HOLD Files

A HOLD file is valuable when you want to do the following:

- Extract fields from a large data source for faster and more efficient retrieval in subsequent requests.
- Store virtual field values or summary values calculated in one request for further processing in another request.

Storing HOLD Files

HOLD files can be created for immediate use and saved temporarily or they can be stored for future and repeated use.

Output Formats for Reports

You can save a HOLD file for a report in the following formats:

- Binary (*.ftm)
- FOCUS (*.foc). For more information, see FOCUS Format Index Fields on page 171.
- Comma Delimited with Titles (*.csv)
- Plain Text (*.ftm)
- Tab Delimited (*.tab)
- Tab Delimited with Titles (*.tab)
- Database Table (*.sql)
  
  Note: The Database Table output is only available when working against an SQL database.

- SQL Script (*.sql)
- Hyperstage (*.bht)
Creating HOLD Files

**Note:** The Hyperstage output is only available when the reporting server has a Hyperstage adapter configuration.

- XML (*.xml)
- Visual Discovery AE (*.txt)
  
  **Note:** The Visual Discovery AE output option is only available with a Visual Discovery Analyst Edition license.

Creating Hold Files

This section contains examples of how you would use a HOLD file.

**Note:**

- Across fields are not allowed in HOLD files.
- Using the Change Title option in the Query pane, you can change the title of a field prior to creating a HOLD file. A blank space in the title will be replaced by an underscore. This functionality enables you to control the names used for the fields included in the HOLD file, and makes it easier to find the fields when creating report.
- When creating a HOLD file, the Temporary dialog box displays only those reporting server applications to which you have access.
- When a report contains a HOLD procedure, dots or periods (.) in the AS name of the Define field are automatically converted to an underscore (_).
- You can use Auto Linking when working with HOLD files. For more information, see *Using the Auto Linking Feature to Link Content*.

**Procedure:** How to Create a Tabular Report From a HOLD File

To create a tabular report from a HOLD file, begin by creating a report.

1. In the Open dialog box, select the `wf_retail_lite` Master File.
2. Add the following measure fields to the report:
   - Cost of Goods
   - Discount
   - Gross Profit
   - Quantity,Sold
3. Add the following dimension fields to the report:
   - Product Category
   - Product,SubCategory
   - Sale,Year

4. On the Home tab, in the Format group, click *File*.
   The Temporary dialog box opens.

5. In the Temporary dialog box, name the HOLD file, keep the default file type, Binary (*.ftm), and click *Save*.

6. At the bottom of the canvas, click *Create Report*.
   The custom database structure displays in the Resources panel. The canvas is returned to a default blank state, enabling the development of a new report using the HOLD file.

7. From the HOLD file, drag Quantity,Sold to the canvas.

8. On the canvas, select the Quantity,Sold column heading.

9. On the Field tab, in the Display group, click *Aggregation* and then click *First Value*.
   **Note:** The heading changes to FST Quantity Sold.

10. Select the FST Quantity Sold heading.

11. On the Field tab, in the Display group, click *Hide Field* to hide Quantity,Sold, as it will be used in a subsequent calculation.

12. On the Data tab, in the Calculation group, click *Summary (Compute)*.

13. In the Summary Field (COMPUTE) dialog box, do the following:
   - In the Format field, type D8.2%.
   - Double-click the Quantity,Sold field to add it to the formula box.
   - Add / 100 after the Quantity Sold field to calculate the percentage.

14. Click *OK* to close the dialog box.

15. Drag Product,Category to the By Query field container.

16. In the Query pane, select the Product,Category field.

17. On the Field tab, in the Break group, select *Subtotal* to create Subtotals on Product,Category.

18. Drag Product, Subcategory to the By Query field container.
19. Drag Sale,Year to Across.


The final report displays.

**Procedure: How to Rearrange HOLD File Components**

The following procedure describes how to rearrange file components in a HOLD file.

**Note:** This procedure creates a binary HOLD file and a subquery to illustrate how to rearrange HOLD files. It also shows the result of this rearrangement.

1. Create a new document, using the wf_retail_lite Master File for the data source.

2. On the Insert tab, in the Reports group, click Report. Populate the report with the following fields from the Data pane:
   - Gross Profit
   - Quantity,Sold
   - Revenue
   - Product,Category
   - Product,Subcategory

3. On the Home tab, in the Format group, click File to create a HOLD file.

   In the Temporary dialog box, enter a name for the file. For example, File1_binary.

4. Click Save.

5. Create a report using the HOLD file, specifying Product,Category, Product,Subcategory, and Quantity,Sold.

6. Next, using the following steps, add a subquery SQL script for use as a filter on the first report.
   a. On the Data tab, in the Data Source group, click Switch.

      Select the original master file (wf_retail_lite.mas).

   b. Locate and double-click the Product,Category dimension field.

      This creates a second report, which you can drag and resize as needed on the Document canvas.

   c. Create a filter on Product,Category, where the product category is equal to Televisions.

7. With the new component selected, click the Home tab and in the Format group, click File.
In the File name field, enter File2_subquery and select the SQL Script (*.sql) format from the file types menu.

8. Click Save.

9. Rearrange the order of the HOLD files so that the File2_subquery is positioned above the File1_binary HOLD file using the following steps:
   a. Right-click Files in the Query pane and click Arrange Files, as shown in the following image.

   ![Arrange Files Dialog Box](image)

   The Arrange Files dialog box opens.

   b. Using the Arrange Files dialog box that displays, select File2_subquery and click Move Up to move the file above File1_binary.

   c. Click OK.

10. Edit the first report and create a filter using the subquery.

11. Click OK to exit the Create a filtering condition dialog box.

   Your report is refreshed to reflect the filtering you have applied.

**FOCUS Format Index Fields**

FOCUS is the only format that supports an index field. The maximum number of fields to index is four. If the file format is FOCUS, then Index appears on the Query pane.

**Creating a Subquery Filter Using a HOLD File**

You can create a subquery using a HOLD file. A subquery is a nested query that is added to the Where clause of an SQL statement. A subquery is valuable because it is highly reusable.

**Procedure: How to Create a Subquery Filter Using a HOLD File**

This procedure describes how to create a subquery filter using a HOLD file created in the previous procedure.

1. Build a report.
Creating Shortcuts and URLs

The use of shortcuts and URLs can simplify workflow and provide additional context to your analytics. The following sections explain how to use shortcuts and URLs and describe how to create these content items in your repository.

Creating Shortcuts

Authorized users can create shortcuts to repository resources and Master Files. Once a shortcut to a Master File is created, you can use it to build visualizations and reports. Once a shortcut to a repository resource is created, you can copy, delete, edit, and run this item. You can also publish and share your shortcuts to make them available to other users and groups.

Procedure: How to Create a Shortcut to a Repository Resource

1. In the Resources tree, right-click a domain or folder, point to New, point to Shortcut, and then click To Repository Resource.

   The Create Shortcut dialog box opens.

2. Click Browse.

   The Shortcut Target dialog box opens.

3. Navigate to the resource of your choice, such as folder, report, chart, dashboard, or visualization, and then click OK.

   The Title field is automatically populated with the name of the original item and the word Shortcut.

4. Optionally, edit the Title and populate the Summary field.
5. Click OK.
A confirmation message indicates that your shortcut is created successfully.

6. Proceed in one of two ways:
- Click Browse again to create another shortcut.
- Click Cancel to close the Create Shortcut dialog box and begin using your new shortcut.

**Procedure: How to Create a Shortcut To a Master File**

1. In the Resources tree, right-click a domain or folder, point to New, point to Shortcut, and then click To Master File.
   
The Open dialog box opens.

2. Navigate to a Master File, previously generated through the Upload wizard or Connect to Data wizard, and then click Open.
   
The shortcut to the Master File appears in your selected directory in the Resources tree. You can use this shortcut to create reports and visualizations. You can also publish or share the shortcut to make it available to other users.

**Creating URLs**

Authorized users can create URLs to webpages and store them within the repository. These URLs can further enhance analytics, providing an additional interactive context to your data. You can run a URL in a new tab, use it in a dashboard, and add it to a personal page. You can also publish a URL to make it available to other users and groups.

**Procedure: How to Create a URL**

1. In the Resources tree, right-click a domain or folder, point to New, and then click URL.
   
The Create URL dialog box opens.

2. Populate the Title field, type the URL to your selected webpage in the URL field, and then click OK.
   
The URL appears in your selected location in the Resources tree.
The following image shows how a URL appears in the Resources tree and displays in a new tab inside a portal.

Creating Blogs

A blog is an interactive content item that operates as commonly-seen blogs on the internet. It allows users to post and view comments. Blogs abide by the same security rules that apply to other items in the repository. You can publish, unpublish, hide, and move blogs between domains or folders. You can also share blogs with other users and groups.

Procedure: How to Create a Blog

1. In the Resources tree, right-click a domain or folder, point to New, and then click Blog.
   The New Blog dialog box opens.

2. Type the requested information in the dialog box, as follows.
   - **Title.** Value displayed in the Resources tree that is used to identify the blog.
   - **Summary.** Optional explanation of the blog. It is displayed in the ToolTip when the mouse hovers over the blog.

3. Once you have provided the appropriate information, click OK.
   The Comments window opens.
4. Click the Add comment link to add a new comment.

5. Once you are done adding and editing comments, click Post to post the comment and close the Comments window.

6. You can optionally interact with the comments by using the following commands:
   - Click the Refresh icon in the comments menu, to refresh comments.
   - Click the Search button in the comments menu, and type a key word or words in the search field, to search through comments. You can specify the search criteria by clicking the arrow next to the Search button and selecting search criteria, such as user name, content, or meta tags.
   - Click the Remove All button to remove all comments from all users. The Remove All option is only available to managers, developers, and group administrators.

You can now publish, share, and add your blog to a page.

**Working With Pages**

Pages are a vital part of the BUE portal architecture. Depending on the type of a page, the BUE portal allows different levels of versatility in the way you organize, share, and interact with this page.

There are three types of pages in a portal. These include:

- **Base Page.** Created in the Page Designer and added to the BUE portal by a manager or developer. If a base page is unlocked, users can customize it at run time. If the user removes customizations, all changes made by the user are removed, and the base page reverts to its default state.

- **Personal Page.** Added to the BUE portal at run time by the user. Personal pages are stored in the repository but they are not visible in the Resources tree. Personal pages are only visible to the user that has created these pages.

- **Domain Page.** Created with the Page Designer directly in a domain or folder. A domain page can be copied or added to a portal, in which case it becomes a base page. If a page is removed from a portal, it becomes a stand-alone domain page and can be edited, moved, unpublished, or hidden.
Note: To avoid unwanted behaviors, you should not edit pages in the Page Designer, or move or hide pages in the repository, while users are running these pages in the BUE portal.

Page Designer Overview

The Page Designer allows you to create domain pages inside domains and folders of your choice. This section explains how to use the Page Designer to create a domain page. It also describes the different components of the Page Designer interface.

Procedure: How to Use the Page Designer to Create a Domain Page

1. In the Resources tree, right-click a domain or folder, point to New, and then click Page.
   The Page Designer opens, and the Add Page dialog box opens inside the Page Designer.
2. Select a page template and, optionally, edit the Title and Name fields.
3. Click Create.
   The page displays in the Page Designer.
4. Optionally add content to the page.
   If left blank, panels behave like Easy Selector containers at run time. To learn more about the Easy Selector, see Using the Easy Selector.
5. Optionally, unlock the page to allow run time edits. Clear the Lock Page check box in the Properties panel.
   Note: The Lock Page option is enabled, by default.
6. Save and close the Page Designer.
   A new domain page is created and now displays inside the selected domain or folder. It is ready to be added to the BUE portal.
Page Designer Interface

The following image shows the Page Designer.

The Page Designer contains the following components, located from the top of the interface to the bottom:

- Page Templates
- Application menu
- Quick Access toolbar
- Ribbon
- Canvas
- Properties panel
- Breadcrumb trail

The components are described in the following topics.
Page Templates

Page templates provide a quick way of creating page layouts. When you create a new domain page, the Add Page window opens and displays layout presets from which you can choose before adding any content.

**Note:** Page templates are only available for domain pages.

The Add Page window is shown in the following image.

The Add Page window contains the following options:

- **Page Templates.** This area contains custom and default page templates. Each template is accompanied by a thumbnail, which allows you to preview the layout. The default templates are:
  - 1 Column
  - 2 Column
  - 3 Column
  - 4 Column
  - Fluid Canvas
  - Responsive 2-2
Responsive 3-2-2
Responsive 3-3
Responsive 3-3-3
Responsive 4-2
Responsive 4-2-2
Responsive 4-4-2
Single Area

New Page Information. This area provides access to the following options:

- Title. The title of the page. The default title matches the name of the selected page template.
- Name. The name of the page. The default name matches the name of the selected page template.
- Location. The location of the page in the repository. To change the location, click Change Location and navigate to a different domain or folder.

Copy Existing Page. Creates a copy of an existing page in the repository.

Application Menu

You can access the Application menu through the BIP icon at the upper-left corner of the Page Designer window.

The menu contains options to:

- Create a page
- Open an existing page in the Page Designer
- Save the current page
- Save the current page as specified
- Exit

Quick Access Toolbar

The Quick Access toolbar allows you to save your changes to the current page.
Ribbon

The ribbon is a rectangular area of distinct groups of buttons that spans the top of the Page Designer window and provides access to commonly used tools.

The ribbon contains three tabs:

- **Layout.** Specifies the theme and layout settings.
- **Insert.** Inserts content into the page.
- **Style.** Applies styles to common properties (background, border, and font).

**Note:** You can hide the ribbon by clicking the arrow in the upper right corner of your page.

Layout Tab

The following image shows the Layout tab.

![Layout Tab Image]

The layout tab has two groups, Preview and Page.

Preview Group

The Preview group has a single Theme button. The Theme menu consists of two parts:

- **Portal Theme Files Browser.** Allows you to configure CSS files, apply a predefined theme, including a Custom theme.
- **CSS Editor.** Enables you to edit specific components of the existing CSS theme.

The default theme is Neutral.

Page Group

The Page group has a single Layout button. You can use the Layout option to change to a column-based layout or to a fluid layout. In a column-based layout, dragging a panel results in a drop indicator, showing where the panel goes. In a fluid layout, the content automatically fills the page area in equal proportions. You can manually rearrange and nest these elements on the page. The display area changes its size depending on your browser dimensions.
The Layout menu has the following options:

- **Single Area.** There is no grid, and all items are free flowing.
- **Fluid Canvas.** Items are dragged to a floating drop target that arranges the content evenly and redistributes space as more items are added.
- **One Column.** The content stretches to fill the entire page area.
- **Two Columns.** The page is evenly divided into two columns.
- **Three Columns.** The page is evenly divided into three columns.
- **Four Columns.** The page is evenly divided into four columns.

When you choose any option other than Single Area, items snap to place within the area.

**Insert Tab**

The Insert tab is used to insert two types of items:

- **Containers.** Adds a panel, accordion, tabbed, responsive, or easy selector container to the page.
- **Content.** Inserts WebFOCUS content (for example, visualizations, reports, charts, documents, dashboards, and URLs), images, and text.

**Style Tab**

The following image shows the Style tab.

![Style Tab Image]

The Style tab is used to configure styling of objects, options for the background and borders, as well as fonts and colors of the text. This tab functions in the same way as does the Style tab in the Portal Designer.

**State**

From the State group, you choose which of the available states you are styling for an object. The state options are:

- **Normal.** This is the default state of an object in which an event, such as a hover, is not occurring, or if styling for that event is not defined.
- **Active.** This is the state in which the object is currently in use. An example is the background color of the current page tab.

- **Hover.** This is the state in which the mouse cursor is resting on the object.

**Background**

You can use an image, a color, or a combination of options when styling the background of an object.

**Image**

The Image button is a split button. Clicking the left side of the button launches an Open dialog box. Clicking the right side of the button displays the Background Image Options. The Background Image Options allow you to change or remove an image.

Click *Change Image* to launch the Open dialog box. From this dialog box, select an existing image in the Repository to use as the background, and click *Open*.

To add a new image, use the Resources tree, and right-click the folder that you wish to place the new image in. Point to *Upload* and click *Image*.

**Repeat**

The Select Background Repeat menu enables you to choose whether or not to repeat the background. The options are:

- **None.** Displays the background image only once.

- **Everywhere.** Repeats the background image horizontally and vertically. This is the default value.

- **Horizontally.** Repeats the background image horizontally.

- **Vertically.** Repeats the background image vertically.

**Position**

If you do not choose to repeat the image everywhere, you can select a background position using a visual menu. For example, you can position the background image at the bottom of the window, on the right. This feature is similar to Menu Bar positioning.

The default background position is top left.
Background Color

The Background Color icon launches the color selection dialog box for setting a page background color. The same icon is used in the Border and Font groups to set the border and font colors, respectively.

Reset Background

The Reset Background icon in the Background group resets the background styling to the theme settings for the currently selected state. The same icon is used in the Border and Font groups to reset those groups.

Border

In addition to color and reset, the Border group has style and width controls.

Style

The Select Border Style menu is a visual menu that enables you to choose one of nine border styles. In the order of left to right (by row), the styles are:

- None (This is the default border style.)
- Solid
- Dotted
- Dashed
- Double
- Groove
- Ridge
- Outset
- Inset

Width

The Width control sets the border thickness in pixels (px). If the style is set to none (the default for most objects), the Width control has no effect.
Color

The Border Color icon launches the color selection dialog box for setting the Border color.

Reset Border

The Reset Border icon in the Border group resets the border styling to the theme settings for the currently selected state.

Font

The Font group enables you to set:

- Font family
- Font size in pixels
- Formatting
  - Bold
  - Italic
  - Underline

In addition, the Font group contains:

Color

The Font Color icon launches the color selection dialog box for setting the font color.

Reset Font

The Reset Font icon in the Font group resets the font styling to the theme settings for the currently selected state.
Canvas

The following image shows the canvas of the Page Designer.

The canvas is the design area of your page.

Properties Panel

The Properties panel appears near the bottom of the window, below the canvas. It shows properties that apply specifically to the currently selected item.

Breadcrumb Trail

The breadcrumb trail appears at the bottom of the Page Designer window. It serves two purposes:

- It indicates the currently selected item.
- You can use it to change the currently selected item.

Click any portion of the breadcrumb trail to change the currently selected item on the page canvas. This feature is another way to select an item, in addition to selecting it through the canvas. This feature is especially useful when you are working with hidden or layered content.
Page Components

The page is made up of different components, such as columns, containers, and resources. This section describes the different components of a page and their properties.

Page

The Page, while not a component itself, does have properties that you can set.

The following are the properties of a page.

- **Title.** The title or label shown in the navigation menu and any tree that displays the list of pages in the portal.

- **Page Icon.**
  - This is an icon displayed to the left of the page name throughout WebFOCUS. You can turn it on or off. It is disabled, by default.
  - The maximum display size of the icon is 16 x 16 pixels. Upload an image that is visible at that size.
  - Change the portal icon by clicking the preview icon or the Change Image button.

- **Lock Page.** Turns off customization on the page. Customization includes moving content and adding content.

  **Note:** The Lock Page check box is selected by default. Clear it to grant permission to end users from moving and adding content.

- **Refresh on Click.** Refreshes the page when you click the page title. This feature is useful if another page changes the parameters used by the reports on this page. When you switch back, the reports rerun with the appropriate parameters.

- **Show in Navigation.** Used to hide the page from the navigation. You can use this property to create a Home page for a portal that displays the first time that a user runs the portal, but the user cannot navigate to it again. In a future WebFOCUS release, there will be support for a URL for each page, allowing you to link to a page that is not included in the navigation.

- **Prevent Layout Change.** Restricts layout changes on unlocked pages at run time. This option is only active when the Lock Page option is disabled.

- **Relative Path.** References a specific path for the content that was added to a page and allows you to move the page in the repository without losing any content or resources.
Show Refresh. If enabled, displays the Refresh option in the page menu at run time.

Margins. Sets page margins in pixels or as a percentage. Use the Same for All option to set equal margins on all four edges of a page.

Comments. Controls the placement of the comments on a page. The options include: none, top, bottom, left, and right.

Container Defaults. Opens the Container Defaults dialog box, where you can set a default size, appearance, and list of behaviors for all containers on a page.

Columns

Columns have the following properties:

Column Number. A label that indicates the column that is selected on the page.

Width. Set in pixels or as a percentage.

Lock Width. Prevents a designated column width from being changed at run time. This option is disabled, by default.

Container Padding. The space between either container and the column edge (left and right of each container, the top of the first container, and the bottom of the last container) or each other (vertical space between each container). These work like page margins, but are set only in pixels.

Freeze Column. Prevents users from adding content to the column or any of the containers inside this column at run time. It also prevents users from removing any content or containers from this column at run time. This option is not available when the Lock Page option is selected.

Show Easy Selector. Activates the Easy Selector function at run time.

Select Folder. Opens the Browse For Folder dialog box, where you can select a folder that is available from the Easy Selector option at run time.

Containers

There are five types of containers:

Panel. A simple container that can hold a single piece of content.

Accordion. A compound container that can hold one or more pieces of content. It uses accordion panes to switch between the content.
- **Tabbed.** Similar to the accordion, but uses tabs to switch between the content.

- **Responsive.** A compound container that responds to the layout changes based on the size of the browser or device.

- **Easy Selector.** A simple container that a flexible way of adding content to a portal at run time without opening the Resources tree.

### Panels

The panel container holds a single piece of content, as shown in the following image.

![Sales by State](image)

The panel consists of three sections:

- **Overall panel**
- **Title Bar**
- **Content Area**
When you hover over a panel in Page Designer, the Change Panel Type button is illuminated. When you then hover over this button, you are presented with a menu where you can change the type of the panel.

To change the title of the panel, right-click the title bar and click Change Title, as shown in the following image.

Panel Properties

The properties for all panel types are:

- **Properties Tab.** Contains the properties that apply to the panel.

  - **Panel Title.** This is the name of the panel. In a simple panel, the title begins as Paneln, where n is a unique number, starting at 1.

  - **Size.** In a single area layout, this is both height and width in pixels. In column-based layouts, this is height only. You can set the height, in pixels, to Auto, Dynamic, or a numeric value. The Dynamic height option is only available when you use a responsive container.

  - **Responsive Properties.** Opens the Responsive Panel Properties dialog box, where you can edit the layout of the responsive container.
Behaviors. You can configure how the panel behaves. By default, all options are on. The options that require a menu click are available by hovering over the title bar and accessing the menu at the upper-right (in accordion and tabbed containers, each area has a menu as well). The options are as follows:

- **Move.** If selected, allows you to move a panel on a page at run time.
- **Resize.** If selected, allows you to resize a panel at run time.
- **Minimize.** Adds the Minimize option to the panel drop-down menu.
- **Maximize.** Adds the Maximize option to the panel drop-down menu.
- **Refresh.** Adds the Refresh option to the panel drop-down menu.
- **Hide.** Adds the Hide option to the panel drop-down menu.
- **Delete.** Adds the Delete option to the panel drop-down menu. When a user deletes a panel, they delete it only from their version.
- **Show Comments.** Displays comments on a panel, and adds the Show/Hide Comments option to the panel drop-down menu, if selected.

Appearance. You can control the following options:

- **Hide Panel.** When this option is selected, the panel is not initially visible. The user can add it by clicking Hidden Content in the page shortcut menu or the Menu Bar.
  You can use the Hidden Content feature to give the user a choice of widgets to view on their page.

- **Freeze Container.** Prevents users from adding content to and removing content from the container at run time. This option also restricts any interaction with the container at run time except minimizing, maximizing, and restoring the panel to its original size. This option is not available when the Lock Page option is selected.

- **Title Tab.** Contains the properties that apply to the title bar of the panel.

  - **Title.** This is the text displayed in the title bar. When you add content, it automatically changes to the current title of that content. You can edit this field to override the automatic change.

  - **Panel Icons.** Works just like the page icon. It is disabled by default.

  - **Change Image.** Allows you to select a different image for the icon.
☐ **Appearance.** You can control the following options:

☐ **Hide Title Bar.** You can hide the title bar to save space. This feature is very useful when you have only a single piece of content on a page.

☐ **Show Menu Icons.** Determines whether the icons that display with the options in a container shortcut menu are visible.

☐ **Content Tab.** Contains the properties for a content item that is displayed inside the panel.

☐ **Content Area.** The properties for the Content Area differ based on the type of content. A blank panel has a blank properties panel.

☐ **Auto Refresh.** If enabled, refreshes the content automatically. This property is off by default. When it is enabled, the default time is 30 seconds.

☐ **Dynamic Report Styling.** When this property is enabled, all reports that run within the BUE portal inherit their styling from the portal.

☐ **Tabs/Areas Tab.** Contains the properties that apply to tabs and areas. This tab is only visible in the properties panel of a tabbed or accordion container. Here you can style different areas of the container by selecting **Buttons or Bar.** You can also hide the new tab button from a tabbed container, or the new area button from an accordion container, to restrict adding more tabs and areas to this container at run time.
**Accordion Container**

The accordion container can hold more than one piece of content, as shown in the following image.

In the preceding image, notice how the chart fits perfectly in the container. WebFOCUS InfoAssist+ has an option to AutoFit charts. When enabled, it accepts the sizing from the portal. This prevents the person who develops the chart and the person who uses it from having to coordinate sizing. Additionally, you can easily resize the container and see the entire chart.

The title bar and content area properties are the same. The overall properties have an additional section labeled Area.

In the Area section, you can use the icons in the order in which they appear to add, rename, delete, and reorder the areas. You can also create a new area using the new area bar in the container or delete containers using the menus. You must use the Properties panel to rename or reorder the areas.

There is also an additional Properties panel, the Pane Title Bars, which is accessible only through the breadcrumb trail. This feature lets you style the title bars of the areas. They are all styled together, but you can style the different states to distinguish the currently active one from the one on which the mouse pointer is resting.
Tabbed Container

The tabbed container can hold more than one piece of content, as shown in the following image.

The tabbed container has all the same properties as the accordion container. Instead of the Pane Title Bars properties, it has a property panel called Tab Bar. You can access this property panel by clicking it.

Unlike the Pane Title Bars, it is not blank. You can choose to style the buttons or the bar.
Responsive Container

The responsive container is designed to help you build a responsive portal that automatically adapts to different screen sizes and mobile devices, providing an optimal viewing experience for users everywhere. You can build your responsive portal on your desktop, and make it available to users on different platforms. The following image shows an example of a responsive portal displayed on a desktop, tablet, and smartphone.

The responsive container intuitively changes its layout when you change the size of your browser. The default width and height of the container, and the inserted items, are pre-configured to offer the best positioning of the elements on the screen. You can manually change the dimensions of the items in the Responsive Item Properties dialog box. You can also change the layout options in the Responsive Panel Properties dialog box.

Responsive Item Properties

The Responsive Item Properties dialog box provides options to change the dimensions of an individual item within the responsive container. You can access the Advanced Responsive Item Properties dialog box at design time by clicking the Responsive Properties button in the property sheet.

The properties for a responsive item are:

- **Custom CSS Classes.** Enables custom CSS classes for the item.
- **Width.** Defines the width of the item.
- **Height.** Defines the height of the item.
- **Margin.** Defines the space between the adjacent items.
- **Shrink.** Defines the ability of the item to shrink if necessary.
- **Grow.** Defines the ability of the item to grow if necessary.
- **Basis.** Specifies the initial size of the item, before any available space is distributed according to the responsive factors.
- **Minimum Width.** Sets the minimum width of the specified element. This setting overrides the Width setting.
- **Maximum Width.** Sets the maximum width of the specified item. This setting overrides the Width setting.
- **Minimum Height.** Sets the minimum height of the specified item. This setting overrides the Height setting.
- **Maximum Height.** Sets the maximum height of the specified item. This setting overrides the Height setting.
- **Self Align.** Provides access to the following options:
  - **Auto.** Intuitively places the item in the best available space inside the responsive container.
  - **Start.** Aligns the item to the left side of the responsive container.
  - **End.** Aligns the item to the right side of the responsive container.
  - **Center.** Aligns the item to in the center of the responsive container.
  - **Stretch.** Stretches the item to fill the available space inside the responsive container, while respecting width and height constraints.
  - **Baseline (text).** Aligns the baseline of text inside the responsive container.

**Note:** In a responsive layout, setting fixed dimensions for items is not recommended, because the viewport width and height continually change from device to device. Responsive layouts need to adapt to this change, whereas fixed dimensions create too many constraints. For this reason, you must only set a range between minimum and maximum width and height, defining an amplitude with which the item can vary in size.
Easy Selector Container

The easy selector container provides a simple way to add content to a portal at run time, without opening the Resources tree. It also gives you the option to control which items users can access. When you insert an easy selector container into a page at design time, the Browse For Folders dialog box opens, as shown in the following image. Here you can select a folder that users can access at run time.

To change a target folder, click the Change Folder button in the Properties panel.

Content

You can add content to a page in a few ways. The first way is to use the ribbon. Navigate to the Insert tab and choose a type of content in the Content group. The second way is to insert a blank panel, area, or tab container, and use the WebFOCUS Resources option to populate it. The Resources tree opens, allowing you to drag content into the page.

Note: When you click and drag one or multiple resources or folders from a tree to a blank page, a tabbed container is created, showing each resource.

The other three options (Image, Resource Tree, and Text) place their content in the content area that is selected, if applicable. Alternatively, they create a new panel with the content on the page.
WebFOCUS Resources

The WebFOCUS Resource option opens the Resources tree on the right-hand side of the window. The tree shows you the content stored in the WebFOCUS Repository. You can access this content in the Domains section of the tree. Alternatively, you can find a resource that you marked as a Favorite.

The Resources tree is docked on the right. When it is docked, you can keep it open, close it, or unpin it so that it collapses to the side. The Resources tree is shown in the following image.

Text

The last type of content is text. The text area is simple to use. All styling is applied to all the text. You cannot style individual words or characters.

The text area has no properties other than the content type and the Area ID.

Working With the WebFOCUS BUE Portal

The first page that you see as a Manager, is the Getting Started page. If you sign in as any other user, the first page you see is the Home page. If you add a new personal page and sign out of the portal with the new page in focus, the new page opens, by default, the next time you sign in. You can create new pages in the WebFOCUS Business User Edition to display the content that is available to you.
Procedure: How to Add a New Personal Page

Click the Add Page icon, as shown in the following image.

![Add Page Icon](image)

A blank page and the WebFOCUS Resources panel opens. You can drag content from the Resources tree panel to the page.

Procedure: How to Add a New Base Page

1. In the Resources tree, right-click a domain page, and then click Publish.

   For more information on how to create domain pages, see How to Use the Page Designer to Create a Domain Page on page 176.

2. Right-click your published page, and then click Add to Portal.

   The confirmation message appears indicating that the page is added to the portal.

3. Click OK to close the confirmation message.

   The BUE portal refreshes, the new page appears in the new tab.

   Note: The domain pages added to the BUE portal behave as base pages. Base pages are locked by default at design time to prevent users from making run-time changes.

Procedure: How to Add Content to the BUE Portal at Run Time

1. Navigate to the page that you want to populate with content.

2. On the Menu bar, click Resources.

   The WebFOCUS Resources panel opens.
3. Drag an item on the page. Use the shaded area to position the item on the page, as shown in the following image.

![Image of WebFOCUS Resources panel]

**Note:** When you drag one item on top of another and position your cursor in the center of the other item, you have a choice to either replace the existing item or add the new item as a new tab. If you choose the latter, a tabbed container will be automatically created. If you choose the latter, a tabbed container will be automatically created. If you multi-select several items and drag them to a page, they will display as tabs inside a single panel. You can refresh or delete each tab individually. You can rearrange content by moving it on the page with your pointer. Optionally, you can change the layout of the page by right-clicking the page title, and then clicking *Page Layout*. The default layout of the personal pages is Fluid Canvas.

4. After you finish adding content to the page, close the WebFOCUS Resources panel by clicking the *Close* icon in the upper-right corner of the panel.
Accessing Page Shortcut Menu Options

Right-click the page title of a personal page or an unlocked base page to access page shortcut menu options. The shortcut menu opens, as shown in the following image.

- **Change Title**: Renames the selected page.
- **Move Left**: Moves the selected page to the left.
- **Move Right**: Moves the selected page to the right.
- **Page Layout**: Allows you to choose a page layout to align your content into the desired number of columns.
- **Delete**: Deletes the selected page.

**Note**: The Home and Getting Started pages do not have shortcut menu options, since these are static base pages for the BUE portal.

Creating Report Queries With InfoAssist+

You can create a new report query directly from Excel by accessing the WebFOCUS Quick Data Add-in. Specify connection attributes and the data source for your query, and then build your report using InfoAssist+. You can place multiple queries in the same worksheet, or spread them out over multiple worksheets in a workbook.

There are limitations with queries that overlap. However, there are data layout options available in the Query properties of Excel that can assist with overlapping queries. This behavior is governed by Excel, not WebFOCUS Quick Data.
**Note:** Quick Data is a WebFOCUS Business User Edition option, which requires a separate license and installation. For more information about licensing Quick Data, contact your Information Builders representative.

**Procedure:** How to Create a New Report Query in InfoAssist

1. Open an Excel file.
2. Select a cell in which to place the query results.
3. With the Add-Ins tab selected, click the WebFOCUS option in the Excel menu, and then click **Create Query**.
   You can also right-click any cell and select **Create WebFOCUS Query**.
4. In the Web Server Connection dialog box, specify the desired Web Server URL and connection settings, and then click **Next**.
   **Note:** Do not end the URL with the / sign.
5. If prompted for sign-in credentials, sign in with your WebFOCUS Business User Edition login and password.
   The next screen opens, where you can select a folder to open a list of available data sources.
6. Select a folder and click **Next**.
7. In the Data Source Selection dialog box, select a Master File, as shown in the following image, and then click **Finish**.

InfoAssist+ opens, where you can build a query and run it to return the output data to Excel.
Example: Creating a New Report Query in InfoAssist

This example covers multiple aspects of creating a new report query using the WebFOCUS Quick Data tool from an Excel file.

1. Open an Excel file, select a cell in which to place the query results, select the ADD-INS tab, click the WebFOCUS option in the Excel menu, and select Create Query.

The Web Server Connection dialog box opens.

2. In the Web Server URL field, type the URL for a web server in your reporting environment, or select one from the drop-down list. An example of a Web Server URL is:

http://localhost:26000

Note: Do not end the URL with the / sign.

3. Click Next.

4. Select a folder to open a list of available data sources. In this example we use the Retail Samples folder. Click Next.

5. In the Data Source Selection dialog box that opens, select WF_RETAIL_LITE from the Data Source list, and click Finish.

InfoAssist+ opens.

6. Drag fields from the Data pane to the Query Pane to create a report.


After you perform the steps up to this point, the InfoAssist window looks similar to the following.
8. Click the Save button.

The report query data is transferred to the Excel file, as shown in the following image.

![Excel spreadsheet]

9. Click the drop-down arrow to the right of the Name Box. You will see named ranges that are automatically added to the query, as shown in the following image.

![Named ranges in Excel]
Named ranges are added to the entire data table. The named range for the entire data table is QDATA1.

10. Select QDATA1 from the Name Box. The data in the table is automatically highlighted.
11. Save the Excel file so that it can be reused in the example on editing an existing report query.

**Ribbon Command Reference**

The ribbon is contextual and changes depending on the type of file that you are developing. This topic describes each of the available ribbons and commands for each InfoAssist+ tool.

**Ribbon Commands for Reports**

When creating and customizing reports in Report mode, you can use the following ribbons and commands to customize report functionality.

**Home Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format Group</strong></td>
<td></td>
</tr>
<tr>
<td>Output File Format</td>
<td>Displays a drop-down menu of all supported output formats.</td>
</tr>
<tr>
<td>Chart</td>
<td>Switches to Chart mode. Converts a report to a chart using the fields specified in the report.</td>
</tr>
<tr>
<td>Report</td>
<td>Indicates that you are in Report mode.</td>
</tr>
<tr>
<td>File</td>
<td>Creates a data file from a report.</td>
</tr>
<tr>
<td><strong>Design Group</strong></td>
<td></td>
</tr>
<tr>
<td>Query (Design view)</td>
<td>Displays the Data, Query, and Filter panes across the entire canvas, eliminating Live Preview. This view provides a larger work area for creating the report.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>Displays the report on the canvas as you create the report. You can use the Live Preview to add, remove, and arrange fields, as well as style the report.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Converts a report into a document. Opens the document on canvas, which you can use to add text, images, lines, reports, and charts to create documents.</td>
</tr>
<tr>
<td>Data from Source</td>
<td>Uses the selected data source to display a live preview of the output on the canvas.</td>
</tr>
<tr>
<td>Use Sample Data</td>
<td>Displays sample data, which reduces processing time by eliminating the need to access the actual data source.</td>
</tr>
<tr>
<td>Records</td>
<td>Limits the number of rows retrieved from the data source when Live Preview is selected. This feature is useful in reducing response time if you are working with a large amount of data. Type the number of rows that you want directly in the Records field, or use the drop-down menu to select one of the preset record limits. The preset choices are All rows, 1, 10, 50, 100, 500, 1000, 2000, 5000, and 10000.</td>
</tr>
</tbody>
</table>

**Filter Group**

<table>
<thead>
<tr>
<th>Filter</th>
<th>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude</td>
<td>Turns off a filter.</td>
</tr>
<tr>
<td>Include</td>
<td>Turns on a filter.</td>
</tr>
</tbody>
</table>

**Report Group**

<p>| Theme                         | Opens a dialog box where you can select a theme to style your report or chart. You can use the default style sheet by clicking the Use Default Stylesheet button. You can also select a document styling theme or an application theme to style all reports created. Use the Environment and Styling section of the Options window, which is accessible by clicking Options in the Application main menu. |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>Opens a Report Style dialog box for applying global styling to the entire report. For more information about styling reports, see <em>Styling Reports</em>.</td>
</tr>
<tr>
<td>Banded</td>
<td>Opens a Color dialog box for choosing a color that provides an alternating color scheme for the report. The report output displays alternating rows of data, using a white background for one row and a background of the selected color for the next row. This pattern continues throughout the report.</td>
</tr>
<tr>
<td>Header &amp; Footer</td>
<td>Opens the Header &amp; Footer dialog box, from which you can add and style headings and footings.</td>
</tr>
<tr>
<td>Column Totals</td>
<td>Adds a grand total row to the bottom of the report to sum numeric data in each column.</td>
</tr>
<tr>
<td>Row Totals</td>
<td>Adds a grand total column to the right side of the report to sum numeric data in each row.</td>
</tr>
</tbody>
</table>

**Format Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Group</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfoMini</td>
<td>Enables the creation of an InfoMini application. For more information on using InfoMini, see <em>Building InfoMini Applications</em> on page 159.</td>
</tr>
<tr>
<td>Chart</td>
<td>Switches to Chart mode. Converts a report to a chart using the fields specified in the report.</td>
</tr>
<tr>
<td>Report</td>
<td>Indicates that you are in Report mode.</td>
</tr>
<tr>
<td>File</td>
<td>Creates a data file from a report.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table</td>
<td>Generates standard browser output. This is the default.</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>Generates output by displaying a table of contents icon in the upper-left corner where report output typically appears. Clicking Table of Contents opens a menu that enables you to select (view) individual values of the first Sort By (By) field, one value at a time. You can also select options to view the entire report or remove the table of contents.</td>
</tr>
<tr>
<td>Freeze</td>
<td>Generates output with column titles that freeze (remain in view) when you scroll through pages of the report output.</td>
</tr>
<tr>
<td>Pages On Demand</td>
<td>Provides access to two distinct features, depending upon the output type that you have selected.</td>
</tr>
</tbody>
</table>

**Features Group**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Popup</td>
<td>Displays pop-up titles when the mouse pointer hovers over a column title in the report output.</td>
</tr>
<tr>
<td>Accordion</td>
<td>Creates expandable views of data for each vertical sort field. This option displays data values only for the first vertical sort field when you first view the output. You can manually expand your view to expose the data values of lower-level sort fields.</td>
</tr>
<tr>
<td>Repeat Sort Value</td>
<td>Displays all repeated sort values instead of blanks in the output after the first instance of a new sort value, which is the default behavior.</td>
</tr>
<tr>
<td>Stack Measures</td>
<td>Displays all numeric measure field names in a column of the report output with the corresponding numeric data values.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>active report Options</td>
<td>Opens the active report options dialog box where you can configure your active report options such as menu items, graph engine, and colors. For more information, see <em>Using Active Technologies</em> on page 94.</td>
</tr>
<tr>
<td>Accessibility</td>
<td>Allows a title to be added to a report, chart, or document that is Section 508-compliant.</td>
</tr>
<tr>
<td><strong>Auto Drill Group</strong></td>
<td></td>
</tr>
<tr>
<td>Auto Drill</td>
<td>Enables you to navigate through different levels within the dimension hierarchy of your data source. Click <em>Auto Drill</em> to enable the functionality. For more information, see <em>Using Auto Drill</em>.</td>
</tr>
<tr>
<td><strong>Auto Linking Group</strong></td>
<td></td>
</tr>
<tr>
<td>Enable Auto Linking</td>
<td>Enables auto linking. For more information, see <em>Using the Auto Linking Feature to Link Content</em>.</td>
</tr>
<tr>
<td>Auto Link Target</td>
<td>Sets procedure as an available target for auto linking.</td>
</tr>
<tr>
<td><strong>Data Tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Calculation Group</strong></td>
<td></td>
</tr>
<tr>
<td>Detail (Define)</td>
<td>Opens the Detail Field (DEFINE) dialog box, where you can create a defined field, type a name for the field, and enter a format. A Define field is an optional attribute used to create a virtual field for reporting. You can derive the virtual field value from information already in the data source (that is, from permanent fields).</td>
</tr>
<tr>
<td>Summary (Compute)</td>
<td>Opens the Summary Field (COMPUTE) dialog box, where you can create a computed field, type a name for the field, and enter a format.</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Join Group</strong></td>
<td></td>
</tr>
<tr>
<td>Join</td>
<td>Opens the Join dialog box, where you can create a new join, edit or delete existing joins, and add data sources to a join.</td>
</tr>
<tr>
<td><strong>Filter Group</strong></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td><strong>Display Group</strong></td>
<td></td>
</tr>
<tr>
<td>Missing Data</td>
<td>This option is disabled for reports.</td>
</tr>
<tr>
<td><strong>Data Source Group</strong></td>
<td></td>
</tr>
<tr>
<td>Add</td>
<td>Opens the Open dialog box, where you can add additional data sources to a document, enabling you to insert reports from different data sources into the same document. This option is activated when you add a HOLD file. This option is unavailable, by default.</td>
</tr>
<tr>
<td>Switch</td>
<td>Opens a drop-down list of all the data sources that have been added. You can choose which data source is currently active and being used to create new reports. This option is activated when you add a HOLD file. This option is unavailable, by default.</td>
</tr>
</tbody>
</table>

**Slicers Tab**

<table>
<thead>
<tr>
<th><strong>Command</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options Group</strong></td>
<td></td>
</tr>
<tr>
<td>New Group</td>
<td>Creates a new group of similar slicers.</td>
</tr>
<tr>
<td>Clear Slicers</td>
<td>Resets all slicers so that no filtering is done.</td>
</tr>
</tbody>
</table>
### Command Reference

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Preview</td>
<td>Applies slicers to preview.</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the Edit Slicers dialog box to the General tab, where you can set general options for your slicers.</td>
</tr>
</tbody>
</table>

#### Record Limit Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Sets the number of records retrieved from the data source for preview.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Sets the number of records retrieved at run time.</td>
</tr>
<tr>
<td>Record Limit</td>
<td>Opens the Edit Slicers dialog box to the Record Limit tab, where you can set record limits for your slicers.</td>
</tr>
</tbody>
</table>

#### Group Number Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group n</td>
<td>Contains a group for each Slicer group that is added. Group 1 is the default slicer group to which you can drag fields to create slicers. To access slicer group options, click Group n to open the Edit Slicers dialog box where you can rename the slicer group and modify the order of the slicers in the group.</td>
</tr>
</tbody>
</table>

#### Layout Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Setup Group</td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td>Enables you to set margin values by choosing Normal (1 inch all around), Narrow (.5 inch all around), Moderate (.5 inch left or right), Wide (1.5 inch left or right), or Custom. Choosing Custom opens the Margins dialog box, where you can set specific margins as needed.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Enables you to set the orientation of your report to portrait or landscape.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Size</td>
<td>Enables you to select the size of the paper for printing output. You can choose A3, A4, A5, Letter, Tabloid, Legal, PowerPoint, or Large Size (34 x 44 Inches).</td>
</tr>
<tr>
<td>Units</td>
<td>Enables you to select the unit of measurement used for customizing the dimension fields of your report. You can choose Inches, Centimeters, or Points.</td>
</tr>
<tr>
<td>Page Numbers</td>
<td>Enables you to select page numbering options. You can choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>- No Lead (no space for headers)</td>
</tr>
<tr>
<td></td>
<td>- On (page numbers only in headers)</td>
</tr>
<tr>
<td></td>
<td>- Off (space for headers, but no page numbering)</td>
</tr>
<tr>
<td></td>
<td>The Page Numbers value is overridden by header and footer text options.</td>
</tr>
<tr>
<td>Report Group</td>
<td></td>
</tr>
<tr>
<td>Cell Padding</td>
<td>Opens the Cell Padding dialog box, where you can set specific values to control the amount of space inserted between rows and columns in a report. For more information, see <em>Use Cell Padding in a Report</em>.</td>
</tr>
<tr>
<td>AutoFit</td>
<td>Limits the width of columns in a report to be no wider than the largest value in each column. AutoFit Column is selected, by default.</td>
</tr>
<tr>
<td>View Tab</td>
<td></td>
</tr>
<tr>
<td>Design Group</td>
<td></td>
</tr>
</tbody>
</table>
### Command Reference

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query (Design view)</td>
<td>Displays the Data, Query, and Filter panes across the entire canvas, eliminating Live Preview. Provides a larger work area for creating the report.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>Displays the report on the canvas as you create the report. You can use the Live Preview to add, remove, and arrange fields, as well as style the report.</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Converts a report into a document. Opens the document on canvas, which you can use to add text, images, lines, reports, and charts to create documents.</td>
</tr>
</tbody>
</table>

### Show/Hide Group

| Resources                      | Minimizes the Resources panel and expands the size of the canvas to also occupy the area where the Resources panel typically appears. The canvas can display a preview of a report, output of a report, or the Query Design pane. |

### Data Panel Group

<table>
<thead>
<tr>
<th>Logical</th>
<th>Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias.</th>
</tr>
</thead>
<tbody>
<tr>
<td>List</td>
<td>Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference.</td>
</tr>
<tr>
<td>Structured</td>
<td>Displays the hierarchical structure of the data source files. The Structured view options include Title, Description, Field, and Alias.</td>
</tr>
</tbody>
</table>

### Query Panel Group

<p>| Areas 2x2                       | Displays data in a two column by two-row grid.                                                                                               |
| Areas 1x4                       | Displays data in a one column by four-row grid.                                                                                               |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tree</td>
<td>Displays data in a tree. This is the default.</td>
</tr>
</tbody>
</table>

**Output Window Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrange</td>
<td>Opens a drop-down menu where you can choose how to display multiple output windows. The options are Cascade, Tile Horizontally, and Tile Vertically.</td>
</tr>
<tr>
<td>Output Location</td>
<td>Opens a drop-down menu where you can choose how to direct new output. The options are Single tab (default), New Tab, Single Window, and New Window.</td>
</tr>
<tr>
<td>Switch Output</td>
<td>Opens a drop-down menu for choosing to view any active output window.</td>
</tr>
</tbody>
</table>

**Report Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch Report</td>
<td>Lists any active reports, charts, documents, and visuals to which you can switch.</td>
</tr>
</tbody>
</table>

**Field Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Group</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Removes, but does not delete, the filter from the report.</td>
</tr>
<tr>
<td>Include</td>
<td>Restores a filter that was previously excluded from a report.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Prompt  | Opens the Create a filtering condition dialog box for creating an auto prompting parameter that you can select when you run a report. The Create a filtering condition dialog box is used to create both filters and auto prompting parameters. The following prompt options are available when Parameter is selected from the Type drop-down menu:  
- **Simple.** This is used for prompts using Text Input. This is the default value.  
- **Static.** This is used for prompts using Selection. This option allows you to select multiple values at run time.  
- **Dynamic.** This is used for prompts using Data Values. This option allows you to select multiple values at run time.  
- **Optional.** This is used for prompts using Single or Multiselect parameters. |

<table>
<thead>
<tr>
<th>Sort Group</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td>Sorts the selected field in ascending order. This option is activated when you click on a measure or dimension.</td>
</tr>
<tr>
<td>Down</td>
<td>Sorts the selected field in descending order. This option is activated when you click on a measure or dimension.</td>
</tr>
<tr>
<td>Rank</td>
<td>Inserts a rank column immediately to the left of the report if a Sort By field is selected. It also adds a rank column to the left of the Sort By field if a Measure field is selected. Ranking a Measure field results in two copies of the field, the original Measure field, and the Sort By field that is created during ranking. This option is activated when you click on a measure or dimension.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Group</td>
<td>Opens the Create a Group dialog box where you can create a group to combine values together. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Limit</td>
<td>Opens a drop-down menu that allows you to specify the number of unique values to display for a sort group that has been added. This option is activated when you click on a measure or dimension.</td>
</tr>
<tr>
<td><strong>Break Group</strong></td>
<td></td>
</tr>
<tr>
<td>Page Break</td>
<td>Starts a new page when the primary sort field changes. Clicking the drop-down icon enables you to select <em>Reset Page Numbers</em>, which allows you to reset page numbers on a page break to start at 1. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Line Break</td>
<td>Inserts a line in the report output when the primary sort field changes. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Subtotal</td>
<td>Inserts a line, total text (TOTAL FIELD Value), and subtotals for all numeric fields when the primary sort field changes. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Sub Header</td>
<td>Opens a dialog box where you can type text to add a subheading just below the column titles in the report output when the primary sort field changes. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Sub Footer</td>
<td>Opens a dialog box where you can type text to add a subfooting at the end of the data on each page of the report output when the primary sort field changes. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td><strong>Style Group</strong></td>
<td></td>
</tr>
<tr>
<td>Font</td>
<td>Opens the Font list, which you can use to change the font.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Font Size</td>
<td>Opens the Font Size list, which you can use to change the numeric value for the font size.</td>
</tr>
<tr>
<td>Font Color</td>
<td>Opens the Color dialog box, where you can select the font color.</td>
</tr>
<tr>
<td>Style Reset</td>
<td>Resets all settings to the default settings from the template.</td>
</tr>
<tr>
<td>Bold</td>
<td>Applies bold font formatting to the selected text.</td>
</tr>
<tr>
<td>Italic</td>
<td>Applies italic font formatting to the selected text.</td>
</tr>
<tr>
<td>Underline</td>
<td>Underlines the selected text.</td>
</tr>
<tr>
<td>Justify Left</td>
<td>Aligns the text to the left of the report.</td>
</tr>
<tr>
<td>Justify Center</td>
<td>Aligns the text to the center of the report.</td>
</tr>
<tr>
<td>Justify Right</td>
<td>Aligns the text to the right of the report.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Opens the Color dialog box, where you can select the background color for the report.</td>
</tr>
<tr>
<td>Data Style</td>
<td>Styles only the data for the selected data source field.</td>
</tr>
<tr>
<td>Title Style</td>
<td>Styles only the column title for the selected data source field.</td>
</tr>
<tr>
<td>Data + Title</td>
<td>Styles both the data and the column title for the selected data source field.</td>
</tr>
</tbody>
</table>

**Format Group**

<table>
<thead>
<tr>
<th>Format Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal</td>
<td>The default value for the data format of the selected measure is Decimal. Use the drop-down menu to select Alphanumeric, Integer, or More options to open the Field Format Options dialog box.</td>
</tr>
<tr>
<td>Change currency options</td>
<td>Changes the currency options for the selected field. This option is activated when you click on a measure.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Percent</td>
<td>Specifies the value of the field as a percentage. This option is activated</td>
</tr>
<tr>
<td></td>
<td>when you click on a measure.</td>
</tr>
<tr>
<td>Comma</td>
<td>Specifies the use of commas for the selected field. This option is activated</td>
</tr>
<tr>
<td></td>
<td>when you click on a measure.</td>
</tr>
<tr>
<td>Increase Decimal Places</td>
<td>Increases the number of decimal places that display for the selected field.</td>
</tr>
<tr>
<td></td>
<td>This option is activated when you click on a measure.</td>
</tr>
<tr>
<td>Decrease Decimal Places</td>
<td>Decreases the number of decimal places that display for the selected field.</td>
</tr>
<tr>
<td></td>
<td>This option is activated when you click on a measure.</td>
</tr>
<tr>
<td>Display Group</td>
<td></td>
</tr>
<tr>
<td>Hide Field</td>
<td>Allows you to hide a selected field.</td>
</tr>
<tr>
<td>Hide Missing</td>
<td>Allows you to hide fields that have no value.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Enables you to apply an aggregation function to a field in a report. Opens</td>
</tr>
<tr>
<td></td>
<td>a drop-down menu of the following options: None (default), Sum, Average,</td>
</tr>
<tr>
<td></td>
<td>Count, Count Distinct, Percent of Count, First Value, Last Value, Maximum,</td>
</tr>
<tr>
<td></td>
<td>Minimum, Total, Percent, Row Percent, Median, Average Square.</td>
</tr>
<tr>
<td>Traffic Lights</td>
<td>Opens the Traffic Light Condition dialog box. From this dialog box, you</td>
</tr>
<tr>
<td></td>
<td>can add new conditional styling by applying traffic light (and other) colors</td>
</tr>
<tr>
<td></td>
<td>to a selected field in the output when the field meets specified criteria,</td>
</tr>
<tr>
<td></td>
<td>modify existing conditional styling, and enable conditional drill-down.</td>
</tr>
<tr>
<td>Data Bars</td>
<td>Adds a data visualization column to the right of a selected numeric field.</td>
</tr>
<tr>
<td></td>
<td>The column displays values in each row using horizontal bars that extend</td>
</tr>
<tr>
<td></td>
<td>from left to right in varying lengths, depending on the corresponding data</td>
</tr>
<tr>
<td></td>
<td>values.</td>
</tr>
</tbody>
</table>
### Command Description

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within</td>
<td>Allows you to use specific aggregation tasks at different report levels. You can use the Within phrase to manipulate display field values as they are aggregated within a sort group rather than a report column.</td>
</tr>
<tr>
<td>Column(s)</td>
<td>This option is disabled for reports.</td>
</tr>
</tbody>
</table>

#### Links Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill Down</td>
<td>Opens the Drill Down dialog box, where you can configure a hyperlink or a drill-down procedure for the selected field. Clicking that field in the report output, at run time, redirects you to the URL you specified or executes the indicated procedure.</td>
</tr>
</tbody>
</table>

### Ribbon Commands for Charts

When creating and customizing charts in Chart mode, you can use the following ribbons and commands to customize chart functionality.

#### Home Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format Group</strong></td>
<td></td>
</tr>
<tr>
<td>Output File Format</td>
<td>Displays a drop-down menu of all supported output formats.</td>
</tr>
<tr>
<td>Chart</td>
<td>Indicates that you are in Chart mode.</td>
</tr>
<tr>
<td>Report</td>
<td>Switches to Report mode. Converts a chart to a report using the fields specified in the chart.</td>
</tr>
<tr>
<td>File</td>
<td>Creates an image file from a chart. This option is disabled by default and is only enabled for HTML format.</td>
</tr>
</tbody>
</table>

---

**Ribbon Command Reference**

218  Information Builders
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query (Design view)</td>
<td>Displays the Data, Query, and Filter panes across the entire canvas, eliminating Live Preview. This view provides a larger work area for creating the chart.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>Displays the chart on the canvas as you create the chart. You can use the Live Preview to add, remove, and arrange fields, as well as style the chart.</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Opens the document on canvas, which you can use to add text, images, lines, reports, and charts to create documents.</td>
</tr>
<tr>
<td>Data from Source</td>
<td>Uses the selected data source to display a live preview of the output on the canvas.</td>
</tr>
<tr>
<td>Use Sample Data</td>
<td>Displays sample data, which reduces processing time by eliminating the need to access the actual data source.</td>
</tr>
<tr>
<td>Records</td>
<td>Limits the number of rows retrieved from the data source when Live Preview is selected. This feature is useful in reducing response time if you are working with a large amount of data. Type the number of rows that you want directly in the Records field, or use the drop-down menu to select one of the preset record limits. The preset choices are All rows, 1, 10, 50, 100, 500, 1000, 2000, 5000, and 10000.</td>
</tr>
</tbody>
</table>

**Filter Group**

<table>
<thead>
<tr>
<th>Filter</th>
<th>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude</td>
<td>Turns off a filter.</td>
</tr>
<tr>
<td>Include</td>
<td>Turns on a filter.</td>
</tr>
</tbody>
</table>

**Report Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theme</td>
<td>Opens a dialog box where you can select a theme to style your report or chart. You can use the default style sheet by clicking the <em>Use Default Stylesheet</em> button. You can also select a document styling theme or an application theme to style all reports created. Use the Environment and Styling section of the Options window, which is accessible by clicking Options in the Application main menu.</td>
</tr>
<tr>
<td>Style</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Banded</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Header &amp; Footer</td>
<td>Opens the Header &amp; Footer dialog box, from which you can add and style headings and footings.</td>
</tr>
<tr>
<td>Column Totals</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Row Totals</td>
<td>This option is disabled for charts.</td>
</tr>
</tbody>
</table>

### Format Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Group</td>
<td></td>
</tr>
<tr>
<td>InfoMini</td>
<td>Enables the creation of an InfoMini application. For more information on using InfoMini, see <em>Building InfoMini Applications</em> on page 159.</td>
</tr>
<tr>
<td>Chart</td>
<td>Indicates that you are in Chart mode.</td>
</tr>
<tr>
<td>Report</td>
<td>Switches to Report mode. Converts a chart to a report using the fields specified in the chart.</td>
</tr>
<tr>
<td>File</td>
<td>Creates an image file from a chart. This option is disabled by default and is only enabled for HTML format.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Chart Types Group</strong></td>
<td></td>
</tr>
<tr>
<td>Bar</td>
<td>Changes the chart type to a bar chart.</td>
</tr>
<tr>
<td>Pie</td>
<td>Changes the chart type to a pie chart.</td>
</tr>
<tr>
<td>Line</td>
<td>Changes the chart type to a line chart.</td>
</tr>
<tr>
<td>Area</td>
<td>Changes the chart type to an area chart.</td>
</tr>
<tr>
<td>Scatter</td>
<td>Changes the chart type to a scatter chart.</td>
</tr>
<tr>
<td>Choropleth</td>
<td>Changes the chart type to a choropleth map.</td>
</tr>
<tr>
<td>Proportional Symbol</td>
<td>Changes the chart type to a proportional symbol (bubble) map.</td>
</tr>
<tr>
<td><strong>Other</strong></td>
<td>Opens the Select a chart dialog box. The chart types, depicted by icons, display on the left side of the dialog box. The first chart type represents the bar chart category, which is selected by default. When a chart type is selected, the dialog box displays thumbnail images of bar chart variations that are supported.</td>
</tr>
<tr>
<td><strong>Map Group</strong></td>
<td></td>
</tr>
<tr>
<td>Background</td>
<td>Provides terrain options and various other geographical views. This option only displays when a map is selected as the chart type.</td>
</tr>
<tr>
<td>Demographic Layers</td>
<td>Allows you to apply one or more pre-defined demographic layers, which can narrow the scope of your data using these underlying layers of demographic categorization. This option only displays when a map is selected as the chart type.</td>
</tr>
<tr>
<td>Reference Layers</td>
<td>Enables you to define one or more reference layers, which creates borders based on your geographical selection. This option only displays when a map is selected as the chart type.</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Features Group</strong></td>
<td></td>
</tr>
<tr>
<td>3D Effect</td>
<td>Sets the three-dimensional view to on or off. The 3D Effect feature is disabled for 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types. This is the default. This option is not available for maps.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Toggles between a vertical display or horizontal display of a chart. For more information, see Rotate a Chart. The Rotate feature is disabled for pie, scatter, 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types. This option is not available for maps.</td>
</tr>
<tr>
<td>Reference</td>
<td>Opens a drop-down menu that provides the Add Reference Line to Y-Axis and Add Reference Line to X-Axis options. Selecting one of these options opens the appropriate Reference Line dialog box, where you can set the specific X-axis or Y-axis value, type the text that you want, and position the reference line on a chart. For more information, see Display a Static Reference Line. The Reference feature is disabled for pie, 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types. This option is not available for maps.</td>
</tr>
<tr>
<td>Annotate</td>
<td>Opens a drop-down menu that provides the Add an annotation option. Selecting this option opens the Annotation dialog box, where you can type the text that you want and position the annotation on a chart. For more information, see Display Annotations. The annotation option is not available in HTML5. This option is not available for maps.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Grid</td>
<td>Opens a drop-down menu allowing you to expand options for Horizontal or Vertical Gridlines. Both selections allow you to enable or disable Major and Minor Gridlines. Clicking More Options opens the Format Grid Lines dialog box. This option is not available for maps. For more information, see Formatting Gridlines.</td>
</tr>
<tr>
<td>Frame &amp; Background</td>
<td>Opens the Frame &amp; Background dialog box where you can edit the background style and frames for charts. The dialog contains different options depending on the chart type selected. This option is not available for maps. For more information, see Formatting a Frame and a Background.</td>
</tr>
<tr>
<td>Narrative</td>
<td>Adds narration to your chart. This option must be enabled by an administrator.</td>
</tr>
<tr>
<td>Gauges</td>
<td>Opens the Gauge dialog box where you can edit your gauge chart. This button is only available when a gauge chart type is selected. This option is not available for maps. For more information, see Style a Gauge Needle.</td>
</tr>
<tr>
<td>active report Options</td>
<td>Opens the active report options dialog box where you can configure your active report options, such as menu items, graph engine, and colors. This button is available when the output type is set to active report. This option is not available for maps.</td>
</tr>
<tr>
<td>Accessibility</td>
<td>Allows a title to be added to a report, chart, or document that is Section 508 compliant. This option is only available for reports and charts when the output type is HTML or PDF. For documents, the output type must be set to PDF. The chart features are unavailable when designing a chart that will be output in active report format. This option is not available for maps.</td>
</tr>
</tbody>
</table>

**Labels Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axes</td>
<td>Opens a drop-down menu, where you can enable and rotate horizontal and vertical axis labels, and stagger horizontal axis labels. You can also edit the axis labels by clicking More Horizontal Axis Options or More Vertical Axis Options. For more information, see Format Axis Labels. This option is not available for maps.</td>
</tr>
<tr>
<td>Legend</td>
<td>Opens a drop-down menu, where you can select the Show Legend option to display the legend on the chart, or clear your selection to hide the legend, change the default legend position, and change the default legend orientation. For more information, see Format Legend Dialog Box. This option is not available for maps.</td>
</tr>
<tr>
<td><strong>Interactive Group</strong></td>
<td></td>
</tr>
<tr>
<td>Interactive Options</td>
<td>Opens the Interactive Options dialog box, which enables you to specify animation and mouse over effects in your chart. This option is only available for HTML5 and active outputs. This option is not available for maps.</td>
</tr>
<tr>
<td><strong>Auto Drill Group</strong></td>
<td></td>
</tr>
<tr>
<td>Auto Drill</td>
<td>Enables you to navigate through different levels within the dimension hierarchy of your data source. Click Auto Drill to enable the functionality. Note: Auto Drill functionality requires the specification of at least one dimension sort field in the request. For more information, see Using Auto Drill.</td>
</tr>
<tr>
<td><strong>Auto Linking Group</strong></td>
<td></td>
</tr>
<tr>
<td>Enable Auto Linking</td>
<td>Enables auto linking.</td>
</tr>
<tr>
<td>Auto Link Target</td>
<td>Sets procedure as an available target for auto linking.</td>
</tr>
</tbody>
</table>
## Data Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Calculation Group</strong></td>
<td></td>
</tr>
<tr>
<td>Detail (Define)</td>
<td>Opens the Detail Field (DEFINE) dialog box, where you can create a defined field, type a name for the field, and enter a format. A Define field is an optional attribute used to create a virtual field for reporting. You can derive the virtual field value from information already in the data source (that is, from permanent fields).</td>
</tr>
<tr>
<td>Summary (Compute)</td>
<td>Opens the Summary Field (COMPUTE) dialog box, where you can create a computed field, type a name for the field, and enter a format.</td>
</tr>
<tr>
<td><strong>Join Group</strong></td>
<td></td>
</tr>
<tr>
<td>Join</td>
<td>Opens the Join dialog box, where you can create a new join, edit or delete existing joins, and add data sources to a join.</td>
</tr>
<tr>
<td><strong>Filter Group</strong></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box, enabling you to set filtering options. Filter options include Where, Where Total, the And conjunction, and the Or conjunctions in a single expression.</td>
</tr>
<tr>
<td><strong>Display Group</strong></td>
<td></td>
</tr>
<tr>
<td>Missing Data</td>
<td>Includes options for how to display missing values in charts.</td>
</tr>
<tr>
<td><strong>Data Source Group</strong></td>
<td></td>
</tr>
<tr>
<td>Add</td>
<td>Opens the Open dialog box, where you can add additional data sources to a document, enabling you to insert reports from different data sources into the same document. This option is only enabled if the chart was created from a HOLD file.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Switch</td>
<td>Opens a drop-down list of all the data sources that have been added. You can choose which data source is currently active and being used to create new reports. This option is only enabled if the chart was created from a HOLD file.</td>
</tr>
</tbody>
</table>

**Slicers Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options Group</strong></td>
<td></td>
</tr>
<tr>
<td>New Group</td>
<td>Creates a new group of similar slicers.</td>
</tr>
<tr>
<td>Clear Slicers</td>
<td>Resets all slicers so that no filtering is done.</td>
</tr>
<tr>
<td>Update Preview</td>
<td>Applies slicers to preview.</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the Edit Slicers dialog box to the General tab, where you can set general options for your slicers.</td>
</tr>
<tr>
<td><strong>Record Limit Group</strong></td>
<td></td>
</tr>
<tr>
<td>Preview</td>
<td>Sets the number of records retrieved from the data source for preview.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Sets the number of records retrieved at run time.</td>
</tr>
<tr>
<td>Record Limit</td>
<td>Opens the Edit Slicers dialog box to the Record Limit tab, where you can set record limits for your slicers.</td>
</tr>
<tr>
<td><strong>Group Number Group</strong></td>
<td></td>
</tr>
<tr>
<td>Group n</td>
<td>Contains a group for each Slicer group that is added. Group 1 is the default slicer group to which you can drag fields to create slicers. To access slicer group options, click Group n to open the Edit Slicers dialog box where you can rename the slicer group and modify the order of the slicers in the group.</td>
</tr>
</tbody>
</table>
## Layout Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Setup Group</strong></td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td>Enables you to set margin values by choosing Normal (1 inch all around), Narrow (.5 inch all around), Moderate (.5 inch left or right), Wide (1.5 inch left or right), or Custom. Choosing Custom opens the Margins dialog box, where you can set specific margins as needed.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Enables you to set the orientation of your report to portrait or landscape.</td>
</tr>
<tr>
<td>Size</td>
<td>Enables you to select the size of the paper for printing output. You can choose A3, A4, A5, Letter, Tabloid, Legal, PowerPoint, or Large Size (34 x 44 Inches).</td>
</tr>
<tr>
<td>Units</td>
<td>Enables you to select the unit of measurement used for customizing the dimension fields of your report or chart. You can choose Inches, Centimeters, or Points.</td>
</tr>
<tr>
<td>Page Numbers</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td><strong>Size &amp; Arrange Group</strong></td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>Sets the height of the chart.</td>
</tr>
<tr>
<td>Width</td>
<td>Sets the width of the chart.</td>
</tr>
<tr>
<td>Auto Overflow</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Aspect Ratio</td>
<td>Lock the height and width aspect ratio. With the aspect ratio locked, changing the width automatically changes the height to keep the component to scale, and changing the height automatically changes the width.</td>
</tr>
<tr>
<td>AutoFit</td>
<td>Expands the chart, at design time, when additional fields are added. At run time, the chart is resized dynamically to fit into the container in which it is placed. AutoFit is enabled, by default.</td>
</tr>
</tbody>
</table>
### Command Reference

#### View Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Align</strong></td>
<td>This option is available in Document mode only.</td>
</tr>
<tr>
<td><strong>Relative Position</strong></td>
<td>This option is available in Document mode only.</td>
</tr>
</tbody>
</table>

#### Design Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Query (Design view)</strong></td>
<td>Displays the Data, Query, and Filter panes across the entire canvas, eliminating Live Preview. This view provides a larger work area for creating the chart.</td>
</tr>
<tr>
<td><strong>Live Preview (Design view)</strong></td>
<td>Displays the chart on the canvas as you create the report. You can use the Live Preview to add, remove, and arrange fields, as well as style the chart.</td>
</tr>
<tr>
<td><strong>Document (Design view)</strong></td>
<td>Converts a chart into a document. Opens the document on canvas, which you can use to add text, images, lines, reports, and charts to create documents.</td>
</tr>
</tbody>
</table>

#### Show/Hide Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Resources</strong></td>
<td>Minimizes the Resources panel and expands the size of the canvas to also occupy the area where the Resources panel typically appears. The canvas can display a preview of a report, output of a report, or the Query Design pane.</td>
</tr>
</tbody>
</table>

#### Data Panel Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Logical</strong></td>
<td>Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias.</td>
</tr>
</tbody>
</table>

---

228  Information Builders
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List</td>
<td>Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference.</td>
</tr>
<tr>
<td>Structured</td>
<td>Displays the hierarchical structure of the data source files. The Structured view options include Title, Description, Field, and Alias.</td>
</tr>
</tbody>
</table>

**Query Panel Group**

| Areas 2x2         | Displays data in a two column by two-row grid. This option is disabled for charts that use the new field container syntax. |
| Areas 1x4         | Displays data in a one column by four-row grid. This option is disabled for charts that use the new field container syntax. |
| Tree             | Displays data in a tree. This is the default. |

**Output Window Group**

| Arrange           | Opens a drop-down menu where you can choose how to display multiple output windows. The options are Cascade, Tile Horizontally, and Tile Vertically. |
| Output Location   | Opens a drop-down menu where you can choose how to direct new output. The options are Single tab (default), New Tab, Single Window, and New Window. |
| Switch Output     | Opens a drop-down menu for choosing to view any active output window. |

**Report Group**

| Switch Report     | Lists any active report or chart to which you can switch. |
Field Tab

**Note:** The Format group is disabled in Chart mode.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Removes, but does not delete, the filter from the chart.</td>
</tr>
<tr>
<td>Include</td>
<td>Restores a filter that was previously excluded from a chart.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Opens the Create a filtering condition dialog box for creating an auto prompting parameter that you can select when you run a chart. The Create a filtering condition dialog box is used to create both filters and auto prompting parameters. The following prompt options are available when Parameter is selected from the Type drop-down menu:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Simple.</strong> This is used for prompts using Text Input. This is the default value.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Static.</strong> This is used for prompts using Selection. This option allows you to select multiple values at run time.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Dynamic.</strong> This is used for prompts using Data Values. This option allows you to select multiple values at run time.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Optional.</strong> This is used for prompts using Single or Multiselect parameters.</td>
</tr>
<tr>
<td>Sort Group</td>
<td></td>
</tr>
<tr>
<td>Up</td>
<td>Sorts the selected field in ascending order.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Down</td>
<td>Sorts the selected field in descending order.</td>
</tr>
<tr>
<td>Rank</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Group</td>
<td>Opens the Create a Group dialog box where you can create a group to combine values together. This option is enabled for dimension fields only.</td>
</tr>
<tr>
<td>Limit</td>
<td>Opens a drop-down menu that allows you to specify the number of unique values to display for a sort group that has been added.</td>
</tr>
</tbody>
</table>

**Format Group**

*Note: These options are disabled for charts.*

**Display Group**

<p>| Hide Field | Allows you to hide a selected field. |
| Hide Missing | Allows you to hide fields that have no value. This option is disabled for charts. |
| Aggregation | Opens a drop-down menu of the following options: None (default), Sum, Average, Count, Count Distinct, Percent of Count, First Value, Last Value, Maximum, Minimum, Total, Percent, Row Percent, Median, Average Square. This option is only available for measure fields or dimensions (alpha field only) that are in a numeric field container. Otherwise, aggregations will not display. |
| Traffic Lights | Opens the Traffic Light Condition dialog box. From this dialog box, you can add new conditional styling by applying traffic light (and other) colors to a selected field in the output when the field meets specified criteria, modify existing conditional styling, and enable conditional drill-down. This option is only available for measure fields. |
| Data Bars | This option is disabled for charts. |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within</td>
<td>Allows you to use specific aggregation tasks at different report levels. You can use the Within phrase to manipulate display field values as they are aggregated within a sort group rather than a report column. This option is disabled for charts.</td>
</tr>
<tr>
<td>Column(s)</td>
<td>Allows you to indicate the number of columns in which you wish to display multiple graphs. The value can be between 1 and 512. The default is 1. This option is also available from the Query Design pane shortcut menu for a Multi-graph component. This option is only enabled when the multi-graph field container is populated.</td>
</tr>
</tbody>
</table>

**Links Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill Down</td>
<td>Opens the Drill Down dialog box, where you can configure a hyperlink or a drill-down procedure for the selected field. Clicking that field in the report output, at run time, redirects you to the URL you specified or executes the indicated procedure. This option is available for measure fields only. If you are working in PDF format, this option is disabled.</td>
</tr>
</tbody>
</table>

**Series Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Group</td>
<td></td>
</tr>
<tr>
<td>Series drop-down list</td>
<td>Lists the available series in the current chart.</td>
</tr>
<tr>
<td>Style Group</td>
<td></td>
</tr>
<tr>
<td>Style</td>
<td>Opens the Format Series dialog box, where you can edit the styling options for the selected series. You can also open this dialog box by right-clicking a series, and then clicking More Style Options.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Properties Group</strong></td>
<td></td>
</tr>
<tr>
<td>Data Labels</td>
<td>Adds data labels to the chart. The drop-down menu contains the following data position options for selecting where to display data values as labels on a chart: Above (default), On top edge, Below top edge, Center, and Base. If you are working with a Pie chart, the options are: On Slice, Outside Slice, and Outside with feeler lines. Clicking <em>More Data Label Options</em> opens the Format Labels dialog box, where you can further edit your data labels.</td>
</tr>
</tbody>
</table>
| Type | Opens a drop-down menu with the following options for selecting different chart types: None (default), Bar, Line, and Area.  
**Note:** When you make a change to the chart type using the Type button on the Series tab, changes to the chart type on the Format tab are overwritten. |
| Trendline | Opens a drop-down menu that provides options for adding a trendline to a chart. |
| Equation | Displays the associated mathematical equation for the selected trendline on the chart.  
The equation is not available in HTML5. |
<p>| <strong>Line Group</strong> | |
| Smooth Line | Draws the chart using smooth lines. |
| Connect Lines | Controls the display of connecting lines between markers on a line or scatter chart. By default, lines are connected on a line chart and disconnected on a scatter chart. |
| Marker | Opens a drop-down menu from which you can select options to change the display of the default data and legend markers on line and scatter chart types. For more information, see <em>Change the Appearance of a Marker</em>. |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pie Group</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The following options are only enabled when you are working with a pie chart.</td>
<td></td>
</tr>
<tr>
<td>Expand</td>
<td>Expands pie slices.</td>
</tr>
<tr>
<td>Hide</td>
<td>Hides pie slices.</td>
</tr>
</tbody>
</table>

**Ribbon Commands for Documents**

When creating and customizing documents in Document mode, you can use the following ribbons and commands to customize document functionality.

**Home Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format Group</strong></td>
<td></td>
</tr>
<tr>
<td>Output File Format</td>
<td>Displays a drop-down menu of all supported output formats.</td>
</tr>
<tr>
<td>Chart</td>
<td>Determines whether chart-specific functionality is available in the InfoAssist+ tool. The default name Chart (data source) is given for each new chart created in a given InfoAssist+ session, where data source is the name of the underlying data source you are using. You can rename the chart by right-clicking Chart in the Query pane and clicking Rename.</td>
</tr>
<tr>
<td>Report</td>
<td>Determines whether report-specific functionality is available in the InfoAssist+ tool. The default name Report (data source) is given for each new report created in a given InfoAssist+ session, where data source is the name of the underlying data source you are using. You can rename the report by right-clicking Report in the Query pane and clicking Rename.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>File</td>
<td>Creates a data file from a report component of a document.</td>
</tr>
</tbody>
</table>

**Design Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query (Design view)</td>
<td>This option is disabled in Document mode.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>This option is disabled in Document mode.</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Once you are in Document mode, it is selected by default in the Design group. The document displays on the canvas, to which you can add text, images, lines, reports, and charts.</td>
</tr>
<tr>
<td>Data from Source</td>
<td>Uses the selected data source to display a live preview of the output on the canvas.</td>
</tr>
<tr>
<td>Use Sample Data</td>
<td>Displays sample data, which reduces processing time by eliminating the need to access the actual data source.</td>
</tr>
<tr>
<td>Records</td>
<td>Limits the number of rows retrieved from the data source when Live Preview is selected. This feature is useful in reducing response time if you are working with a large amount of data. Type the number of rows that you want directly in the Records field, or use the drop-down menu to select one of the preset record limits. The preset choices are All rows, 1, 10, 50, 100, 500, 1000, 2000, 5000, and 10000.</td>
</tr>
</tbody>
</table>

**Filter Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Turns off a filter.</td>
</tr>
<tr>
<td>Include</td>
<td>Turns on a filter.</td>
</tr>
</tbody>
</table>

**Clipboard Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste</td>
<td>Enables you to paste a text, report, or chart object that you have copied to or placed on the clipboard.</td>
</tr>
<tr>
<td>Cut</td>
<td>Enables you to cut a text, report, or chart object from your document, placing it on the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Enables you to copy a text, report, or chart object to the clipboard.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Enables you to duplicate a text, report, or chart object in your document, placing it on the clipboard.</td>
</tr>
</tbody>
</table>

### Report Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theme</td>
<td>Opens a dialog box where you can select a theme to style your report or chart. You can use the default style sheet by clicking the <em>Use Default Stylesheet</em> button. You can also select a document styling theme or an application theme to style all reports created. Use the Environment and Styling section of the Options window, which is accessible by clicking <em>Options</em> in the Application main menu.</td>
</tr>
<tr>
<td>Style</td>
<td>Opens a Report Style dialog box for applying global styling to the entire report. This option is disabled for charts in Document mode. For more information about styling reports, see <em>Styling Reports</em>.</td>
</tr>
<tr>
<td>Banded</td>
<td>Opens a Color dialog box for choosing a color that provides an alternating color scheme for the report. The report output displays alternating rows of data, using a white background for one row and a background of the selected color for the next row. This pattern continues throughout the report. This option is disabled for charts in Document mode.</td>
</tr>
<tr>
<td>Header &amp; Footer</td>
<td>Opens the Header &amp; Footer dialog box, from which you can add and style headings and footings.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Column Totals</td>
<td>Adds a grand total row to the bottom of the report to sum numeric data in each column. This option is disabled for charts in Document mode.</td>
</tr>
<tr>
<td>Row Totals</td>
<td>Adds a grand total column to the right side of the report to sum numeric data in each row. This option is disabled for charts in Document mode.</td>
</tr>
</tbody>
</table>

**Insert Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pages Group</td>
<td></td>
</tr>
<tr>
<td>Page</td>
<td>Adds a new page to a document.</td>
</tr>
<tr>
<td>Reports Group</td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td>Inserts a report placeholder on the canvas.</td>
</tr>
<tr>
<td>Chart</td>
<td>Inserts a chart placeholder on the canvas.</td>
</tr>
<tr>
<td>Existing Report</td>
<td>Opens the Open dialog box, where you can browse to the report that you want to insert in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Objects Group</td>
<td></td>
</tr>
<tr>
<td>Text Box</td>
<td>Inserts an inline text object in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Image</td>
<td>Opens the Open dialog box, where you can browse to the image that you want to insert in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>active dashboard Prompts group</td>
<td></td>
</tr>
<tr>
<td>Drop Down</td>
<td>Inserts a drop-down control placeholder in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>List</td>
<td>Inserts a list control placeholder in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Checkbox</td>
<td>Inserts a check box control placeholder in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Radio Button</td>
<td>Inserts a radio button control placeholder in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Text</td>
<td>Inserts a text area control placeholder in the upper-left corner of the canvas.</td>
</tr>
</tbody>
</table>

**Format Tab**

<table>
<thead>
<tr>
<th>Command Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Group</td>
<td></td>
</tr>
<tr>
<td>InfoMini</td>
<td>Enables the creation of an InfoMini application. For more information on using InfoMini, see <em>Building InfoMini Applications</em> on page 159.</td>
</tr>
<tr>
<td>Report</td>
<td>Makes report-specific functionality available. In Document mode, if you select a report object, the Report option is enabled on the Home tab and the ribbon options change. For more information, see <em>Ribbon Commands for Reports</em> on page 204.</td>
</tr>
<tr>
<td>Chart</td>
<td>Makes chart-specific functionality available. In Document mode, if you select a chart object, the Chart option is enabled on the Home tab and the ribbon options change. For more information, see <em>Ribbon Commands for Charts</em> on page 218.</td>
</tr>
<tr>
<td>File</td>
<td>Creates a data file from a report component of a document.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table</td>
<td>Generates standard browser output. This is the default. This option is only available for reports in Document mode.</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>Generates output by displaying a table of contents icon in the upper-left corner where report output typically appears. Clicking Table of Contents opens a menu that enables you to select (view) individual values of the first Sort By (By) field, one value at a time. You can also select options to view the entire report or remove the table of contents. This option is unavailable for charts in Document mode, and is disabled for reports in Document mode.</td>
</tr>
<tr>
<td>Freeze</td>
<td>Generates output with column titles that freeze (remain in view) when you scroll through pages of the report output. This option is unavailable for charts in Document mode, and is disabled for reports in Document mode.</td>
</tr>
<tr>
<td>Pages On Demand</td>
<td>Provides access to two distinct features depending upon the output type that you have selected. This option is available for reports in Document mode.</td>
</tr>
</tbody>
</table>

**Features Group**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Popup</td>
<td>Displays pop-up titles when the mouse pointer hovers over a column title in the report output.</td>
</tr>
<tr>
<td>Accordion</td>
<td>Creates expandable views of data for each vertical sort field. This option displays data values only for the first vertical sort field when you first view the output. You can manually expand your view to expose the data values of lower-level sort fields.</td>
</tr>
<tr>
<td>Repeat Sort Value</td>
<td>Displays all repeated sort values instead of blanks in the output after the first instance of a new sort value, which is the default behavior.</td>
</tr>
</tbody>
</table>
### Command Reference

#### Stack Measures
Displays all numeric measure field names in a column of the report output with the corresponding numeric data values.

#### active report Options
Opens the active report options dialog box where you can configure your active report options such as menu items, graph engine, and colors. For more information, see *Using Active Technologies* on page 94.

#### Accessibility
Allows a title to be added to a report, chart, or document that is Section 508-compliant.

#### Auto Drill Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Drill</td>
<td>This option is disabled in Document mode.</td>
</tr>
</tbody>
</table>

#### Data Tab

#### Calculation Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail (Define)</td>
<td>Opens the Detail Field (DEFINE) dialog box, where you can create a defined field, type a name for the field, and enter a format. A Define field is an optional attribute used to create a virtual field for reporting. You can derive the virtual field value from information already in the data source (that is, from permanent fields).</td>
</tr>
<tr>
<td>Summary (Compute)</td>
<td>Opens the Summary Field (COMPUTE) dialog box, where you can create a computed field, type a name for the field, and enter a format.</td>
</tr>
</tbody>
</table>

#### Join Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join</td>
<td>Opens the Join dialog box, where you can create a new join, edit or delete existing joins, and add data sources to a join.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Filter Group</strong></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box, enabling you to set filtering options. Filter options include Where, Where Total, the And conjunction, and the Or conjunctions in a single expression.</td>
</tr>
<tr>
<td><strong>Display Group</strong></td>
<td></td>
</tr>
<tr>
<td>Missing Data</td>
<td>Includes options for how to display missing values in charts.</td>
</tr>
<tr>
<td><strong>Data Source Group</strong></td>
<td></td>
</tr>
<tr>
<td>Add</td>
<td>Opens the Open dialog box, where you can add additional data sources to a document, enabling you to insert reports from different data sources into the same document.</td>
</tr>
<tr>
<td>Switch</td>
<td>Opens a drop-down list of all the data sources that have been added. You can choose which data source is currently active and being used to create new reports.</td>
</tr>
</tbody>
</table>

**Slicers Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options Group</strong></td>
<td></td>
</tr>
<tr>
<td>New Group</td>
<td>Creates a new group of similar slicers.</td>
</tr>
<tr>
<td>Clear Slicers</td>
<td>Resets all slicers so that no filtering is done.</td>
</tr>
<tr>
<td>Update Preview</td>
<td>Applies slicers to preview.</td>
</tr>
<tr>
<td><strong>Record Limit Group</strong></td>
<td></td>
</tr>
<tr>
<td>Preview</td>
<td>Sets the number of records retrieved from the data source for preview.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Run Time</td>
<td>Sets the number of records retrieved at run time.</td>
</tr>
<tr>
<td><strong>Group Number Group</strong></td>
<td></td>
</tr>
<tr>
<td>Group ( n )</td>
<td>Contains a group for each Slicer group that is added. Group 1 is the default slicer group to which you can drag fields to create slicers.</td>
</tr>
</tbody>
</table>

## Layout Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Setup Group</strong></td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td>This option is disabled in Document mode.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Enables you to set the orientation of your report to portrait or landscape.</td>
</tr>
<tr>
<td>Size</td>
<td>Enables you to select the size of the paper for printing output. You can choose A3, A4, A5, Letter, Tabloid, Legal, PowerPoint, or Large Size (34 x 44 Inches).</td>
</tr>
<tr>
<td>Units</td>
<td>Enables you to select the unit of measurement used for customizing the dimension fields of your report or chart. You can choose Inches, Centimeters, or Points.</td>
</tr>
<tr>
<td>Page Numbers</td>
<td>Enables you to select page numbering options. You can choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>□ No Lead (no space for headers)</td>
</tr>
<tr>
<td></td>
<td>□ On (page numbers only in headers)</td>
</tr>
<tr>
<td></td>
<td>□ Off (space for headers, but no page numbering)</td>
</tr>
<tr>
<td></td>
<td>The Page Numbers value is overridden by header and footer text options.</td>
</tr>
<tr>
<td><strong>Size &amp; Arrange Group</strong></td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Height</td>
<td>Sets the height of the selected document component.</td>
</tr>
<tr>
<td>Width</td>
<td>Sets the width of the selected document component.</td>
</tr>
<tr>
<td>Auto Overflow</td>
<td>Automatically expands the query area to show all data.</td>
</tr>
<tr>
<td>Aspect Ratio</td>
<td>Lock the height and width aspect ratio.</td>
</tr>
<tr>
<td>AutoFit</td>
<td>In Document mode, this option is disabled.</td>
</tr>
<tr>
<td>Align</td>
<td>Opens a drop-down menu of available alignment options, when two or more document components are selected.</td>
</tr>
<tr>
<td>Relative Position</td>
<td>Positions the top-left corner of the lower component, to the bottom-left corner of the higher component, when two or more document components are selected.</td>
</tr>
<tr>
<td>Size and Arrange</td>
<td>Opens the Size and Position dialog box where you can set size and position options for the object in your document.</td>
</tr>
</tbody>
</table>

**Report Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell Padding</td>
<td>Opens the Cell Padding dialog box, where you can set specific values to control the amount of space inserted between rows and columns in a report. For more information, see Use Cell Padding in a Report.</td>
</tr>
<tr>
<td>Autofit Column</td>
<td>When working with a report component, this option automatically compresses the columns in the report to the width of the widest data instance. Autofit Column is selected, by default.</td>
</tr>
</tbody>
</table>

**View Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Group</td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Query (Design view)</td>
<td>This option is unavailable in Document mode.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>This option is unavailable in Document mode.</td>
</tr>
<tr>
<td>Document</td>
<td>Enables Document mode by default.</td>
</tr>
</tbody>
</table>

**Show/Hide Group**

| Resources                     | Minimizes the Resources panel and expands the size of the canvas to also occupy the area where the Resources panel typically appears. The canvas can display a preview of a report, output of a report, or the Query Design pane. |
| Ruler                         | Displays a ruler above the canvas and to the left of the canvas for a document. |
| Grid                          | Displays a grid as a visual aid for aligning objects in a document.          |
| Relationships                 | Shows the relative positioning relationship among objects.                   |

**Data Panel Group**

| Logical                       | Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias. |
| List                          | Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference. |
| Structured                    | Displays the hierarchical structure of the data source files. The Structured view options include Title, Description, Field, and Alias. |

**Query Panel Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Areas 2x2</td>
<td>Displays data in a two column by two-row grid. When working with the new field container syntax, this option is unavailable.</td>
</tr>
<tr>
<td>Areas 1x4</td>
<td>Displays data in a one column by four-row grid. When working with the new field container syntax, this option is unavailable.</td>
</tr>
<tr>
<td>Tree</td>
<td>Displays data in a tree. This is the default.</td>
</tr>
</tbody>
</table>

**Output Window Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrange</td>
<td>Opens a drop-down menu where you can choose how to display multiple output windows. The options are Cascade, Tile Horizontally, and Tile Vertically.</td>
</tr>
<tr>
<td>Output Location</td>
<td>Opens a drop-down menu where you can choose how to direct new output. The options are Single tab (default), New Tab, Single Window, and New Window.</td>
</tr>
<tr>
<td>Switch Output</td>
<td>Opens a drop-down menu for choosing to view any active output window.</td>
</tr>
</tbody>
</table>

**Report Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch Report</td>
<td>Lists any active report or chart to which you can switch.</td>
</tr>
</tbody>
</table>

**Field Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Group</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Removes, but does not delete, the filter from the report or chart.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Include</td>
<td>Restores a filter that was previously excluded from a report or chart.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Opens the Create a filtering condition dialog box for creating an auto prompting parameter that you can select when you run a report. The Create a filtering condition dialog box is used to create both filters and auto prompting parameters. The following prompt options are available when Parameter is selected from the Type drop-down menu:</td>
</tr>
<tr>
<td>Simple</td>
<td>This is used for prompts using Text Input. This is the default value.</td>
</tr>
<tr>
<td>Static</td>
<td>This is used for prompts using Selection. This option allows you to select multiple values at run time.</td>
</tr>
<tr>
<td>Dynamic</td>
<td>This is used for prompts using Data Values. This option allows you to select multiple values at run time.</td>
</tr>
<tr>
<td>Optional</td>
<td>This is used for prompts using Single or Multiselect parameters.</td>
</tr>
<tr>
<td>Sort Group</td>
<td></td>
</tr>
<tr>
<td>Up</td>
<td>Sorts the selected field in ascending order.</td>
</tr>
<tr>
<td>Down</td>
<td>Sorts the selected field in descending order.</td>
</tr>
<tr>
<td>Rank</td>
<td>Inserts a rank column immediately to the left of the report if a Sort By field is selected. It also adds a rank column to the left of the Sort By field if a Measure field is selected. Ranking a Measure field results in two copies of the field, the original Measure field, and the Sort By field that is created during ranking.</td>
</tr>
<tr>
<td>Group</td>
<td>Opens the Create a Group dialog box where you can create a group to combine values together.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Limit</td>
<td>Opens a drop-down menu that allows you to specify the number of unique values to display for a sort group that has been added.</td>
</tr>
</tbody>
</table>

**Break Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Break</td>
<td>Starts a new page when the primary sort field changes. Clicking the drop-down icon enables you to select Reset Page Numbers, which allows you to reset page numbers on a page break to start at 1.</td>
</tr>
<tr>
<td>Line Break</td>
<td>Inserts a line in the report output when the primary sort field changes.</td>
</tr>
<tr>
<td>Subtotal</td>
<td>Inserts a line, total text (TOTAL FIELD Value), and subtotals for all numeric fields when the primary sort field changes.</td>
</tr>
<tr>
<td>Sub Header</td>
<td>Opens a dialog box where you can type text to add a subheading just below the column titles in the report output when the primary sort field changes.</td>
</tr>
<tr>
<td>Sub Footer</td>
<td>Opens a dialog box where you can type text to add a subfooting at the end of the data on each page of the report output when the primary sort field changes.</td>
</tr>
</tbody>
</table>

**Style Group**

**Note:** The options in this group are only available for reports in Document mode.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Opens the Font list, which you can use to change the font.</td>
</tr>
<tr>
<td>Font Size</td>
<td>Opens the Font Size list, which you can use to change the numeric value for the font size.</td>
</tr>
<tr>
<td>Font Color</td>
<td>Opens the Color dialog box, where you can select the font color.</td>
</tr>
<tr>
<td>Style Reset</td>
<td>Resets all settings to the default settings from the template.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bold</td>
<td>Applies bold font formatting to the selected text.</td>
</tr>
<tr>
<td>Italic</td>
<td>Applies italic font formatting to the selected text.</td>
</tr>
<tr>
<td>Underline</td>
<td>Underlines the selected text.</td>
</tr>
<tr>
<td>Justify Left</td>
<td>Aligns the text to the left of the visual.</td>
</tr>
<tr>
<td>Justify Center</td>
<td>Aligns the text to the center of the visual.</td>
</tr>
<tr>
<td>Justify Right</td>
<td>Aligns the text to the right of the visual.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Opens the Color dialog box, where you can select the background color for the visual.</td>
</tr>
<tr>
<td>Data Style</td>
<td>Styles only the data for the selected data source field.</td>
</tr>
<tr>
<td>Title Style</td>
<td>Styles only the column title for the selected data source field.</td>
</tr>
<tr>
<td>Data + Title</td>
<td>Styles both the data and the column title for the selected data source field.</td>
</tr>
</tbody>
</table>

**Format Group**

*Note:* The options in this group are only available for reports in Document mode.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change currency options</td>
<td>Changes the currency options for the selected field.</td>
</tr>
<tr>
<td>Percent</td>
<td>Specifies the value of the field as a percentage.</td>
</tr>
<tr>
<td>Comma</td>
<td>Specifies the use of commas for the selected field.</td>
</tr>
<tr>
<td>Increase Decimal Places</td>
<td>Increases the number of decimal places that display for the selected field.</td>
</tr>
<tr>
<td>Decrease Decimal Places</td>
<td>Decreases the number of decimal places that display for the selected field.</td>
</tr>
</tbody>
</table>

**Display Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Field</td>
<td>Allows you to hide a selected field.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hide Missing</td>
<td>Allows you to hide fields that have no value.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Opens a drop-down menu of the following options: None (default), Sum, Average, Count, Count Distinct, Percent of Count, First Value, Last Value, Maximum, Minimum, Total, Percent, Row Percent, Median, Average Square.</td>
</tr>
<tr>
<td>Traffic Lights</td>
<td>Opens the Traffic Light Condition dialog box. From this dialog box, you can add new conditional styling by applying traffic light (and other) colors to a selected field in the output when the field meets specified criteria, modify existing conditional styling, and enable conditional drill-down.</td>
</tr>
<tr>
<td>Within</td>
<td>Allows you to use specific aggregation tasks at different report levels. You can use the Within phrase to manipulate display field values as they are aggregated within a sort group rather than a report column.</td>
</tr>
<tr>
<td>Data Bars</td>
<td>Adds a data visualization column to the right of a selected numeric field. The column displays values in each row using horizontal bars that extend from left to right in varying lengths, depending on the corresponding data values.</td>
</tr>
<tr>
<td>Column(s)</td>
<td>Allows you to indicate the number of columns in which you wish to display multiple graphs. The value can be between 1 and 512. The default is 1. This option is also available from the Query Design pane shortcut menu for a Multi-graph component.</td>
</tr>
</tbody>
</table>

**Links Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill Down</td>
<td>Opens the Drill Down dialog box, where you can configure a hyperlink or a drill-down procedure for the selected field. Clicking that field in the report output, at run time, redirects you to the URL you specified or executes the indicated procedure. This option is disabled in Document mode.</td>
</tr>
</tbody>
</table>

**Series Tab**

In Document mode, the Series tab is enabled for chart components.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select Group</strong></td>
<td></td>
</tr>
<tr>
<td>Series drop-down list</td>
<td>Lists the available series in the current chart.</td>
</tr>
<tr>
<td><strong>Style Group</strong></td>
<td></td>
</tr>
<tr>
<td>Style</td>
<td>Opens the Format Series dialog box, where you can edit the styling options for the selected series. You can also open this dialog box by right-clicking a series, and then clicking More Style Options.</td>
</tr>
<tr>
<td><strong>Properties Group</strong></td>
<td></td>
</tr>
<tr>
<td>Data Labels</td>
<td>Adds data labels to the chart. The drop-down menu contains the following data position options for selecting where to display data values as labels on a chart: Above (default), On top edge, Below top edge, Center, and Base. If you are working with a Pie chart, the options are: On Slice, Outside Slice, and Outside with feeler lines. Clicking More Data Label Options opens the Format Labels dialog box, where you can further edit your data labels.</td>
</tr>
<tr>
<td>Trendline</td>
<td>Opens a drop-down menu that provides options for adding a trendline to a chart.</td>
</tr>
</tbody>
</table>
Ribbon Commands for Visualizations

When creating and customizing visualizations in Visualizations mode, you can use the following ribbons and commands to customize visualization functionality.

Home Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Clipboard Group</strong></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Enables you to paste a text, report, or chart object that you have copied to or placed on the clipboard.</td>
</tr>
<tr>
<td>Cut</td>
<td>Enables you to cut a text, report, or chart object from your document, placing it on the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Enables you to copy a text, report, or chart object to the clipboard.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Enables you to duplicate a text, report, or chart object in your document, placing it on the clipboard.</td>
</tr>
<tr>
<td><strong>Data Group</strong></td>
<td></td>
</tr>
<tr>
<td>Calculation</td>
<td>Opens a menu from which you can choose to create Define or Compute fields.</td>
</tr>
<tr>
<td>Join</td>
<td>Opens the Join dialog box, where you can create a new join, edit or delete existing joins, and add data sources to a join. You can also create blends, which allow you to combine data from local or system resources into your current data source.</td>
</tr>
<tr>
<td><strong>Visual Group</strong></td>
<td></td>
</tr>
<tr>
<td>Insert</td>
<td>Inserts a new visual. The left side of the Insert button inserts the default visual, which is a stacked bar chart. Click the down arrow next to the Insert button to specify a visual type, such as a chart, grid, or text.</td>
</tr>
<tr>
<td>Change</td>
<td>Opens the Select a Visual menu, from which you can select the type of chart, map, or grid that you want to add to your visualization.</td>
</tr>
</tbody>
</table>
| Swap      | Changes the vertical or horizontal orientation of data in a visual. When you add one or more fields to the canvas, Swap is enabled. When you have data fields in the vertical and horizontal field containers, clicking Swap switches the axis of these data fields to display on the opposite axis. When working with matrix charts, the rows and columns are similarly switched when you click Swap. Swap is available for bar, line, area, scatter, bubble, and matrix marker charts. It is also available for grids. **Note:**  
  - Swap is disabled when the canvas is empty.  
  - Swap is unavailable for maps. |
### Command | Description
--- | ---
**Clear** | Clears the current visual. You can use the split button to select the option to clear a component, or the entire visualization, which clears all visuals on the canvas. If you have created a filter, you can also clear it. The Clear button is disabled until you begin developing a visual on the canvas.

### Storyboard Group

| Command | Description |
--- | --- |
**Add** | Takes a snapshot of the current visual or visualization, adding it to the storyboard. |

| Command | Description |
--- | --- |
**Show** | Opens your storyboard as a PowerPoint presentation, where you can choose to view or save your storyboard. All storyboards display in Microsoft PowerPoint format. |

### Format Tab

| Command | Description |
--- | --- |
**Report Group**

| Command | Description |
--- | --- |
**Theme** | Opens the Templates dialog box, where you can select a theme to style your grid. You can use the default style sheet by clicking the *Use Default Stylesheet* button. You can also select a styling theme for your grid or an application theme to style all visualizations created. |

| Command | Description |
--- | --- |
**Header & Footer** | Opens the Header & Footer dialog box, from which you can add and style headings and footings. |

| Command | Description |
--- | --- |
**Column Totals** | Adds a grand total row to the bottom of the grid object to sum numeric data in each column. |

### Features Group

**Note:** These options do not display for grids or maps.
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference</td>
<td>Opens the reference menu, where you can access the Add Reference Line to Y-Axis and Add Reference Line to X-Axis options. Selecting one of these options opens the Reference Line dialog box, where you can set the following: the X-axis or Y-axis value, the text that you want to appear, and the position of the reference line on a chart.</td>
</tr>
<tr>
<td>Grid</td>
<td>Opens the grid menu, where you can access the Horizontal or Vertical Gridlines options. Both selections allow you to enable or disable Major and Minor Gridlines. Clicking More Grid Lines Options opens the Format Grid Lines dialog box.</td>
</tr>
<tr>
<td>Frame &amp; Background</td>
<td>Opens the Frame &amp; Background dialog box, where you can edit the background style and frames for charts. This dialog box contains different options depending on the chart type that you have selected.</td>
</tr>
<tr>
<td>Narrative</td>
<td>Adds narration to your visual. This option must be enabled by an administrator.</td>
</tr>
</tbody>
</table>

**Labels Group**

*Note: These options do not display for grids or maps.*

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axes</td>
<td>Opens the Axes menu, where you can enable and rotate horizontal and vertical axis labels, as well as stagger horizontal axis labels. You can also edit the axis labels by clicking More Vertical Axis Options or More Horizontal Axis Options.</td>
</tr>
<tr>
<td>Legend</td>
<td>Opens the Legend menu, where you can select the Show Legend option to display the legend on the chart. You can also clear your selection to hide the legend. In addition, you can change the default legend position and orientation.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Interactive Group</strong></td>
<td><strong>Note:</strong> These options do not display for grids or maps.</td>
</tr>
<tr>
<td>Interactive Options</td>
<td>Opens the Interactive Options dialog box, which enables you to specify animation and mouse over effects in your chart.</td>
</tr>
<tr>
<td><strong>View Tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Show/Hide Group</strong></td>
<td></td>
</tr>
<tr>
<td>Resources</td>
<td>Minimizes the Resources panel, expanding the size of the canvas to occupy the area where the Resources panel typically appears. When you click the Resources button again, the Resources panel displays and the chart, map, or grid adjusts accordingly.</td>
</tr>
<tr>
<td><strong>Data Panel Group</strong></td>
<td></td>
</tr>
<tr>
<td>Logical</td>
<td>Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td>List</td>
<td>Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference.</td>
</tr>
<tr>
<td>Structured</td>
<td>Displays the hierarchical structure of the data source files. The Structured view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td><strong>Report Group</strong></td>
<td></td>
</tr>
<tr>
<td>Switch Report</td>
<td>Lists any active report or chart to which you can switch.</td>
</tr>
</tbody>
</table>
### Field Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Filter Group</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Options on the Field tab are contingent on the visual type that you select.</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Select an existing filter in the Filter pane and choose <em>Exclude</em> to remove, but not delete, the filter from the visual.</td>
</tr>
<tr>
<td>Include</td>
<td>Select an existing filter in the Filter pane and choose <em>Include</em> to restore the filter, which was previously excluded from the visual.</td>
</tr>
<tr>
<td><strong>Sort Group</strong></td>
<td></td>
</tr>
<tr>
<td>Up</td>
<td>Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td>Down</td>
<td>Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference.</td>
</tr>
<tr>
<td>Group</td>
<td>Opens the Create a Group dialog box where you can create a group to combine values together. For grids, this option is activated when you select a dimension.</td>
</tr>
<tr>
<td><strong>Display Group</strong></td>
<td></td>
</tr>
<tr>
<td>Hide Field</td>
<td>Hides a selected field.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Specifies an aggregation for a specific field. Commonly used options include: Sum, Average, Count, Minimum, and Maximum.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Traffic Lights</td>
<td>Specifies conditional styling to the selected field.</td>
</tr>
</tbody>
</table>

**Series Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Group</td>
<td>Note: This group is not available for grids. For maps, this group is disabled.</td>
</tr>
<tr>
<td>Series drop-down list</td>
<td>Lists the available series in the current visualization.</td>
</tr>
</tbody>
</table>

**Style Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>Opens the Format Series dialog box, where you can edit the styling options for the selected series. You can also open this dialog box by right-clicking a series, and then clicking More Style Options.</td>
</tr>
</tbody>
</table>

**Properties Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Labels</td>
<td>Adds data labels to the chart. The drop-down menu contains the following data position options for selecting where to display data values as labels on a chart: Above (default), On top edge, Below top edge, Center, and Base. If you are working with a Pie chart, the options are: On Slice, Outside Slice, and Outside with feeler lines.</td>
</tr>
<tr>
<td>Trendline</td>
<td>Opens a drop-down menu that provides options for adding a trendline to a chart.</td>
</tr>
</tbody>
</table>

**Line Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smooth Line</td>
<td>Draws the chart using smooth lines.</td>
</tr>
<tr>
<td>Connect Lines</td>
<td>Controls the display of connecting lines between markers on a line or scatter chart. By default, lines are connected on a line chart and disconnected on a scatter chart.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Marker</td>
<td>Opens a drop-down menu from which you can select options to change the display of the default data and legend markers on line and scatter chart types. For more information, see <em>Change the Appearance of a Marker</em>.</td>
</tr>
</tbody>
</table>

### Pie Group

**Note:** The following options are only enabled when you are working with a pie chart.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand</td>
<td>Expands pie slices.</td>
</tr>
<tr>
<td>Hide</td>
<td>Hides pie slices.</td>
</tr>
</tbody>
</table>
Feedback

Customer success is our top priority. Connect with us today!

Information Builders Technical Content Management team is comprised of many talented individuals who work together to design and deliver quality technical documentation products. Your feedback supports our ongoing efforts!

You can also preview new innovations to get an early look at new content products and services. Your participation helps us create great experiences for every customer.

To send us feedback or make a connection, contact Sarah Buccellato, Technical Editor, Technical Content Management at Sarah_Buccellato@ibi.com.

To request permission to repurpose copyrighted material, please contact Frances Gambino, Vice President, Technical Content Management at Frances_Gambino@ibi.com.